
 1   Before Use
The NIS-Elements C is used as a function of NIS-Elements AR. It cannot be used alone.
This section describes the starting/shutdown and structure of the NIS-Elements C window. 

When a Galvano scanner that does not support the Fast mode is in use, replace "C2plus" written in this
instruction manual with "C2." (For details, see Section 1.1.3, "Differences in Window Names Depending 
on Models Used." 

1.1    Starting and Shutting Down the NIS-Elements C

This section describes the starting/shutdown the NIS-Elements C.

1.1.1    Starting the NIS-Elements C

Double-click the NIS-Elements AR icon.

Figure 1.1-1  NIS-Elements icon

The NIS-Elements title window appears.
Then, the title window closes and NIS-Elements C starts.

Figure 1.1-2  Title window

Then, the Driver selection window appears on the desktop. 
To use the regular C2 Confocal system, select "Nikon Confocal." 
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* If only one camera is installed, the camera is automatically selected and the Driver selection window
is not displayed.

* To use the C2+TIRF system, check the [Enable Multi Camera] check box and select both Nikon 
Confocal and ANDOR. (see Chapter 12) 

Figure 1.1-3  Driver selection window

As NIS-Elements C starts, the C2plus Settings window opens automatically as well.

Figure 1.1-4  Initial NIS-Elements window and the C2plus Settings window

However, when the NIS-Elements was exited with the C2plus Settings window closed during the
previous use, the window does not appear automatically at the next startup because the NIS-Elements 
reproduces the status at the previous exiting. 
To manually display the C2plus Settings window, right-click on the gray area (without any setting 
window displayed) to display a menu as shown below. Select [Acquisition Controls] -> [C2plus Settings] 
in the menu. 
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Figure 1.1-5  Displaying the C2plus Settings window

* Other display methods 
The C2plus Settings window can also be displayed by selecting [View] -> [Acquisition Controls] -> 
[C2plus Settings] from the menu bar. 

Figure 1.1-6  Displaying the C2plus Settings window

1.1.2    Shutting Down the NIS-Elements C

The layout of the NIS-Elements C is memorized when it shuts down. 

1.1.3    Differences in Window Names Depending on Models Used

If a model that supports the Fast Galvano (enabling high scan speed) is in use, a name "C2plus" is 
displayed at the upper left of each window. For models that do not support the Fast Galvano, a name 
"C2" is displayed.
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Figure 1.1-7  Identification of models

Table 1.1-1   Window Names of Models That Support or Do Not Support Fast Galvano

In this instruction manual, window names of models that support Fast Galvano are written as "C2plus"
hereinafter.
When a model that does not support Fast mode is in use, replace window name "C2plus" with "C2." 

 Differences depending on laser unit models 

Indication on the excitation laser indicator and some functions that are displayed on the Optical path 
window vary depending on laser unit models used. 

This instruction manual describes operations of the NIS-Elements C using "LU-NV" windows. (The right 
figure shows the LU-N4 window configuration without spectral detector.) 

Avoid using combinations of LU-N4 or LU-N3 laser unit and detection mode (SD or VF) using the 
spectral detector as much as possible to prevent effects of excitation light. 

Window Names of Models That Support 
Fast Galvano

Window Names of Models That Do Not 
Support Fast Galvano

C2plus Settings C2 Settings
C2plus Compact GUI C2 Compact GUI
C2plus Stimulation C2 Stimulation
C2plus Scan Area C2 Scan Area
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Figure 1.1-8  Distinction of laser unit

1.1.4    Setting OS

If sleep mode is specified in the power supply option of the OS, some devices may not work normally 
after recovery from the sleep mode. Disable the sleep mode of the OS. 

1. Click [Start] -> [Control Panel] -> [Power Options]. 
2. Select [Change when the computer sleeps] to display the plan setup editing window. 
3. Select [None] from the [Put the computer to sleep:] option. 
4. Click the [Save Changes] button to confirm the settings. 

1.2    Structure of C2plus Settings Window

The C2plus Settings window enables to apply various settings, including the laser, adjusting the 
brightness of the image, the photo activation setting, and scan resolution/speed, to use the Confocal 
Microscope. 
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Figure 1.2-1  C2plus Settings window

Table 1.2-1   Summary of C2plus Settings window functions
Name Function

(1) Acquire window 
display/nondisplay selection

Switches display/nondisplay of the Acquire window. 

(2) Acquire window Enables to display live images, to acquire images (see 
Chapter 4) or to apply the photo activation settings 
(see Chapter 10), to use external detector unit (see 
Chapter 16). 
The functions available with "NIS-Elements" are 
arranged as buttons in this area. 

(3) Filter and Dye window Enables to select the channel series to be used and set 
the optical path.
(See "Filter and Dye" in the chapters concerning 
detector modes.)

(4) Acquisition/Photo Activation 
window

Acquisition window -
The Acquisition window enables to set PMT 
brightness, laser power, and pinhole size. 
(See "Acquisition" in the chapters concerning detector 
modes.) 
Photo Activation window -
The Photo Activation window enables to set the 
desired stimulation laser power. (see Chapter 10)

(5) Scan setting window Enables to set a scan method, resolution, scan speed, 
etc. (see Chapter 8)

(6) Optimize button Calculates the recommended value of resolution, zoom 
magnification, and Z stack step size based on the 
objective type and the selected excitation wavelength, 
and the indication/automatic application function can 
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1.3    Combinations of Detection Modes and Functions

The following table lists settable functions in each detection mode. 

Table 1.3-1   Combinations of Detection Modes and Functions

Y: Available
N: Unavailable

* External detector units are usable only when a C2 system without a spectral detector or the Simple Si 
detector is in use.
When C2si (system with a spectral detector) or the Simple Si detector is in use, no external detector 
is usable. 

* When using the Simple Si detector, see Chapter 18, "Simple Si Detector."

be set in detail.

Function
Detection Mode
DU3 SD VF

Unidirectional Y Y Y
Bidirectional Y N N
Channel Series Y N N
Multi position acquisition
(Chapter 4)

Available in all detection modes.
(However, no photo activation experiment is available.)

Fast mode (Chapter 8) Y N N
HV linear correction Y N N
Pinhole setting Y Y Y
Photo activation (Chapter 10) Y Y Y

Particular line sequential
(Chapter 5)

2Ex1Em Y N N
4Ex4Em Y N N

Using external detector (Chapter 16) * Y N N

l Avoid using combinations of LU-N4 or LU-N3 laser unit and detection mode (SD or 
VF) using the spectral detector as much as possible to prevent effects of excitation 
light.
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 2   Optical Path Changeover for C2 Scan Head
This chapter describes the optical path changeover for the C2 scan head. 

When using the Simple Si detector, see Chapter 18, "Simple Si Detector." 

2.1    Optical Path Changeover Lever for C2 Scan Head

Confocal Microscope C2 illuminates the sample with the laser light (excitation light) transmitted from 
the laser unit, and detects the fluorescence from the sample by the detector unit.
The detector unit to be used for the detection can be selected from the two types: the Standard Detector
unit with a filter, or the Spectral Detector unit with a diffraction grating for the spectral function.
To select which detector the fluorescence from the sample is transmitted to, use the optical path 
changeover lever on the C2 scan head. 

Figure 2.1-1  Optical path changeover lever for C2 scan head

Table 2.1-1   Overview of detector unit function
Lever position Overview
Standard (Oblique) Switches to Standard, and leads the fluorescence light from the 

pinhole to the Standard Detector unit, which has a filter.

When this is selected, NIS-Elements C enters the "Standard Detector 
mode (DU3)" in which the 3 channel images at maximum are 
acquired by using the filter. 

Spectrum (Vertical) Switches to Spectrum, and leads the fluorescence light from the 
pinhole to the Spectral Detector unit, which has a diffraction grating.

When this is selected, either of the following two detection modes 
can be selected for NIS-Elements C: "Spectral Detector mode (SD)" 
in which the 32 channel images at maximum 
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2.2    Detection Mode When Switching the Optical Path

This section describes the detection mode indication when the optical path is switched by the optical 
path changeover lever on the C2 scan head. 

Table 2.2-1   Mode indication when the optical path is switched

are acquired by the spectral function, or "Virtual Filter mode (VF)" 
in which 4 virtual channel images by four excitations at maximum 
can be acquired. 

Switching 
operation by the 
lever

Mode change

Standard 
↓

Spectrum

The optical path is switched to the Spectral Detector unit side, and the 
Spectral Detector mode (SD) is used as the detection mode of the NIS-
Elements C.
For using the Virtual Filter mode (VF), select [VF] in the Optical path 
window to switch the detection mode.

The last settings of the detection mode are recalled. 
Spectrum 

↓
Standard

The optical path is switched to the Standard Detector unit side, and the 
Standard Detector mode (DU3) is used as the detection mode of the NIS-
Elements C.
The Standard Detector mode (DU3) can be switched to directly from 
either the Spectral Detector mode (SD) or the Virtual Filter mode (VF).

The last settings of the detection mode are recalled.
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 3   Basic Operations
This chapter describes the basic instructions for acquiring live images in the NIS-Elements C. 

Switch beforehand the optical path of the C2 scan head appropriately.
When selecting the Standard Detector mode [DU3] as the detection mode, set the optical path
changeover lever on the C2 scan head to the [Standard] position.
When selecting the Spectral Detector mode [SD] or the Virtual Filter mode [VF], set the optical path 
changeover lever on the C2 scan head to the [Spectrum] position. 

3.1    Acquiring the Live Image and Setting the Scan Area

 1      Setting the Optical path

1. Display the Optical path window.
Click the [Setting] button in the Filter and Dye window.
For details of the Optical path settings, see "Filter and Dye" in the chapters concerning detection 
modes. 

Figure 3.1-1  Filter and Dye window
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Figure 3.1-2  Optical path window

2. Select the detection mode (detector).
(This step is not needed if the Standard Detector mode [DU3] or the Spectral Detector mode [SD] 
is used, as they are automatically selected as the detection mode when the optical path changeover 
lever on the C2 scan head is switched.)

If the Virtual Filter mode [VF] is to be used, switch the optical path changeover lever on the C2 
scan head to the [Spectrum] position, and then select the [VF] button in the Optical path window. 

Figure 3.1-3  Displaying the Detection mode (when Standard is selected by the optical path 
changeover lever)
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Figure 3.1-4  Selecting the Detection mode (when Spectrum is selected by the optical path 
changeover lever)

* When using the Simple Si detector
Select [CB] to use Continuous Bandpass mode; [VB] to use the Variable Bandpass mode.
For details, see Chapter 18, "Simple Si Detector." 

Figure 3.1-5  When using the Simple Si detector

3. Activate the automatic mode of Optical path setting.
Click the [Auto] button. 

4. Select the fluorescence dyes for the channels to be used.
For each channel to be used, select a fluorescence dye from the pull-down menu. 
Once a fluorescence dye is selected, appropriate laser is automatically selected. 
And then the dichroic mirror recommended by the NIS-Elements is displayed. 

Figure 3.1-6  Selecting mode and fluorescence dyes
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5. Select the channels to be used.
Check the check box for each channel to be used. 

Figure 3.1-7  Selecting channels

6. Select the desired icon to use or disuse the transmitted detector. 

7. Confirm the Optical path settings.
Click the [OK] button.
The Optical path settings are confirmed, and the Optical path window closes. 

Figure 3.1-8  Selecting the transmitted detector and confirming the Optical path settings

 2      Applying Scan settings

In the Scan setting window, apply various scan settings to acquire the live image. 
For details of Scan settings, see Chapter 8, "Scan Setting Window."
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Figure 3.1-9  Scan setting window

 3      Acquiring the live image

Click the [Live] button.
The live image is acquired and the Live window appears.

Figure 3.1-10  Acquiring the live image
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Figure 3.1-11  Live window

 4      Adjusting the brightness of the live image

In the Acquisition window, adjust the brightness of the live image for each channel.
For details, see "Acquisition Window" in the chapters concerning detection modes.

Figure 3.1-12  Acquisition window

 5      Setting the scan area

Set the scan area for the acquired live image.
For details of the scan area, see Chapter 9, "Navigation Mode."

1. Switch the Live window to the navigation mode.
Click the [Show Scan Area] button in the Live window. 
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Figure 3.1-13  Switching to navigation mode

2. Select the scan area setting tool to be used.
The scan area setting tools differ in their available shapes depending on the scan area selected. 
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Figure 3.1-14  Selecting the scan area setting tool

3. Set the scan area with the tool selected.
For instructions on selecting and using scan area setting tools, see Section 9.3.2, "Scan Area 
Setting Tools." 
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Figure 3.1-15  Setting the scan area

 6      Acquiring the image of the set scan area

1. Right click on the drawn scan area. 
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Figure 3.1-16  Acquiring the live image of scan area

Figure 3.1-17  Live window after changing the scan area
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* While working with Frozen image, the live image in the set scan area can also be acquired by 
clicking the [Live] button.

Figure 3.1-18  Acquiring the live image

l Laser Interlocked

Indicates the interlock status of the microscope main unit.

If the optical path of the microscope main unit is switched to the binocular system, 
all of the laser shutters close for safety purpose.
At this time, the [Laser Interlocked] button blinks and the confocal image
acquisition cannot be executed.

When you execute the confocal image acquisition again, switch the optical path of
the microscope main unit to "Confocal," and then click this [Laser Interlocked] 
button.

Figure 3.1-19  Laser Interlocked indicator

l When LU4 or LU4A is in use 

Note that, if an interlock occurs during image acquisition, the laser shutter operates 
differently as follows in LU4 and LU4A after the interlock is reset.

LU4:
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The laser shutter closes when an interlock occurs and opens after the interlock is 
reset. 

LU4A:
The laser shutter closes when an interlock occurs but does not open after the
interlock is reset. However, the laser shutter opens when the next image
acquisition starts. 

l When LU-N4 or LU-N3 is in use 

When the [Clear Laser Interlock Automatically] check box in the C2plus Settings
window is selected in advance, the hardware status is recognized even if an interlock 
occurs during image acquisition and the interlock is automatically reset. 

Figure 3.1-20  Automatic release of Laser Interlocked

l When LU-NV is in use

When the [Automatic Laser Interlock release] check box in the LU-NV 
Configuration window is selected in advance, the hardware status is recognized 
even if an interlock occurs during image acquisition and the interlock is
automatically reset. 
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Figure 3.1-21  Automatic release of Laser Interlocked
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 4   Acquire Window
The Acquire window enables to display the live image, acquire the image or apply the photo activation 
settings.
Additionally, the functions available with NIS-Elements are arranged as buttons in this area.

4.1    Functions of Acquire Window

Figure 4.1-1  Acquire window

Table 4.1-1   Functions of Acquire window
Name Function

(1) Live button Enables to display the live image. 
The Live window opens and displays the live image automatically.
The live image is the real-time image that is currently observed with the 
microscope. 

(2) Find Mode Starts/stops live image acquisition in Find mode. Find mode is 
the mode where the live image acquisition is executed by
temporarily switching to the high-frame-rate setting in order to 
ease the detection of the observation object such as a cell. 
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Opens the Find mode settings window.
For details of the Find mode, see Section 4.1.2, "Find mode." 

(3) XY button Enables acquiring the captured image of the currently displayed live image.
When the captured image is acquired, the Captured window appears separately 
from the Live window. 
The captured image is a still image that is acquired by re-scanning the scan 
area displayed in the current Live window. 

(4) XYZ...button Opens the Capture Z-Series window. 
Enables to acquire a three-dimensional (X-Y-Z) image.
For operations of this window, refer to "NIS-Elements AR (Advanced
Research) User's Guide."

Figure 4.1-2  Capture Z-Series window

The same window can also be opened with the following procedure:

l Select [Acquire] on the menu bar and then select [Capture Z-Series] ->
[Capture Automatically...] in this order. 

(5) XY 
Time...button

Opens the Capture Timelapse window. 
Enables to acquire two-dimensional (X-Y) images in time series. 
For operations of this window, refer to "NIS-Elements AR (Advanced 
Research) User's Guide."
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Figure 4.1-3  Capture Timelapse window

The same window can also be opened with the following procedure:

l Select [Acquire] on the menu bar and then select [Capture Timelapse] ->
[Capture Automatically...] in this order. 

(6) XYZ 
Time...button

Opens the ND Acquisition window. 
Enables to acquire three-dimensional (X-Y-Z) images in time series. 
For operations of this window, refer to "NIS-Elements AR (Advanced 
Research) User's Guide."

Figure 4.1-4  ND Acquisition window
(7) Photo

Activation 
button

Opens the ND Stimulation window. (This button is not displayed if a three-
laser unit without AOM is connected.)
The photo activation observation can be set.
For operations of this window, see Chapter 10 in this instruction manual.
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4.1.1    Window for Acquiring Various Images

The windows shown in (4), (5), and (6) of "Table 4.1-1 Functions of Acquire window" can also be 
opened with the following procedure:

l Select [Applications] on the menu bar and then select [Define/Run ND Acquisition...]. 

In the ND Acquisition window displayed with the above procedure, click a switching tab to select a 
function to use. 
For operations of this window, refer to "NIS-Elements AR (Advanced Research) User's Guide."

Figure 4.1-5  ND Stimulation window

The same window can also be opened with the following procedure:

l Select [Applications] on the menu bar and then select [Define/Run 
Sequential Stimulation...] in this order.
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Figure 4.1-6  ND Acquisition window

4.1.1.1    Switching Z Stacks Acquisition Directions

Z stack image acquisition directions can be switched by [Bottom to Top] or [Top to Bottom].
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Figure 4.1-7  ND Acquisition window

4.1.1.2    Timelapse Experiment

 Timestamp in Timelapse Experiment  

In an experiment of timelapse, timestamp "0" is usually recorded at the beginning of the experiment 
(when the [Run now] button is clicked), but it is also possible to record timestamp "0" in the first frame.

For details, see "Options" in "NIS-Elements AR" Help. 
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Figure 4.1-8  ND Acquisition window

  When Using Perform Time Measurement  

If the Time Measurement is executed with the [Perform Time Measurement] check box selected, a load 
on processing becomes so high that it may cause the following problems:

l When the [Loop] side is set, the time for transition to the next phase may be longer than the time 
supposed from the frame rate.

l When the [Duration] side is set, the number of the frames may be smaller than that supposed from 
the frame rate. 
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Figure 4.1-9  ND Acquisition window

4.1.1.3    Notes When Acquiring Images

  When Executing the Large Image Function in ND Acquisition Window

The Large Image is a function to acquire a large image composed of multiple image frames and combine 
them to form a composite image by using the automatic algorithm, to be used when the target area is 
larger than the field of view (FOV) of the camera.

When this function is executed, the turning action is controlled by the stage. Therefore, it is necessary to 
execute the calibration before the Large Image function is executed.
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Figure 4.1-10  ND Acquisition window

For operations of Auto calibration, refer to "NIS-Elements AR (Advanced Research) User's Guide."

Figure 4.1-11  Auto calibration

  When Executing the Scan Large Image Function While Both C2 and CCD Camera Are Used  

When both C2 and CCD camera are used, if the transmitted detector (TD) is in the optical path, it blocks 
the light from the diascopic illumination. Therefore, the TD must be removed from the optical path 
before the Scan Large Image setting window is called. 

* When executing the Scan Large Image function, do not use the optical configuration (O.C.) in which 
the TD is registered. When the TD is registered in the O.C. even if the TD is removed from the 
optical path, the TD automatically enters the optical path when an image is acquired. 
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4.1.2    Find Mode

By using the Find mode, you can acquire the live image by temporarily switching to the high-frame-rate 
setting in order to ease the detection of the observation object such as a cell.

4.1.2.1    Setting for Find Mode Settings Window

Figure 4.1-12  Find mode settings window

Table 4.1-2   Summary of Find mode settings window functions
Name Function

(1) Change to band scan 
with aspect:

Switches the band scan area by the specified ratio.

E.g., 
If "2x" is selected in Scan Size 512 x 512, the band scan area is 
switched to 512 x 256 in the Find mode. 

(2) Lower resolution: Changes the scan size.

E.g., 
If "2x" is selected in Scan Size 512 x 512, the scan size is 
changed to 256 x 256 in the Find mode. 

(3) Line skipping: Unusable in the C2. 
(4) Turn OFF line & 

frame averaging
Changes a setting for Frame Average.

* C2 is not equipped with the line average function.

E.g., 
Even if the Frame Average is set in the normal mode, the live 
image is acquired by changing the setting to "None" in the Find 
mode. 
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4.2    Multi Position Acquisition

You can execute the experiment with multiple points within the same FOV by using the optical
configuration (hereinafter referred to as O.C.) where different scan areas are respectively registered. 
(Photo activation experiment is not available.)

In Multi Position Acquisition, the image acquisition is executed by the ND Sequence Acquisition 
function of NIS-Elements AR, by using the Lambda series.

* About Lambda series:
When acquiring multiple excitation lights by emitting multiple lasers, the lasers are not emitted 
simultaneously but emitted in sequence. By emitting lasers in sequence, the cross talk between 
channels can be avoided.

4.2.1    Procedure for Multi Position Acquisition Settings 

 1      Register the first scan area to O.C.

1. Specify a scan area on the acquired image.

* The scan areas usable in the multi position acquisition are the square scan area and the band 
scan area only. 

(5) Change Galvano to 
Resonant

Unusable in the C2. 

(6) OK button Confirms the settings applied and closes the Find mode settings
window. 

(7) Cancel button Discards the settings applied and closes the Find mode settings 
window. 

(8) Apply button Confirms the Find mode settings. 

l If the C2plus Settings window or the C2plus Compact GUI window is closed during 
scan in the Find mode, no GUI menu or button can be selected and the scan cannot 
be stopped. In that case, press the "- (minus)" key of the ten-key to stop the scan. 
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Figure 4.2-1  Specify a scan area

2. Register the specified scan area to O.C.
Select [Calibration] -> [New Optical Configurationc] from the menu bar to call the wizard. 

Figure 4.2-2  Call the Optical Configuration Wizard

3. Enter the name of O.C. to be registered. 

4. Check the setting conditions, and then click the [Finish] button. 
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Figure 4.2-3  Register the optical configuration

 2      Register the second and subsequent scan areas as separate O.C., respectively

After that, repeat "Step 1" to "Step 4" of  1  to register the O.C. of each scan area to be acquired in the 
multi position. 

Figure 4.2-4  Register the optical configuration
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 3      Execute the multi position acquisition

Register the O.C. of each scan area for each action, and make the experiment setting, respectively. 

1. Select [Applications] -> [Define/Run ND Sequence Acquisition...] from the menu bar to open the 
ND Sequence Acquisition window.

Figure 4.2-5  Call the ND Sequence Acquisition window

Figure 4.2-6  ND Sequence Acquisition window

2. Click the first phase and select [ND Acquisition].
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Figure 4.2-7  ND Sequence Acquisition window

3. Click the [Definec] button to open the experiment setting window. 

Figure 4.2-8  ND Sequence Acquisition window

4. Select the Lambda series tab on experiment setting window and specify the O.C. of the first scan 
area. 

5. When the setting of the experiment sequence of the first scan area is completed, click the [OK] 
button to close the window. 
The ND Sequence Acquisition window is resumed. 
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Figure 4.2-9  Experiment setting window

* The Lambda series is used for the multi position acquisition. However, do not set multiple 
O.C.s in one Lambda series for the purpose of the multi position.
If O.C.s with different scan area types and/or sizes are set, displayed size will differ from the 
original image size, because the image size ratios must be matched within one ND image. 

6. Click the next phase and select [ND Acquisition]. 

7. Click the [Definec] button to open the experiment setting window. 

Figure 4.2-10  ND Sequence Acquisition window
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8. Specify the O.C. of the second scan area.

9. When the setting of the experiment sequence of the second scan area is completed, click the [OK] 
button to close the window. 
The ND Sequence Acquisition window is resumed. 

Figure 4.2-11  Experiment setting window

10. After that, repeat "Step 6" to "Step 9" to make the experiment setting for the O.C. of the scan area 
registered for acquisition within the same FOV. 

11. Click the [Run now] button to execute the multi position acquisition. 

Figure 4.2-12  ND Sequence Acquisition window

4.3    Function of Z Intensity Correction
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When acquiring the images of a sample at Z drive positions (tomographic images) by Z stack, acquiring 
images with identical conditions at all Z drive positions makes some of the images to be too bright or 
too dark depending on the Z drive position to acquire.
A solution to this problem is the Z Intensity Correction function. 

To use the Z Intensity Correction function, first adjust the brightness on the live image by Z drive 
position you wish to acquire, and then register the optimum brightness setting values (laser power) for 
each Z drive position.

After that, acquire images by using the registered setting values. The brightness of the images for each Z 
drive position to acquire is automatically controlled, and images are acquired with the optimum
brightness at all Z drive positions.

  Minimum/recommended number of registrations for the Z Intensity Correction function

To use the Z Intensity Correction function, register at least two Z drive positions (Top and Bottom), and 
to acquire clearer images, it is recommended to register 4 or more positions (Top and Bottom plus two 
or more intermediate Z drive positions). 

* A function to load Z drive positions from the ND Acquisition window by clicking the [From ND] 
button on the Z Intensity Correction window, is provided. In that case, only three points Top, Home, 
and Bottom are loaded. Registration of four or more Z drive positions is recommended by the Z 
intensity correction function, but there is no operational problem with the setting of one point less 
than the recommended number.

  Z drive positions not registered to Z Intensity Correction

For the setting values of Z drive positions not registered to Z Intensity Correction are automatically
interpolated according to the setting values of the registered Z drive position, and the interpolated setting 
values are used to acquire images.
To check the interpolated setting values, open the Microsoft Excel file output by using the [Export...] 
button on the Z Intensity Correction window. 

4.3.1    Usage of Function of Z Intensity Correction

 1      Setting Z Stacks position for image acquisition and Z Device

1. Call the Capture Z-Series window.
For setting Z stacks instructions, see "NIS-Elements AR (Advanced Research) User's Guide."
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Figure 4.3-1  Z stacks Settings

2. Select "Z Device."
Select a Z drive other than Piezo from the pull-down menu. 

* When only the Z Device supplied with the microscope is installed, no Z Device selection menu 
is displayed in the Capture Z-Series window.
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Figure 4.3-2  Selecting the Z Device

 2      Displaying the Z Intensity Correction window to read Z drive positions

1. Right-click on the gray area (without any setting window displayed) to display a menu.
Select [Acquisition Controls] -> [Z Intensity Correction] in the menu to open the Z Intensity 
Correction window. 
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Figure 4.3-3  Displaying the Z Intensity Correction window

2. Clicking the [From ND] button in the Z Intensity Correction window reads the Top, Home, and 
Bottom Z drive positions. 

Figure 4.3-4  Z Intensity Correction window

Figure 4.3-5  Z Intensity Correction window

3. To read a Z drive position other than Top, Home, and Bottom, display the Z drive position you 
want to register and click the [Add New] button. 
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Figure 4.3-6  Capture Z-Series window

Figure 4.3-7  Z Intensity Correction window
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Figure 4.3-8  Z Intensity Correction window

 3      Adjust brightness at the Z drive positions and register them to Z Intensity Correction

1. Double-clicking the Top Z drive position displays the  button. 

Figure 4.3-9  Z Intensity Correction window
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Figure 4.3-10  Z Intensity Correction window

2. Acquiring the live image of Top Z drive position.
Click the [Live] button.
The live image of Top Z drive position is acquired and the Live window appears. 

Figure 4.3-11  Live image acquisition

3. Adjusting the brightness of the live image.
In the Acquisition window, adjust the brightness of the live image for each channel. 
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Figure 4.3-12  Acquisition window

4. Register the adjusted values. 
Click the [Add New] button in the Z Intensity Correction window.
The adjusted values are registered at the Top Z drive position. 

Figure 4.3-13  Z Intensity Correction window
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Figure 4.3-14  Z Intensity Correction window

5. Repeat steps 1 to 4 for each Z drive position to be registered to move the multiple Z drive 
positions to be registered next.

Figure 4.3-15  Z Intensity Correction window

6. After registering all of them, click the [Run Z Corr] button in the Capture Z-Series window to 
execute the image acquisition.
With the registered setting values, the brightness of the image for each Z drive position is 
automatically controlled and images are acquired with the optimum brightness at all the Z drive 
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positions. 

The settings registered on the Z Intensity Correction window are exportable to a file by using the 
[Save...] button, and an exported file is loadable by using the [Load...] button. 

Figure 4.3-16  Image acquisition running

4.3.2    Z Intensity Correction Window

Figure 4.3-17  Z Intensity Correction window
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Table 4.3-1   Functions of Z Intensity Correction window
Name Function

(1) Use in ND 
Multipoint

Absolute
Interpolates registered Z drive positions when acquiring 
Multipoint regardless of change in Z drive positions.
Relative
Interpolates Z drive positions with offset according to change in Z 
drive positions when acquiring Multipoint. 

(2) Move Z to selected 
Point

Moves the Z drive position to the selected point. 

(3) Corr. Home Indicates the position to be reference for correction.
When [Set as Correction Home] displayed by right-clicking is 
selected, the selected Z drive position is the reference point for
correction. 

(4) Z-Stack range To ND
Sends the Top, Home, and Bottom Z drive positions defined in 
the Z Intensity Correction window to the Capture Z-Series 
window. 
From ND
Reads the Top, Home, and Bottom Z drive positions defined in 
the Capture Z-Series window to the Z Intensity Correction 
window. 

(5) Use on Live Applies brightness adjustment at each set Z drive position to the 
live image. 

(6) Offset Correction 
Curve

Updates the Z drive position interpolation with offset according to 
the current Z drive position.

(7) Add New button Adds Z drive positions to be registered. 
(8) Remove

Registrations button
 Removes all registrations. 
 Removes the selected item. 

(9) Load... button Retrieves the saved in a file. 
(10) Save... button Writes the registrations in a file and saves it.
(11) Export... button Writes the registrations in a Microsoft Excel file.

The exported file allows the user to check the interpolated values 
of Z drive position with setting values unregistered.
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 5   Detection Mode DU3
This chapter describes the settings for the Standard Detector mode (DU3). 

5.1    Filter and Dye Window

This window enables to select a desired channel series and set the Optical path. 

The Standard Detector mode can be used when the optical path changeover lever on the C2 scan head is 
set to the [Standard] position. 

5.1.1    Structure of Filter and Dye Window

Figure 5.1-1  Filter and Dye window (DU3-use)

Table 5.1-1   Functions of Filter and Dye window (DU3-use)
Name Function

(1) Detector Indicates that the Standard Detector mode [DU3] is used when 
the optical path changeover lever on the C2 scan head is set to the 
[Standard] position. 

(2) Ch series Selects whether to perform scanning by simultaneously firing all 
lasers for the channels in use or by firing each laser in the
specified order.
For Ch series selection, see Section 5.1.4, "Selecting the Channel 
Series." 

* Usable only when a four-laser unit or LU-N series laser unit is 
connected.

(3) Setting button Opens the Optical path window.
To use, select the detector, the dichroic mirror, the channel, 
fluorescence dye for each channel, laser and others. 

(4) Status Indicates for the settings for each channel (fluorescence dye 
name, laser wavelength, and wavelength band to be acquired). 

(5) TD Indicates the status of the motorized transmitted detector. 
(6) TD IN/OUT button Sets/removes the motorized transmitted detector in/from the 

optical path. 
(IN = Set in the optical path/ OUT = Remove from the optical 
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5.1.2    Setting the Optical Path

Click the [Setting] button of the Filter and Dye window to display the Optical path window. 
The Standard Detector mode [DU3] setting screen is displayed when the optical path changeover lever 
on the C2 scan head is set to the [Standard] position. 

There are two modes available for Optical path setting, [Auto] and [Manual]. 
Normally, the auto mode should be used.

Figure 5.1-2  Filter and Dye window (DU3-use)

path)
As for the case where the TD IN/OUT button is not displayed, it 
will be displayed when the motorized transmitted detector is set 
in the optical path in the Optical path window. 

(7) Close mechanical 
shutter during
experiment

If unchecked, the shutter remains open during the ND image 
acquisition.
As the shutter is not opened/closed every image acquisition, the 
time for the image acquisition can be shortened. 

* During the interval period, laser power is automatically 
changed to the minimum but the laser cannot be shut off 
completely because the shutter is left open. 

(8) Eye Port button Changes optical path to eye port. 
Each function on the C2plus Settings window becomes non-
selectable when the Eye Port button is selected. 

l Optical Configuration

Individual data items set in the Standard Detector mode (DU3) can be managed 
collectively with the Optical Configuration window.
For storing and retrieving the [Optical Configuration] settings, see the sections 
concerning the optical configuration in the "NIS-Elements AR (Advanced 
Research) User's Guide."
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Figure 5.1-3  Optical path window (for auto mode, DU3-use)

5.1.3    Optical Path Window
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Figure 5.1-4  Optical path window (for auto mode, DU3-use)

Table 5.1-2   Functions of Optical path window (DU3-use)
Name Function

(1) Detection mode selection 
Indication 

Standard Detector mode (DU3).
Enables to acquire the 3-channel + TD images. 

(2) Mode selector Selects the desired mode for setting the Optical path.
Auto -
Activates the auto mode. 
Once a fluorescence dye is selected, appropriate laser 
and the dichroic mirror are automatically selected.
Manual -
Activates the manual mode. 
Enables to set the lasers and the dichroic mirror to be
used manually. 

(3) Excitation laser indicator Displays the current setting for the laser.
The currently set laser icon is displayed in a large size, 
and the optical path is indicated. 

(4) Motorized transmitted detector 
selection button

When the motorized transmitted detector is in use, 
brings the transmitted detector into the Optical path, to 
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enable the ability.

Brings the transmitted detector out of the Optical path, 
to disable the ability. 

(5) Channel selection check box Enables to select the channels to be used. 
(6) Channel color setting button Displays the Color Selection window, enables to set 

the desired color for each channel. 
(7) Sorting fluorescence dye list Sorts the fluorescence dye list according to the 

selected type.

ABC:
Displays the list in alphabetical order.

Emission:
Displays the list in the order of peak wavelength of 
fluorescence intensity.

Excitation:
Displays the list in excitation wavelength order.

(8) Fluorescence dye
selection/input:

In auto mode -
Selects the fluorescence dye name to be used for each 
channel. 
In manual mode -
Selects the in-use fluorescence dye name for each 
channel or enters an arbitrary channel name. 

(9) Excitation laser select These menus are only effective while in the manual
mode.
Enables to set the laser wavelength that is set with the 
software configuration, regardless of the setting of the 
Filter cube display/select. 

(10) Rainbow chart Provides the following information: 

l Wavelength band for which to acquire images 
(shown in color and value for each channel)

l Spectral profile of fluorescence dye 
l Excitation laser for fluorescence dye 
l A color band indicating the wavelengths in the

entire band (400 to 750 nm) 
l Scale of the wavelengths in the entire band (400 to 

750 nm)
(11) 1st Dichroic mirror select This menu is only effective while in the manual mode. 

Enables to manually select the 1st Dichroic mirror to 
be used. 

(12) Filter cube display/select These menus are only effective while in the manual 
mode.
The filter cube to be mounted on the detector can be 
selected regardless of the excitation laser. 
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5.1.4    Selecting the Channel Series

The [Ch series] menu enables to select whether to perform scanning by simultaneously firing all lasers 
for the channels to be used or by firing each laser in the specified order. 

There are four options for channel series, "None," "Line 1->3," "Line 3->1," and "Custom," either of
which can be selected from the pull-down menu. 

* Usable only when a four-laser unit or LU-N series laser unit is connected.

* Before executing the line sequence by the channel series function, correct the image shift of the 
image in which normal bidirectional scan was performed.

* Channel series can be applied to the image acquisition phase in the photo activation experiment 
sequence (but cannot be applied to the stimulation phase).

(13) Ch series selection Selects whether to perform scanning by 
simultaneously firing all lasers for the channels in use 
or by firing each laser in the specified order.
For Ch series selection, see Section 5.1.4, "Selecting
the Channel Series." 

(14) ND filter installation icon An icon is displayed on the line of laser with ND filter 
installed. 

* This icon indicates whether ND filter is installed or 
not, and does not indicate insertion or removal of 
ND filter (IN = Insert in the optical path, OUT = 
Remove from the optical path).
Insertion or removal of ND filter is performed on 
the Acquisition window. 

(15) OK button Confirms the Optical path settings applied and closes 
the Optical path window. 

(16) Cancel button Discards the Optical path settings applied and closes 
the Optical path window.

l About the setting condition when the setting mode is switched

Auto mode -> Manual mode:
The entire settings in the Auto mode are retained.

Manual mode -> Auto mode:
The fluorescence dye with the same channel name as set in the manual mode is 
automatically selected.
If the same fluorescence dye name does not exist in the list, a fluorescence dye
detectable by the laser wavelength is automatically selected from the list. 
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Figure 5.1-5  Selecting the channel series (Filter and Dye window)

Figure 5.1-6  Selecting the channel series (Optical path window)

Table 5.1-3   Functions of channel series

* When "Line 1->3" or "Line 3->1" is selected, the lasers are fired sequentially for each scan line. 
This scan method is called the line sequence.

Figure 5.1-7  Scanning motion in line sequence (Line 1->3 is selected)

  Custom  

Name Function
None Performs scanning by simultaneously firing all lasers for the channels to 

be used. 
Line 1->3 Performs scanning by sequentially firing the lasers for the channels to be 

used (Ch1 -> Ch2 -> Ch3). 
Line 3->1 Performs scanning by sequentially firing the lasers for the channels to be 

used (Ch3 -> Ch2 -> Ch1). 
Custom Performs scanning by firing the lasers in desired order for the channels to 

be used.
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Selecting "Custom" from the [Ch series] menu displays the current channel scan order and the [Custom] 
button. 

Clicking the [Custom] button opens the Line Channel Series Setup window to allow setting the scan 
order for each channel. 

Figure 5.1-8  Channel series (Custom)

Figure 5.1-9  Line Channel Series Setup window 

Table 5.1-4   Functions of channel series
No. Name Function
(1) Scan order matrix 

for each channel
Allows the user to set desired order of channels to be scanned.
Each laser can also be fired simultaneously to multiple channels by a 
single scan.
(Example: Firing lasers simultaneously for Ch1 and Ch2 by the first 
scan.)
However, one channel cannot be set twice or more times. (Selecting 
two or more check boxes in the same vertical line of the matrix is 
prohibited.) 

(2) 1->3 button Set the channel to be scanned for each laser in order of Ch1, Ch2, 
and Ch3. 

(3) 3->1 button Set the channel to be scanned for each laser in order of Ch3, Ch2, 
and Ch1. 

(4) TD check box
Allows the user to set the TD scan order if the transmitted detector 
(TD) is in the optical path.
Be sure to set the TD scan order so that the scan order comes 
together with other channels because single TD scan is disabled. 
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5.2    Acquisition Window

The Acquisition window enables to set PMT brightness (detection sensitivity), laser power, and pinhole 
size.

5.2.1    Structure of Acquisition Window

Figure 5.2-1  Acquisition window (DU3-use)

Table 5.2-1   Functions of Acquisition window (DU3-use)

(Example: Laser is fired to Ch3 and TD by the second scan.)
(5) OK button Confirms the settings applied and closes the window.
(6) Cancel button Discards the settings applied and closes the window.

Name Function
(1) Acquisition/PhotoActivation 

window switching
Switches between the Acquisition and Photo Activation
windows.

For the Photo Activation window, see Chapter 10. 
(2) Laser power monitor button Displays the laser power value (integer obtained after 

A/D conversion divided by 10) of the current channel by 
clicking this button.
During the image acquisition, the laser power cannot be
measured and this button is grayed out. 

* When a laser unit of the LU-N series is in use, the 
value displayed in the monitor does not increase over 
a certain value with the increase in the laser power 
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value, but this is not a problem. 
(3) Brightness adjustment for 

each channel 
For each of the channels (Ch1 to Ch3), use the HV, 
Offset, Laser, and ND filter IN/OUT controls to adjust 
the brightness of the live image. 

(4) Channel selection Selects the channels (Ch1 to Ch3, and/or TD) to acquire 
the desired images. 
Do this by adding a check mark. 

When acquiring the transmitted image (TD image) only, 
see Section 5.2.1.2, "When Acquiring Transmitted Image 
Only." 

(5) Select All Channels button Selects all channels for acquiring images. 
(6) Fluorescence dye name

indication
The fluorescence dye name specified in the Optical path 
window is indicated. 

(7) Channel color Displays the channel color specified in the Optical path
window. 

(8) Laser wavelength indication Displays the currently selected laser wavelength. 
(9) Laser ON/OFF button Selects whether the laser is emitted or not. 

* When LU-NV is in use, this button is grayed out and 
is disabled while the button on the front panel of the 
laser unit is OFF or blinking.

The laser is emitted.

The AOTF shutter closes and the laser power 
value becomes 0.
When switched from OFF to ON, the laser
power value set in the previous ON status is 
applied. 

(10) Pinhole Adjusts the pinhole size. (6 steps) 
For pinhole size, see Section 5.2.3, "Setting the Pinhole." 

(11) HV Linear Correction Enables or disables HV Linear Correction. 
For HV Linear Correction, see Section 5.2.4, "HV Linear 
Correction." 

(12) Brightness adjustment for
transmitted detector 

For the transmitted detector, use the HV and Offset 
controls to adjust the brightness of the live image. 

(13) AG button Automatically adjusts the HV value (HV gain) of the 
currently selected channel to the optimum values.

For Auto Gain, see Section 5.2.5, "Auto Gain." 
(14) Auto Gain setting button Sets the ratio of saturation pixels used for automatic HV 

gain correction.
The window for range of the ratio of saturation pixels 
settings appears when this button is clicked.

For setting for ratio of saturation pixels, see "Setting for 
ratio of saturation pixels" in the Section 5.2.5, "Auto 
Gain." 
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5.2.1.1    Recommended Value Indication/Automatic Application

By the function of the recommended value indication/automatic application, the recommended values of
the appropriate resolution, zoom magnification, and Z stack step size are calculated based on the 
objective type and the selected excitation wavelength.
Using the calculated recommended values enables the image acquisition clearer and with less damage to 
the sample. 

  Recommended Value Automatic Application  

To automatically apply the recommended values to the parameters, set the [Nyquist XY] button of the
Scan Area window to ON.

(15) Optimize button Displays the XYZ Size Setup window.
In the XYZ Size Setup window, the calculation method 
of the recommended values of the resolution, zoom 
magnification, and Z stack step size can be set.

For the XYZ Size Setup window, see Section 5.2.1.1,
"Recommended Value Indication/Automatic 
Application." 

(16) External Port button Makes the external detector unit available.
For details of using the external detector unit, see Chapter
16. 

* External detector units are usable only when a C2 
system without a spectral detector is in use. When 
C2si (system with a spectral detector) is in use, no 
external detector is usable.
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Figure 5.2-2  Scan Area window

Figure 5.2-3  Location of Recommended Value Indication

* When the laser or objective in use is changed, the recommended values are recalculated, and newly 
indicated and automatically applied.

 Recommended Value Settings  

Detailed settings of the recommended values are made in the XYZ Size Setup window that is displayed 
by clicking the [Optimize] button of the Acquisition window.
If the [Nyquist XY] button of the Scan Area window is ON, the recommended values are automatically 
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applied to the parameters.
Or if the [Nyquist XY] button is OFF, the recommended values of the scan size and zoom are indicated 
in the Scan setting window.

Figure 5.2-4  XYZ Size Setup window

Table 5.2-2   Functions of XYZ Size Setup window
Name Function

(1) Zoom Preference When the [Nyquist XY] button is ON, keeps the scan size 
and applied the recommended value of the zoom. 

(2) Resolution Preference When the [Nyquist XY] button is ON, keeps the zoom and 
applied the recommended value of the scan size.

(3) Use Cropping Fits the scan size in detail by using Crop Scan. 

(4) Suggested Step (Z)

Sets the Z step size calculation method. 
Recommend (Z˜1/3
FWHM)

Approximately one third of the thickness 
of optical section (FWHM value). 

Half Overlap
(Z=1/2 FWHM)

One half of the thickness of optical 
section (FWHM value).

Minimum Overlap
(Z=FWHM)

The thickness of optical section (FWHM 
value). 

Perfect Voxel
(Z=X=Y)

Value same as the pixel size.

(5) OK button Confirms the XYZ Size Setup applied and closes the XYZ 
Size Setup window. 

(6) Cancel button Discards the XYZ Size Setup applied and closes the XYZ 
Size Setup window.

Page 13 of 425. Detection Mode DU3

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhCD46.htm



5.2.1.2    When Acquiring Transmitted Image Only

By using the TD channel, you can acquire the image with the TD channel only. 

1. Display the Optical path window.
Select a channel for the laser power control and deselect other unnecessary channel's check box. 

* Even when the multiple channels are selected in the Optical path window, the image with the 
TD channel only can be acquired by deselecting the unnecessary check box in the Acquisition 
window. In this case, the laser power value of the channel that is deselected at last is used for 
acquiring the TD image.

Figure 5.2-5  Optical path window (DU3-use)

2. Set the transmitted detector into the optical path and then click the [OK] button to close the 
Optical path window.

Figure 5.2-6  Optical path window (DU3-use)

3. Use the HV and Offset controls of the transmitted detector to adjust the brightness of the live 
image. 

4. Use a channel that remains to "On" to control the laser power to set the laser power value.

5. Deselect the unnecessary check boxes other than TD. 
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Figure 5.2-7  Acquisition window (DU3-use)

6. Acquire the image. 

5.2.2    Setting Image Brightness

For the live images of each channel, adjust HV, Offset, Laser and ND filter IN/OUT to obtain clear 
images. 

Figure 5.2-8  Setting the live image brightness (DU3-use)

Table 5.2-3   Brightness adjustment functions for the live image (DU3-use) 
Name Function

(1) HV Sets the voltage to be applied to the PMT.

Slider bar:
Slides to the right or left to set the HV value.

Arrow buttons:
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Click either arrow button to increase or decrease the HV value 
stepwise.

Direct entry in HV value display field:
Type the desired setting value.

(2) Offset Sets the BL offset value of the PMT.

Slider bar:
Slides to the right or left to set the offset value.

Arrow buttons:
Click either arrow button to increase or decrease the offset value 
stepwise.

Direct entry in offset value display field:
Type the desired setting value. 

(3) Laser (*) Sets the laser power value.

Slider bar:
Slides to the right or left to set the laser power value.

Arrow buttons:
Click either arrow button to increase or decrease the laser power 
value stepwise.

Direct entry in laser power value display field:
Type the desired setting value. 

(4) HV (TD) Sets the voltage to be applied to the transmitted detector.

Slider bar:
Slides to the right or left to set the HV value.

Arrow buttons:
Click either arrow button to increase or decrease the HV value 
stepwise.

Direct entry in HV value display field:
Type the desired setting value.

(5) Offset (TD) Sets the offset value of the transmitted detector.

Slider bar:
Slides to the right or left to set the offset value.

Arrow buttons:
Click either arrow button to increase or decrease the offset value 
stepwise.

Direct entry in offset value display field:
Type the desired setting value. 
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(6) ND filter IN/OUT 
button (*)

Inserts/removes the ND filter in/from the optical path. (IN = Insert in 
the optical path/ OUT = Remove from the optical path)
This button is displayed only for lasers that can control
insertion/removal of ND filter. 

* When LU-NV is in use, this function is grayed out and is disabled while the button on the front panel 
of the laser unit is OFF or blinking. 

  PMT Overload

If too much gain is applied to the illumination intensity, the gain is automatically shut down to 
protect PMT and/or transmitted detector (TD) and the following PMT Overload dialog box is
displayed. 

Figure 5.2-9  PMT Overload dialog box

5.2.3    Setting the Pinhole

Figure 5.2-10  Setting the Pinhole (DU3-use)
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Table 5.2-4   Pinhole setting functions (DU3-use)

5.2.3.1    Calculation Settings for Pinhole Size

This section describes the setting window for calculating the pinhole size.

Click the [Pinhole] button in Acquisition window, the A.U. Calculation Settings window appears. 
(Usually, the [Recommend] is selected to enable automatic calculation. [Recommend] calculates the 
A.U. value by using the Nikon-recommended EM and NA values.) 

Name Function
(1) Pinhole size 

setting
Sets a pinhole size for C2 system.

Slider bar:
Slides to the right or left to set the pinhole size. (Unit: A.U.)

Arrow buttons:
Click either arrow button to increase or decrease the pinhole size 
stepwise.

Direct entry in pinhole size display field:
Type the desired setting value. 

(2) Pinhole button Displays the A.U. Calculation Settings window to calculate the 
pinhole size.
(For A.U. Calculation Settings, see Section 5.2.3.1, "Calculation 
Settings for Pinhole Size.") 

(3) Home Changes the pinhole to the predetermined home position.
The value of the home position can be changed in the A.U. 
Calculation Settings window.
(For A.U. Calculation Settings, see Section 5.2.3.1, "Calculation 
Settings for Pinhole Size.") 

(4) Pinhole size Indicates pinhole size of C2 system. (Unit: µm) 
(5) thickness of 

optical section
Indicates the FWHM (full width at half maximum) of z airy disk. 

(6) Optical 
Resolution

The actual size of 1 pixel square calculated from the optical
information (for objectives and scan parameters) and the size 
acquired from an image. 

(7) Reference 
excitation 
wavelength for 
the pinhole size
calculation

Selects the excitation wavelength as the reference of the automatic 
calculation of the pinhole size from the laser wavelengths, or enter it 
manually in the A.U. Calculation Settings window. (For A.U. 
Calculation Settings, see Section 5.2.3.1, "Calculation Settings for 
Pinhole Size.") 
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Figure 5.2-11  A.U. Calculation Settings window

Table 5.2-5   A.U. Calculation Settings window
Name Function

(1) Select calculation 
method

Recommend -
Sets parameters automatically. (Nikon recommended) 
User Setting -
Allows the user to manually set parameters. 

(2) EM:emission
wavelength[µm]

Selected Laser wavelength -
Calculates parameters by using the laser wavelength selected in 
the pinhole combo box of the Acquisition window as the 
emission wavelength (EM value).
The wavelength displayed in the combo box is to be the laser
wavelength set in the Optical Setting window. 
Manual -
Allows the user to manually set parameters. (The parameter is 
calculated with the input value as the emission wavelength (EM 
value).)
Enter the value directly from the keyboard.

(3) NA: Numerical 
Aperture

Sets refractive index of the objective.
NA_obj(NA of objective lens) -
Regardless of whether or not the objective NA value exceeds 
the refractive index of the sample, executes calculation by using
the objective NA as the calculation parameter. 
Min(NA_obj, NA_sample) -
When the objective NA value does not exceed the refractive 
index of the sample, executes calculation by using the objective 
NA as the calculation parameter. When the objective NA value 
exceeds the refractive index of the sample, executes calculation
by using the sample refractive index. 

(4) "Airy" Home Position Sets a home position of pinhole.
Enter the value directly from the keyboard.

* The pinhole size can be selected from six types in C2. 
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5.2.4    HV Linear Correction

When HV changes, Gain changes as shown in the graph captioned "Without HV Linear Correction."

As HV increases, the gain variation (the variation of image brightness) is gradual initially, and it
becomes steep beyond a certain point.

The gain variation can be automatically corrected to be linear with HV variation by the function called
"HV Linear Correction." With this correction, gain varies at the same rate as the HV adjustment. 

Figure 5.2-12  Gain vs. HV

To enable HV Linear Correction, check the [HV Linear Correction] check box.

Therefore, if the entered value does not match any of the types, 
the size that is larger than and the closest to the entered value is 
set as the home position.

(5) Keep A.U. check box When checked, the pinhole size is fixed by the A.U. when the 
selected wavelength or objective is changed. (However changes 
by the um.) 
When unchecked, the pinhole size is fixed by the um. (However 
changes by the A.U.)

* The pinhole size can be selected from six types in C2. 
Therefore, if the to-be-fixed A.U. value does not match any of 
the types, the size that is larger than and the closest to the A.U. 
value is selected. 

(6) OK button Confirms the A.U. Calculation Settings applied and closes the
A.U. Calculation Settings window. 

(7) Cancel button Discards the A.U. Calculation Settings applied and closes the 
A.U. Calculation Settings window.
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Figure 5.2-13  HV Linerar Correction

5.2.5    Auto Gain

Auto Gain is a function to automatically correct the value of HV gain to set the optimum image
brightness.
Automatic HV gain correction is performed within the predetermined range of the ratio of saturation 
pixels. 

Automatic HV gain correction is performed only when channels are selected.
For a TD, automatic adjustment is performed when it is selected.

After execution of Auto Gain, in the window indicating the progress of Auto Gain, the correction values 
actually used (ratio of saturation pixels) are displayed by channel.
For a channel on which Auto Gain failed, "x" is indicated and the HV value returns to its original value.

l When HV Linear Correction is enabled or disabled, HV is reset to 0 V once. 
l If the Offset slider bar is moved, the accurate correction is not performed.

l When setting the line scan, Auto Gain cannot be executed. 
l During execution of Auto Gain, do not perform manual adjustments in the 
Acquisition window.
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Figure 5.2-14  Execution of Auto Gain (DU3-use)

Figure 5.2-15  Auto Gain progress

  Setting for ratio of saturation pixels  

Set the maximum and minimum value for the ratio of saturation pixels used for automatic HV gain 
correction.

Click the [Auto Gain Setting] button to display the Auto gain setup window.
Set the maximum and minimum value for the ratio of saturation pixels in the Auto gain setup window. 
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Figure 5.2-16  Displaying the Auto gain setup window

Figure 5.2-17  Setting for ratio of saturation pixels

Table 5.2-6   Setting for ratio of saturation pixels

5.3    Experiments by Using Lambda Series

By using the Lambda series as the function of the NIS-Elements AR, the multiwavelength excitation and
emission experiments such as 2Ex 1Em (2 excitations 1 emission experiment) and 4Ex 4Em (4 
excitations 4 emissions experiment) can be executed. 

Multiwavelength excitation and emission experiment means an experiment made when using a 

Name Function
(1) Target Maximal 

Intensity
Specifies the application ratio of the setting of the ratio of saturation 
pixels.
Sets the percentage (%) of the maximum value to be applied. 

(2) Advanced 
Settings

If checked, advanced settings of the ratio of saturation pixels are 
enabled. 

(3) Overillumination
Tolerance (Area)

Minimum Sets the minimum value for ratio of saturation pixels.
Maximum Sets the maximum value for ratio of saturation pixels.

(4) Perform in Find 
Mode (fast)

If checked, execution in the Find mode is enabled. 

(5) Perform Auto 
Offset

If checked, the offset value is set automatically. 

(6) OK button Confirms the settings of Auto gain setup applied and closes the Auto 
gain setup window. 

(7) Cancel button Discards the settings of Auto gain setup applied and closes the Auto 
gain setup window.
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fluorescence dye whose fluorescence intensity varies with the wavelength of excitation lasers. The 
excitation lasers are changed, but the wavelength of acquired fluorescence is identical. 

* About Lambda series:
When acquiring multiple excitation lights by emitting multiple lasers, the lasers are not emitted 
simultaneously but emitted in sequence. By emitting lasers in sequence, the cross talk between 
channels can be avoided.

5.3.1    2Ex 1Em Acquisition 

This section describes the settings to make the 2 excitations 1 emission experiment. 

5.3.1.1    Procedure for 2Ex 1Em Settings 

In the 2 excitations 1 emission experiment, the 2 excitation wavelengths are to be respectively registered 
to the optical configuration (hereinafter referred to as O.C.), and the O.C. is used by the Lambda series. 

 1      Switching the optical path of the C2 scan head

Switch the optical path changeover lever on the C2 scan head to the [Standard] position.

Figure 5.3-1  Switching the optical path of the C2 scan head

 2      Setting the optical path of the 1st excitation wavelength to be registered to O.C.

1. Click the [Setting] button in the Filter and Dye window.
For details of the Optical path settings, see Section 5.1, "Filter and Dye Window." 
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Figure 5.3-2  Filter and Dye window

2. Activate the Manual mode of Optical path setting.
Click the [Manual] button. 

Figure 5.3-3  Selecting the Manual mode

3. Select a channel to be excited. (e.g. Ch1)
Change the channel name and channel color freely. 

Figure 5.3-4  Selecting the channel

4. Select the 1st excitation wavelength. (e.g. 488 nm)
Select the wavelength for excitation lasers from the pull-down menu.
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Figure 5.3-5  Selecting 1st excitation wavelength

5. Click the [OK] button to confirm the Optical path settings. 

Figure 5.3-6  Optical path settings

6. In the Acquisition window, adjust a PMT for the excitation lasers.
Set the HV value, the Offset value, and the Laser power value.
For details of the acquisition settings, see Section 5.2, "Acquisition Window." 

Figure 5.3-7  Acquisition window

 3      Registering the set optical path as an O.C.
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1. Select [Calibration] -> [New Optical Configuration] from the menu bar to open the Wizard. 

Figure 5.3-8  To display the Optical Configuration Wizard

2. Enter the name of O.C. to be registered, and then click the [Finish] button. 

Figure 5.3-9  Registration of optical configuration

 4      Setting the optical path of the 2nd excitation wavelength to be registered to O.C.

1. Click the [Setting] button in the Filter and Dye window.
For details of the Optical path settings, see Section 5.1, "Filter and Dye Window." 
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Figure 5.3-10  Filter and Dye window

2. Check that the Optical path setting is set to Manual mode.
If it is not set to Manual mode, click the [Manual] button.

Figure 5.3-11  Selecting the Manual mode

3. Select the same channel as selected in the setting of the 1st excitation wavelength. (e.g. Ch1)
Change the channel name and channel color freely. 

Figure 5.3-12  Selecting the channel

4. Select the 2nd excitation wavelength. (e.g. 543 nm)
Select the wavelength for excitation lasers from the pull-down menu.

Page 28 of 425. Detection Mode DU3

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhCD46.htm



Figure 5.3-13  Selecting 2nd excitation wavelength

5. Click the [OK] button to confirm the Optical path settings. 

Figure 5.3-14  Optical path settings

6. In the Acquisition window, adjust a PMT for the excitation lasers.
Set the HV value, the Offset value, and the Laser power value.
For details of the acquisition settings, see Section 5.2, "Acquisition Window." 

Figure 5.3-15  Acquisition window

 5      Registering the optical path of the 2nd excitation wavelength as the second O.C.

1. Select [Calibration] -> [New Optical Configuration] from the menu bar to open the Wizard. 
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Figure 5.3-16  To display the Optical Configuration Wizard

2. Enter the name of O.C. to be registered, and then click the [Finish] button. 

Figure 5.3-17  Registration of optical configuration

 6      Execute the Lambda series

1. Select [Applications] -> [Define/Run ND Acquisition...] from the menu bar to open the ND 
Acquisition window. 
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Figure 5.3-18  To display the ND Acquisition window

2. Select and check the [Lambda] tab among the tabs displayed in the ND Acquisition window. 

Figure 5.3-19  ND Acquisition window

3. In the first column of the [Optical Conf.], select the O.C. to which the optical path of the 1st 
excitation wavelength has been registered. 

4. In the second column of the [Optical Conf.], select the O.C. to which the optical path of the 2nd 
excitation wavelength has been registered. 
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Figure 5.3-20  ND Acquisition window

5. Click the [Run now] button to acquire the image.

Figure 5.3-21  ND Acquisition window

Page 32 of 425. Detection Mode DU3

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhCD46.htm



Figure 5.3-22  Acquired image

5.3.2    4Ex 4Em Acquisition 

This section describes the settings to make the 4 excitations 4 emissions experiment.

To execute the 4 excitations 4 emissions experiment, a special filter cube for "DAPI/CY5 Dual" needs to 
be used. 

5.3.2.1    Procedure for 4Ex 4Em Settings 

In the 4 excitations 4 emission experiment, the 4 excitation wavelengths are to be separately registered 
to the 2 optical configurations (hereinafter referred to as O.C.), and the O.C. is used by the Lambda 
series.
(e.g., if the 4 channels of DAPI, FITC, TRITC, and Cy5 are to be acquired, the lasers of 405, 488, 543, 
and 640 are to be used.)

 1      Switching the optical path of the C2 scan head

Switch the optical path changeover lever on the C2 scan head to the [Standard] position.
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Figure 5.3-23  Switching the optical path of the C2 scan head

 2      Setting the optical path of the Ch1 and Ch3 to be registered to O.C.

1. Click the [Setting] button in the Filter and Dye window.
For details of the Optical path settings, see Section 5.1, "Filter and Dye Window." 

Figure 5.3-24  Filter and Dye window

2. Activate the Manual mode of Optical path setting.
Click the [Manual] button. 

Figure 5.3-25  Selecting the Manual mode
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3. Select the two channels to be excited. (Select Ch1 and Ch3) 
Change the channel name and channel color freely. 

Figure 5.3-26  Selecting the channel

4. Assign an excitation wavelength to each of the selected channels. (e.g. 408 nm and 543 nm)
Select the wavelength for excitation lasers from the pull-down menu. 

Figure 5.3-27  Selecting 1st, 2nd, and 3rd excitation wavelength

5. Click the [OK] button to confirm the Optical path settings. 

Figure 5.3-28  Optical path settings

6. In the Acquisition window, adjust a PMT for the excitation lasers.
Set the HV value, the Offset value, and the Laser power value.
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For details of the acquisition settings, see Section 5.2, "Acquisition Window." 

Figure 5.3-29  Acquisition window

 3      Registering the optical path of the Ch1 and Ch3 as an O.C.

1. Select [Calibration] -> [New Optical Configuration] from the menu bar to open the Wizard. 

Figure 5.3-30  To display the Optical Configuration Wizard

2. Enter the name of O.C. to be registered, and then click the [Finish] button. 
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Figure 5.3-31  Registration of optical configuration

 4     Setting the optical path of the Ch1 and Ch2 to be registered to O.C.

1. Click the [Setting] button in the Filter and Dye window.
For details of the Optical path settings, see Section 5.1, "Filter and Dye Window." 

Figure 5.3-32  Filter and Dye window

2. Check that the Optical path setting is set to Manual mode.
If it is not set to Manual mode, click the [Manual] button.

Figure 5.3-33  Selecting the Manual mode
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3. Select the two channels to be excited. (Select Ch1 and Ch2) 

Figure 5.3-34  Selecting the channel

4. Select the excitation wavelength. (e.g. 637 nm and 488 nm) 
Select the wavelength for excitation lasers from the pull-down menu.

* Set beforehand the special filter cube for "DAPI/CY5 Dual" in the 1st FL Cube.

Figure 5.3-35  Selecting 4th excitation wavelength

5. Click the [OK] button to confirm the Optical path settings. 
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Figure 5.3-36  Optical path settings

6. In the Acquisition window, adjust a PMT for the excitation lasers.
Set the HV value, the Offset value, and the Laser power value.
For details of the acquisition settings, see Section 5.2, "Acquisition Window." 

Figure 5.3-37  Acquisition window

 5      Registering the set optical path of the Ch1 and Ch2 as the 2nd O.C.

1. Select [Calibration] -> [New Optical Configuration] from the menu bar to open the Wizard. 

Figure 5.3-38  To display the Optical Configuration Wizard
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2. Enter the name of O.C. to be registered, and then click the [Finish] button. 

Figure 5.3-39  Registration of optical configuration

 6      Execute the Lambda series

1. Select [Applications] -> [Define/Run ND Acquisition...] from the menu bar to open the ND 
Acquisition window. 

Figure 5.3-40  To display the ND Acquisition window

2. Select and check the [Lambda] tab among the tabs displayed in the ND Acquisition window. 
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Figure 5.3-41  ND Acquisition window

3. In the first column of the [Optical Conf.], select the O.C. to which the optical path of the Ch1 and 
Ch3 have been registered.

4. In the second column of the [Optical Conf.], select the O.C. to which the optical path of the Ch1 
and Ch2 have been registered. 

Figure 5.3-42  ND Acquisition window

5. Click the [Run now] button to acquire the image.
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Figure 5.3-43  ND Acquisition window

Figure 5.3-44  Acquired image
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 6   Detection Mode SD
This chapter describes the settings for the Spectral Detector mode (SD). 

6.1    Filter and Dye Window

This window enables to set the Optical path. 

The Spectral Detector mode can be used when the optical path changeover lever on the C2 scan head is 
set to the [Spectrum] position and the Spectral Detector (SD) is selected as the detection mode in the 
Optical path window. 

6.1.1    Structure of Filter and Dye Window

Figure 6.1-1  Filter and Dye window (SD-use)

Table 6.1-1   Functions of Filter and Dye window (SD-use)
Name Function

(1) Detector Indicates that the Spectral Detector mode [SD] is used when the 
optical path changeover lever on the C2 scan head is set to the 
[Spectrum] position and the Spectral Detector (SD) is selected as 
the detection mode in the Optical path window.

(2) Setting button Opens the Optical path window.
To use, select the detector, the dichroic mirror, the excitation 
laser, fluorescence dye for each excitation laser and others. 

(3) Status Indicates for the settings for each excitation laser (fluorescence 
dye name, laser wavelength, and wavelength band to be 
acquired). 

(4) TD Indicates the status of the motorized transmitted detector. 
(5) TD IN/OUT button Sets/removes the motorized transmitted detector in/from the 

optical path. 
(IN = Set in the optical path/ OUT = Remove from the optical 
path)
As for the case where the TD IN/OUT button is not displayed, it 
will be displayed when the motorized transmitted detector is set 
in the optical path in the Optical path window. 
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6.1.2    Setting the Optical Path

Click the [Setting] button of the Filter and Dye window to display the Optical path window. 
The Spectral Detector mode [SD] setting screen is displayed when the optical path changeover lever on 
the C2 scan head is set to the [Spectrum] position and the Spectral Detector (SD) is selected as the 
detection mode in the Optical path window. 

There are two modes available for Optical path setting, [Auto] and [Manual].
Normally, the auto mode should be used.

Figure 6.1-2  Filter and Dye window

(6) Spectral Detector 
setting information

Displays the information set on the Spectral Detector. 

(7) Close mechanical 
shutter during 
experiment

If unchecked, the shutter remains open during the ND image
acquisition. 
As the shutter is not opened/closed every image acquisition, the 
time for the image acquisition can be shortened. 

* During the interval period, laser power is automatically 
changed to the minimum but the laser cannot be shut off 
completely because the shutter is left open. 

(8) Eye Port button Changes optical path to eye port. 
Each function on the C2plus Settings window becomes non-
selectable when the Eye Port button is selected. 

l Optical Configuration

Individual data items set in the Spectral Detector mode (SD) can be managed 
collectively with the Optical Configuration window. 
For storing and retrieving the [Optical Configuration] settings, see the sections 
concerning the optical configuration in the "NIS-Elements AR (Advanced 
Research) User's Guide."
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Figure 6.1-3  Optical path window (for auto mode)

6.1.3    Optical Path Window
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Figure 6.1-4  Optical path window (for auto mode, SD-use)

Table 6.1-2   Functions of Optical path window (SD-use)
Name Function

(1) Detection mode selection 
button 

Enabled to select the Spectral Detector mode (SD).
Enables to acquire the 32-channel + TD spectral 
images simultaneously. 

(2) Mode selector Selects the desired mode for setting the Optical path.
Auto -
Activates the auto mode. 
Once the fluorescence dye to be used is selected, the
appropriate laser and the dichroic mirror, and the 
acquired wavelength range and resolution are 
automatically selected.
Up to 2 lasers can be selected. 
Manual -
Activates the manual mode. 
Enables to set all of the laser, the dichroic mirror, 
acquired wavelength range, and resolution to be used 
manually. 
Up to 4 lasers can be selected. 

(3) Excitation laser indicator Displays the current setting for the laser.
The currently set laser icon is displayed in a large size, 

Page 4 of 536. Detection Mode SD

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh176D.htm



and the optical path is indicated. 
(4) Sorting fluorescence dye list This menu is only effective while in the auto mode.

Sorts the fluorescence dye list according to the 
selected type.

ABC:
Displays the list in alphabetical order.

Emission:
Displays the list in the order of peak wavelength of 
fluorescence intensity.

Excitation:
Displays the list in excitation wavelength order.

(6) Fluorescence dye
selection/input:

This menu is only effective while in the auto mode. 
Selects the in-use fluorescence dye name for each
channel or enters an arbitrary channel name. 

(7) Excitation laser wavelength
select

These menus are only effective while in the manual 
mode.
Enables to set the laser wavelength that is set with the
software configuration, regardless of the setting of the 
Filter cube display/select. 

(8) Rainbow chart Provides the following information: 

l Wavelength band for which to acquire images 
(shown in color and value for each excitation laser)

l Spectral profile of fluorescence dye 
l Excitation laser for fluorescence dye 
l A color band indicating the wavelengths in the

entire band (400 to 750 nm) 
l Scale of the wavelengths in the entire band (400 to 

750 nm) 
(9) 1st Dichroic mirror select This menu is only effective while in the manual mode.

Enables to manually select the 1st Dichroic mirror to 
be used. 

(10) Motorized transmitted detector
selection button

When the motorized transmitted detector is in use, 
brings the transmitted detector into the Optical path, to 
enable the ability.

Brings the transmitted detector out of the Optical path, 
to disable the ability. 

(11) ND filter installation icon An icon is displayed on the line of laser with ND filter 
installed. 

* This icon indicates whether ND filter is installed or 
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6.1.4    Optical Path Window Switching Tab

The tab for switching between [Detector] and [Binning/Skip] is displayed on the right top of the Optical 
path window. 

6.1.4.1    Detector Tab

Figure 6.1-5  Optical path window (for manual mode, Detector tab)

not, and does not indicate insertion or removal of ND 
filter (IN = Insert in the optical path, OUT = 
Remove from the optical path).
Insertion or removal of ND filter is performed on 
the Acquisition window. 

(12) OK button Confirms the Optical path settings applied and closes 
the Optical path window. 

(13) Cancel button Discards the Optical path settings applied and closes 
the Optical path window.

l About switching between SD and VF

SD -> VF: 
The last settings in the Virtual Filter mode (VF) are recalled.

VF -> SD: 
The last settings in the Spectral Detector mode (SD) are recalled. 

l About the setting condition when the setting mode is switched

Auto mode -> Manual mode:
The entire settings in the Auto mode are retained.

Manual mode -> Auto mode:
The last settings in the Auto mode are recalled. 
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Table 6.1-3   Functions of Detector tab
Name Function

(1) Resolution Selects a wavelength resolution. (Enabled in the manual mode 
only.)
Selectable from 2.5, 5, or 10 nm.

(2) Channels Selects the number of channels (number of PMTs). (Enabled in
the manual mode only.)
Up to 32 channels can be selected in the wavelength range of 400 
nm to 750 nm.

(3) Binning Displays the number of channel binning currently set. 
(4) Wavelength range 

setting bar
Sets a wavelength range in a wavelength range from 400 to 750
nm. (Enabled in the manual mode only.)
Sets a range by shifting the wavelength range setting bar to the 
right or left or by enlarging or reducing it. (Linked with the above 
setting of the number of channels.)

* A part of the wavelength range may be displayed in black 
depending on the setting conditions. In the wavelength range 
displayed in black, no wavelength range can be set. 

(5) Start Displays the start wavelength of the wavelength range currently 
selected.
Enabled to enlarge or reduce the range of the short wavelength in 
units of wavelength resolution with the right or left button in the 
manual mode.

(6) All In the currently selected wavelength range, enables shifting to the 
right or left in units of 0.25 nm without changing the width of the 
wavelength. (Enabled in the manual mode only.) 

(7) End Displays the end wavelength of the wavelength range currently 
selected. 
In the manual mode, the range of the long wavelength in units of 
wavelength resolution can be enlarged or reduced using the right 
and left buttons. 

(8) Enlarge button Enlarges the rainbow chart.
The display is switched in three levels. 

l Restriction on the detection wavelength range for the long wavelength 

To prevent the incidence of the second-order light of excitation light to the detector, 
there are restrictions on the settings of the detection wavelength range for the long 
wavelength, as shown below. 

1. If there is a possibility of the incidence of the second-order light of excitation 
light to the detection wavelength range, the wavelength resolution of the 
diffraction grating is increased (the detection range is narrowed) to prevent the 
incidence of the second-order light of excitation light to the detection wavelength 
range.
(The wavelength resolution of the diffraction grating automatically transits from 
10.0 nm to 5.00 nm, and then to 2.50 nm.) 
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6.1.4.2    Binning/Skip Tab

With the inter-channel binning, the dark image can be brightened. (Enabled in the manual mode only.)
Further, channels within the set wavelength range can be arbitrarily skipped. Since masked channel data 
is not acquired, the data volume can be reduced.
Set this tab after the setting of the [Detector] tab is confirmed.

Figure 6.1-6  Optical path window (for manual mode, Binning/Skip tab)

Table 6.1-4   Functions of Binning/Skip tab

2. When the wavelength resolution is 2.50 nm, the detection wavelength range is 
limited so as not to move to the wavelength longer than the wavelength of 
second-order light.

Name Function
(1) Binning Sets the number of channels to be combined into one 

channel.
Two to four channels can be set.
When Binning is set, the number of channels set with the 
[Detector] tab is automatically re-set to the closest number 
of channels that can be divided by the binning value. 

(2) PMT All on/off button All on -
Resets all PMT skips that have been set. 

All off -
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Leaves one channel and skips all of other PMTs. 
(3) PMT skip selection check 

box
Sets skip in each channel. If this box is clicked, ¡ (black) is 
displayed and skip is set.
Channel data with skip set is not acquired during scan.

*  If the setting of the [Detector] tab is changed, the setting with the [Binning/Skip] tab is cancelled.

6.2    Acquisition Window

The Acquisition window enables to set PMT brightness (detection sensitivity), laser power, and pinhole 
size. 

6.2.1    Structure of Acquisition Window

Figure 6.2-1  Acquisition window (SD-use)

Table 6.2-1   Functions of Acquisition window (SD-use)
Name Function

(1) Acquisition/Photo 
Activation window 
switching

Switches between the Acquisition and Photo Activation
windows.

For the Photo Activation window, see Chapter 10. 
(2) Laser power monitor 

button 
Displays the laser power value (integer obtained after A/D 
conversion divided by 10) of the current excitation laser by
clicking this button.
During the image acquisition, the laser power cannot be 
measured and this button is grayed out. 

(3) Excitation laser color Displays the excitation laser color specified in the Optical path 
window. 

(4) Laser wavelength The currently selected laser wavelength is indicated.
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6.2.1.1    Recommended Value Indication/Automatic Application

By the function of the recommended value indication/automatic application, the recommended values of
the appropriate resolution, zoom magnification, and Z stack step size are calculated based on the 
objective type and the selected excitation wavelength.
Using the calculated recommended values enables the image acquisition clearer and with less damage to 
the sample.

  Recommended Value Automatic Application  

indication 
(5) Laser ON/OFF button Selects whether the laser is emitted or not. 

* When LU-NV is in use, this button is grayed out and is 
disabled while the button on the front panel of the laser unit 
is OFF or blinking.

The laser is emitted.

The AOTF shutter closes and the laser power value 
becomes 0.
When switched from OFF to ON, the laser power 
value set in the previous ON status is applied.

(6) Si HV Adjusts HV of the Spectral Detector.
(7) Pinhole Adjusts the pinhole size.

For pinhole size, see Section 6.2.3, "Setting the Pinhole."
(8) Brightness adjustment 

for transmitted 
detector 

For the transmitted detector, use the HV and Offset controls to 
adjust the brightness of the live image. 

(9) TD channel selection Enables to acquire TD images by checking the check box. 
(10) AG button Automatically adjusts the Si HV value (Si HV gain) of the 

currently selected excitation laser to the optimum values.

For Auto Gain, see Section 6.2.4, "Auto Gain."
(11) Auto Gain setting

button
Sets the ratio of saturation pixels used for automatic Si HV gain 
correction. The window for range of the ratio of saturation 
pixels settings appears when this button is clicked.
For setting for ratio of saturation pixels, see "Setting for ratio of
saturation pixels" in the Section 6.2.4, "Auto Gain." 

(12) Optimize button Displays the XYZ Size Setup window.
In the XYZ Size Setup window, the calculation method of the 
recommended values of the resolution, zoom magnification, and 
Z stack step size can be set.

For the XYZ Size Setup window, see Section 6.2.1.1,
"Recommended Value Indication/Automatic Application."
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To automatically apply the recommended values to the parameters, set the [Nyquist XY] button of the
Scan Area window to ON.

Figure 6.2-2  Scan Area window

Figure 6.2-3  Location of Recommended Value Indication

* When the laser or objective in use is changed, the recommended values are recalculated, and newly 
indicated and automatically applied.

 Recommended Value Settings  

Detailed settings of the recommended values are made in the XYZ Size Setup window that is displayed 

Page 11 of 536. Detection Mode SD

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh176D.htm



by clicking the [Optimize] button of the Acquisition window.
If the [Nyquist XY] button of the Scan Area window is ON, the recommended values are automatically 
applied to the parameters.
Or if the [Nyquist XY] button is OFF, the recommended values of the scan size and zoom are indicated in 
the Scan setting window.

Figure 6.2-4  XYZ Size Setup window

Table 6.2-2   Functions of XYZ Size Setup window
Name Function

(1) Zoom Preference When the [Nyquist XY] button is ON, keeps the scan size 
and applied the recommended value of the zoom. 

(2) Resolution Preference When the [Nyquist XY] button is ON, keeps the zoom and 
applied the recommended value of the scan size.

(3) Use Cropping Fits the scan size in detail by using Crop Scan. 

(4) Suggested Step (Z)

Sets the Z step size calculation method.
Recommend (Z˜1/3
FWHM)

Approximately one third of the thickness 
of optical section (FWHM value).

Half Overlap
(Z=1/2 FWHM)

One half of the thickness of optical 
section (FWHM value).

Minimum Overlap
(Z=FWHM)

The thickness of optical section (FWHM 
value). 

Perfect Voxel
(Z=X=Y)

Value same as the pixel size.

(5) OK button Confirms the XYZ Size Setup applied and closes the XYZ 
Size Setup window. 

(6) Cancel button Discards the XYZ Size Setup applied and closes the XYZ 
Size Setup window.
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6.2.2    Setting Image Brightness

For each excitation laser, adjust HV, Offset, Laser, and ND filter IN/OUT to obtain clear images. 

Figure 6.2-5  Setting the live image brightness (SD-use)

Table 6.2-3   Brightness adjustment functions for the live image (SD-use) 
Name Function

(1) Laser (*) Sets the laser power value.

Slider bar:
Slides to the right or left to set the laser power value.

Arrow buttons:
Click either arrow button to increase or decrease the laser power 
value stepwise.

Direct entry in laser power value display field:
Type the desired setting value. 

(2) HV Sets the voltage to be applied to the transmitted detector.

Slider bar:
Slides to the right or left to set the HV value.

Arrow buttons:
Click either arrow button to increase or decrease the HV value 
stepwise.

Direct entry in HV value display field:
Type the desired setting value.

(3) Offset Sets the offset value of the transmitted detector.

Slider bar:
Slides to the right or left to set the offset value.
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Arrow buttons:
Click either arrow button to increase or decrease the offset value 
stepwise.

Direct entry in offset value display field:
Type the desired setting value. 

(4) Si HV Adjusts HV of the Spectral Detector. (Applied to all excitation
lasers.)

Slider bar:
Slides to the right or left to set the Si HV value.

Arrow buttons:
Click either arrow button to increase or decrease the Si HV value 
stepwise.

Direct entry in Si HV value display field:
Type the desired setting value.

(5) ND filter IN/OUT 
button (*)

Inserts/removes the ND filter in/from the optical path. (IN = Insert in 
the optical path/ OUT = Remove from the optical path)
This button is displayed only for lasers that can control 
insertion/removal of ND filter. 

* When LU-NV is in use, this function is grayed out and is disabled while the button on the front panel of 
the laser unit is OFF or blinking. 

  PMT Overload

If too much gain is applied to the illumination intensity, the gain is automatically shut down to 
protect PMT and/or transmitted detector (TD), and then following PMT Overload dialog box is
displayed. 

Figure 6.2-6  PMT Overload dialog box

6.2.3    Setting the Pinhole

Page 14 of 536. Detection Mode SD

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh176D.htm



Figure 6.2-7  Setting the Pinhole (SD-use)

Table 6.2-4   Pinhole setting functions (SD-use)
Name Function

(1) Pinhole size 
setting

Sets a pinhole size for C2 system.

Slider bar:
Slides to the right or left to set the pinhole size. (Unit: A.U.)

Arrow buttons:
Click either arrow button to increase or decrease the pinhole size 
stepwise.

Direct entry in pinhole size display field:
Type the desired setting value. 

(2) Pinhole button Displays the A.U. Calculation Settings window to calculate the 
pinhole size.
(For A.U. Calculation Settings, see Section 6.2.3.1, "Calculation 
Settings for Pinhole Size.") 

(3) Home Changes the pinhole to the predetermined home position.
The value of the home position can be changed in the A.U. 
Calculation Settings window.
(For A.U. Calculation Settings, see Section 6.2.3.1, "Calculation 
Settings for Pinhole Size.") 

(4) Pinhole size Indicates pinhole size of C2 system. (Unit: µm) 
(5) thickness of 

optical section
Indicates the FWHM (full width at half maximum) of z airy disk. 

(6) Optical 
Resolution

The actual size of 1 pixel square calculated from the optical
information (for objectives and scan parameters) and the size 
acquired from an image. 

(7) Reference 
excitation 
wavelength for 
the pinhole size

Selects the excitation wavelength as the reference of the automatic 
calculation of the pinhole size from the laser wavelengths, or enter it 
manually in the A.U. Calculation Settings window. (For A.U. 
Calculation Settings, see Section 6.2.3.1, "Calculation Settings for 
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6.2.3.1    Calculation Settings for Pinhole Size 

This section describes the setting window for calculating the pinhole size.

Click the [Pinhole] button in Acquisition window, the A.U. Calculation Settings window appears. 
(Usually, the [Recommend] is selected to enable automatic calculation. [Recommend] calculates the A.U. 
value by using the Nikon-recommended EM and NA values.) 

Figure 6.2-8  A.U. Calculation Settings window

Table 6.2-5   A.U. Calculation Settings window

calculation Pinhole Size.") 

Name Function
(1) Select calculation 

method
Recommend -
Sets parameters automatically. (Nikon recommended) 
User Setting -
Allows the user to manually set parameters. 

(2) EM:emission
wavelength[µm]

Selected Laser wavelength -
Calculates parameters by using the laser wavelength selected in 
the pinhole combo box of the Acquisition window as the 
emission wavelength (EM value).
The wavelength displayed in the combo box is to be the laser
wavelength set in the Optical Setting window. 
Manual -
Allows the user to manually set parameters. (The parameter is 
calculated with the input value as the emission wavelength (EM 
value).)
Enter the value directly from the keyboard.

(3) NA:Numerical 
Aperture

Sets refractive index of the objective. 

NA_obj(NA of objective lens) -
Regardless of whether or not the objective NA value exceeds 
the refractive index of the sample, executes calculation by using
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6.2.4    Auto Gain

Auto Gain is a function to automatically correct the value of Si HV gain to set the optimum image 
brightness.
Automatic Si HV gain correction is performed within the predetermined range of the ratio of saturation 
pixels. 

Automatic Si HV gain correction is performed only Si HV.
For a TD, automatic adjustment is performed when it is selected.

After execution of Auto Gain, in the window indicating the progress of Auto Gain, the correction values 
actually used (ratio of saturation pixels) are displayed.
If Auto Gain failed, "x" is indicated and the Si HV value returns to its original value. 

the objective NA as the calculation parameter. 
Min(NA_obj, NA_sample) -
When the objective NA value does not exceed the refractive 
index of the sample, executes calculation by using the objective 
NA as the calculation parameter. When the objective NA value 
exceeds the refractive index of the sample, executes calculation
by using the sample refractive index. 

(4) "Airy" Home Position Sets a home position of pinhole.
Enter the value directly from the keyboard.

* The pinhole size can be selected from six types in C2. 
Therefore, if the entered value does not match any of the types, 
the size that is larger than and the closest to the entered value is 
set as the home position.

(5) Keep A.U. check box When checked, the pinhole size is fixed by the A.U. when the 
selected wavelength or objective is changed. (However changes 
by the um.) 
When unchecked, the pinhole size is fixed by the um. (However 
changes by the A.U.)

* The pinhole size can be selected from six types in C2. 
Therefore, if the to-be-fixed A.U. value does not match any of 
the types, the size that is larger than and the closest to the A.U. 
value is selected. 

(6) OK button Confirms the A.U. Calculation Settings applied and closes the
A.U. Calculation Settings window. 

(7) Cancel button Discards the A.U. Calculation Settings applied and closes the 
A.U. Calculation Settings window.

l When setting the line scan, Auto Gain cannot be executed. 
l During execution of Auto Gain, do not perform manual adjustments in the 
Acquisition window.
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Figure 6.2-9  Execution of Auto Gain (SD-use)

Figure 6.2-10  Auto Gain progress

  Setting for ratio of saturation pixels  

Set the maximum and minimum value for the ratio of saturation pixels used for automatic Si HV gain
correction.

Click the [Auto Gain Setting] button to display the Auto gain setup window.
Set the maximum and minimum value for the ratio of saturation pixels in the Auto gain setup window. 

Figure 6.2-11  Displaying the Auto gain setup window
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Figure 6.2-12  Setting for ratio of saturation pixels

Table 6.2-6   Setting for ratio of saturation pixels

6.3    Various Views (Spectral Detector-use) 

This section describes various spectral views. 

6.3.1    Channel View Setting

6.3.1.1    Channel Mixed View

From multiple channels acquired with the Spectral Detector (SD), selected channels are mixed and 

Name Function
(1) Target Maximal 

Intensity
Specifies the application ratio of the setting of the ratio of saturation 
pixels.
Sets the percentage (%) of the maximum value to be applied. 

(2) Advanced 
Settings

If checked, advanced settings of the ratio of saturation pixels are 
enabled. 

(3) Overillumination
Tolerance (Area)

Minimum Sets the minimum value for ratio of saturation pixels.
Maximum Sets the maximum value for ratio of saturation pixels.

(4) Perform in Find 
Mode (fast)

If checked, execution in the Find mode is enabled. 

(5) Perform Auto 
Offset

If checked, the offset value is set automatically. 

(6) OK button Confirms the settings of Auto gain setup applied and closes the Auto 
gain setup window. 

(7) Cancel button Discards the settings of Auto gain setup applied and closes the Auto 
gain setup window.
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displayed. 

1. Open the Live window.

Figure 6.3-1  Live window

2. Select desired channels. 
While pressing the [Ctrl] key, click desired channels. 
To select a range, select the channel as the start point first, then while pressing the [Shift] key, click 
the channel as the end point. 
For selection of channels in multiple ranges, see Section 6.3.1.4, "Multi-Range Channel View." 

Figure 6.3-2  Channel view bar

6.3.1.2    Split Channel View

Selected channels are split into respective channels and displayed. 

1. Click the [Split Components] button. 
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"All image" mixing all channels, respective channel images, "TD image," "Ratio image," "Custom 
image" are displayed. 

Figure 6.3-3  Live window

Figure 6.3-4  Split channel view

* For switching from Split channel view to Channel mixed view, click the [Split Components] button 
again. 

2. Right-click on the [Custom] button and a menu appears. Select [Properties...] on the menu.
The Custom window appears to allow you to change the channels for the Custom View.
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Figure 6.3-5  Split channel view (Custom image)

6.3.1.3    Ratio Image View

The Ratio image view is displayed. 

Right-click on the window to display a menu.
Selecting [Ratio View] from the menu changes the window to the Ratio image. 
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Figure 6.3-6  Displaying the Ratio image view

Figure 6.3-7  Ratio image view

6.3.1.4    Multi-Range Channel View

Mouse operation for displaying multi-range channels is as follows:
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Figure 6.3-8  Multi-range channel view

1. Set and display the First range.
Click the channel at the left end of the First range. 

2. While pressing the [Shift] key, click the channel at the right end of the First range. 

3. Select the Second range.
While pressing the [Ctrl] key, click the channel at the left end of the Second range. 

4. While pressing the [Ctrl] + [Shift] key, click the channel at the left end of the Second range. 

5. Click the [Transmitted] button.
While pressing the [Ctrl] key, click the [Transmitted] button. Then, the TD image and the images 
of the selected channels are mixed and displayed. 

Figure 6.3-9  Channel mixed view
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6.3.2    Color Mode Setting

6.3.2.1    Color Mode

The color mode switching method and channel color assignment are shown below.

Select the desired color mode from three modes; True Color, Custom Color, Grouped Color and Gray 
Scale and switch the display.
To set the color mode, be sure to turn "ON" the [Treat as Spectral] button. (If it is turned "OFF," 
spectral information hidden.) 

Figure 6.3-10  Frozen window

* Settings of Custom Color, Grouped Color, Gray Scale
To configure detailed settings, use the LUTs window.
To Displaying the LUTs window is shown below. 

Click the [Show LUTs window] button or right-click on the gray area (without any setting window
displayed) to display a menu as shown below.
Select [Visualization Controls] -> [LUTs] in the menu to open the LUTs window. 
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Figure 6.3-11  Displaying the LUTs window

  Displaying the True Color Image

Images of all channel data are displayed using the wavelength colors corresponding to the wavelength 
range provided during data acquisition. 
Colors that are approximately same as those viewed by bare eyes are displayed. 

Click the [True Color] button to display the True color image. 

Figure 6.3-12  True Color image
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 Displaying the Custom Color Image  

Custom Colors are assigned to respective channel data and images are displayed using multiple channel 
data.
Custom Color assignment uses the LUTs window. 

Click the [Custom Color] button to display the Custom color image. 

Figure 6.3-13  Custom Color button

  Custom Color Setting

Click on the [Reference color] button, then opens the Select New Color window. For the Select New 
Color window, see Section 6.3.2.2, "Select New Color Window." 
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Figure 6.3-14  Custom Color setting window

* In Custom Color mode, channels between [Reference color] buttons are color-interpolated and 
displayed. 

  Displaying the Grouped Color Image  

With image acquired using the Spectral Detector, channels in a specified range can be grouped and colors 
can be assigned by group.
Grouped Color assignment uses the LUTs window.

Click the [Grouped Color] button to display the Grouped color image. 

Figure 6.3-15  Grouped Color button

  Grouped Color Setting

Click on the [Reference color] button, then opens the Select New Color window. For the Select New 
Color window, see Section 6.3.2.2, "Select New Color Window." 
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Figure 6.3-16  Grouped Color setting window

* In Grouped Color mode, the area is split by the number set in [Reference color] button. Channels in 
each area are all displayed with the same color. 

* In the channel bar of image window, can change an area too. Click the group to change, then pick 
the border between adjoining groups by the mouse and move to the right or left.

Figure 6.3-17  Grouped Color mode
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 Displaying the Gray Scale Image  

Each channel is displayed with Gray Scale (Monochrome 256 gradations).
Gray Scale assignment uses the LUTs window. 

Click the [Gray Scale] button to display the Gray Scale image. 

Figure 6.3-18  Gray Scale button

Figure 6.3-19  Gray Scale image

 Gray Scale Setting  
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Figure 6.3-20  Gray Scale setting window

* The pseudo color menu also allows changing the displayed color settings.

6.3.2.2    Select New Color Window

In this window, colors to be assigned to channels are selected.

Click the [Reference color] button on Custom Color or Grouped Color settings to display this window. 

1. In the Select New Color window, select the desired tab from three [Color palette] tabs. 

Figure 6.3-21  Select new color window (Palette)

E[Palette]
Select a color from red, green, blue, yellow, purple, cyan, and white. Colors; yellow, purple, and
cyan, support color weakness. 
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2. Select the color to be assigned.
In the [Hue] and [Wavelength] tabs, a numeric value can be directly entered or the bar displayed in 
the color range can be moved to the right or left for selection. 

Figure 6.3-22  Select new color window (Hue)

E[Hue]
A hue is set. 
A hue in a range of 0 to 240 can be set. 
A numeric value can be directly entered or the bar displayed in the color range can be moved to the 
right or left for selection. 

3. The selected color is displayed in [Sample].

Figure 6.3-23  Select new color window (Wavelength)

E[Wavelength]
A color is set using a wavelength in the wavelength range. 
A wavelength is specified with a numeric value or bar to select a wavelength color.
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6.3.3    Spectrum Profile

Brightness of the ROI area specified in the spectral image can be decomposed and displayed for each 32 
channels.

6.3.3.1    Displaying the Spectrum Profile

1. Specify the ROI area in the spectral image. (If two or more ROI areas are selected, graphs are 
displayed for the colors of the ROI selected areas on the profile graph.) 

Figure 6.3-24  Specify the ROI area (Spectral image)

2. As shown below, right-click on the gray area (without any setting window displayed) to display a 
menu. 
Select [Visualization Controls] -> [Spectrum Profile] in the menu to open Spectrum Profile. 
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Figure 6.3-25  Displaying the Spectrum Profile

Figure 6.3-26  Spectrum Profile (all ROI areas are displayed)

3. To display the ROI on the graph, remove the check mark from [Display All ROI] and select the 
desired ROI from the ROI list. 

Figure 6.3-27  Spectrum Profile (displayed for each ROI area)
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X-axis: 32-channel spectral colors displayed. 
Y-axis: ROI brightness value or background brightness value displayed. 

6.3.3.2    Spectrum Profile Setting

Figure 6.3-28  Spectrum Profile

* If any fluorescence dye is added in [Add spectra] the ideal line of fluorescence dye reaction is 
displayed on the graph and can be used as an indicator about whether the fluorescence dye is 
correctly reacting. 

Table 6.3-1   Summary of Spectrum Profile functions
Name Function

(1) Unmix Separates the wavelength information of a spectral image 
and displays an Unmixing image.
For Unmix, see Section 6.3.4, "Spectral Unmixing Setting." 

(2) Manage Stored Spectra Displays the item registered in Stored. 
(3) Export Exports numeric data to Microsoft Excel. 
(4) Display All ROI Displays all of the active ROIs. 
(5) Vertical Scale Absolute 

Enlarges the window assuming that the brightness 
minimum to maximum displayed in the graph as 100%. 

Vertical Scale Normalized 

Displays the brightness of each ROI in the Y-axis direction 
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as a relative value to 100%. (Normalizing correction) 
Scale to cursor 

Calculates the aberration of the curve so that the cross 
point between bar graphs will be Y:1 and displays a 
relative graph. 

Free cursor 

Displays a cursor that can be moved to any position. When
the cursor is picked with the mouse, brightness of the pixel 
at the cursor position can be checked as information. 

Cursor to maximum 

Moves the cursor to the maximum value of the specified 
ROIfs brightness. 

Cursor to minimum

Moves the cursor to the minimum value (0 or larger) of the 
specified ROIfs brightness. 

(6) Options 

Opens the Options window for Spectrum Profile. 
(7) Find Spectra Automatically detects spectra.

Specifies the number of classifications (2 to 4) for spectra 
to automatically separate the wavelength or use "Auto 
Search" for separation without specifying the number of 
classifications. 

(8) Define Opens the Simple ROI Editor tool. 
(9) Clear Clears the ROI area specified in the image. 

(Before clearing, a confirmation message is displayed.)
(10) Store Spectrum Stores the user-defined spectrum (wavelength information).

The spectrum defined here is also added to the fluorescence 
dye selection list in the Optical path window. 

(11) Move Up

Brings the selected spectra to one line above. 

Move down 
Brings the selected spectra to one line below. 

Add spectra 
Adds a spectrum as an indicator. 

Remove spectra 
Removes a spectrum as an indicator.
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6.3.3.3    Registering Spectrum and the Usage

The spectrum (wavelength information) defined in the Spectrum Profile window by the user is available 
as fluorescence dye on the Optical path window. 

1. Click the [Store Spectrum] button to display the Store Spectrum window. 

Figure 6.3-29  Spectrum Profile

2. Enter a fluorescence dye name in the [Spectrum Name:] field and click the [OK] button. 

Figure 6.3-30  Store Spectrum

3. Display the Optical path window. 

Figure 6.3-31  Filter and Dye window

4. Select the registered fluorescence dye name from the fluorescence dye selection menu of the 
selected channel.
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The window to select the excitation laser wavelength to be used appears. 

Figure 6.3-32  Optical path window (for auto mode)

5. Select the excitation laser wavelength to be used for this fluorescence dye and click the [OK] 
button. 

Figure 6.3-33  Selecting excitation laser

The fluorescence dye name and the excitation laser wavelength of the selected channel are updated. 

Figure 6.3-34  Optical path window (for auto mode)
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* When changing the excitation laser wavelength defined for each fluorescence dye
If you click the fluorescence dye name while pressing the [Ctrl] key with the fluorescence dye 
(for which you want to change the excitation laser wavelength) set for the channel, the 
excitation laser selection window (described in step 5) appears.
Confirm that the displayed fluorescence dye name is that for which you want to change the 
excitation laser wavelength, and then re-set the excitation laser wavelength.

6.3.4    Spectral Unmixing Setting

Separate the wavelength information of a spectral image and display an Unmixing image.
If wavelengths overlap (because multiple fluorescence dyes are in use) and differences are hard to 
identify, wavelength information can be separated and displayed. 

6.3.4.1    Displaying the Spectral Unmixing Setting

1. Specify the wavelength to be separated in the spectral image or on the Frozen window using the 
ROI area. 

Figure 6.3-35  Specifying the ROI area (Spectral image)

2. Open the Spectral Unmixing Setting window.
Select [Imagen-> [Spectral Unmixing Setting...non the menu bar.
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Figure 6.3-36  Displaying Spectral Unmixing Setting window

3. If [ROIs] is selected from [Category:] in [Source Elements], [Elements:] displays the elements 
(ROIs) of the target to be separated. 

Figure 6.3-37  Spectral Unmixing Setting

Page 40 of 536. Detection Mode SD

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh176D.htm



4. Using the [Add] button, add the elements of the target to be separated from [Elements:] in [Source 
Elements] to [Unmixing Elements]. 

Figure 6.3-38  Spectral Unmixing Setting

5. Click the [Unmix] button to open the unmixed image window separately from the Frozen window. 

Figure 6.3-39  Spectral Unmixing Setting
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Figure 6.3-40  Spectral Unmixing view

* In addition to specifying using the ROI area, wavelength information can be separated by specifying 
the fluorescence dye in use. 
However, noise provided upon image acquisition may appear. 

* If the image as a result of normal Unmix looks ambiguous, performing Unmix with the [Fast Unmix] 
check box selected may lead to a good result. 

* Specifying the background color of ROI.
As shown below, specify the ROI area in the part to be designated as the background color. 
Right-click the mouse on the created ROI area to display a menu. 
From the menu, select [Use as Background ROI].
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Figure 6.3-41  Changing the setting of the ROI area

Figure 6.3-42  Spectral Unmixing view

6.3.4.2    Spectral Unmixing Setting
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Figure 6.3-43  Spectral Unmixing Setting

Table 6.3-2   Summary of Spectral Unmixing Setting functions
Name Function

(1) Category: Displays the category of the ROI, user-registered 
wavelength information, fluorescence dye, etc. 

(2) Add> Selects the elements of the target to be separated from 
[Elements:] and adds to [Unmixing Elements]. 

(3) Elements: Selects the elements of the target to be separated. 
(4) Fast Unmix If check is turned "ON," the calculation algorithm is 

simplified and higher-speed separation is performed 
compared with normal Unmix. 

* Since Live Unmixing uses high-speed calculations 
unlike normal Unmix, Fast Unmix is not applied even 
if this check box is selected.

(5) Add Remainder Channel This function enables calculation of remainder data in the
Unmxing calculation.
When selected, the remainder data is shown as an image in 
the Unmixing calculation result.
When deselected, the remainder data is not shown. 

(6) Open 

Retrieves the setting information saved in an XML file. 
(7) Save 

Writes the setting information in an XML file and saves it.
(8) Move the Element one line 
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6.3.5    Live Unmixing

Live observation is available in the state where spectral images are separated for each wavelength. 

6.3.5.1    Displaying the Live Unmixing

1. Specify the wavelength to be separated in the spectral image using the ROI area. 

Up 

Brings the selected Element to one line above. 
(9) Move the Element one line 

down
Brings the selected Element to one line below. 

(10) Remove the Element 

Removes the selected Element. 
(11) Remove all 

Removes all Elements. 
(12) Color The graph color and post-Unmix image can be set to any 

color. 
(13) Remove Spectra Enabled only when [User Defined] or [From Blind 

Unmixing] is selected for [Category:] area.
Removes the items selected in [Elements:] area. 

(14) Rename Spectrum Enabled only when [User Defined] or [From Blind 
Unmixing] is selected for [Category:] area.
Changes the names of items selected in [Elements:] area. 

Note:

[Remainder data]

The Remainder data is used as a quality standard for the data produced by the Unmix 
calculation. 
The Remainder data is represented as an absolute value for the total of differences between 
measurement data (b) and the total of Unmixed data (a). 

This data is added as one channel data to Unmixed data.
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Figure 6.3-44  Specify the ROI area (Spectral image)

2. Open the Spectral Unmixing Setting window.
Select [Imagen-> [Spectral Unmixing Setting...] on the menu bar.

Figure 6.3-45  Displaying the Spectral Unmixing Setting window

3. If [ROIs] is selected from [Category:] in [Source Elements], [Elements:] displays the elements 
(ROIs) of the target to be separated. 
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Figure 6.3-46  Spectral Unmixing Setting

4. Using the [Add] button, add the elements of the target to be separated from [Elements:] in [Source 
Elements] to [Unmixing Elements]. 

Figure 6.3-47  Spectral Unmixing Setting

5. Click the [Close] button to confirm the wavelength you want to separate. 
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(If you click the [Unmix] button instead, normal Unmix image starts to be captured.) 

Figure 6.3-48  Spectral Unmixing Setting

* Fast Unmix
Since Live Unmixing uses high-speed calculations unlike normal Unmix, Fast Unmix is not 
applied even if the [Fast Unmix] check box is selected.

* In addition to specifying using the ROI area, wavelength information can be separated by
specifying the fluorescence dye in use. 
However, noise provided upon image acquisition may appear. 

6. Click the [Live Unmixing] button on the horizontal toolbar. If the wavelength to be separated is not 
specified, the message of "Invalid unmixing definition no unmixing elements defined." appears. 

Figure 6.3-49  Live Unmixing
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* Alternative method of switching to Live Unmixing
As shown in the figure on the right, select [Image] -> [Live Unmixing] on the menu bar. 

Figure 6.3-50  Switching to Live Unmixing

7. Click the [Live] button, the live image is switched to the Unmix live image. 

Figure 6.3-51  Acquiring the Unmix live image
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Figure 6.3-52  Live Unmixing

* Click the [Live Unmixing] button or select [Image] -> [Live Unmixing] on the menu bar again 
to return to the regular live image. 

6.3.6    Blind Unmix 

Automatically search for typical spectra and display an Unmix image separated by the spectral
wavelength information.
If wavelengths overlap (because multiple fluorescence dyes are in use) and differences are hard to 
identify, wavelength information can be separated and displayed.

Blind Unmix allows automatic separation by specifying the number of classifications or separation 
without specifying the number of classifications by using [Auto Search.]

6.3.6.1    Displaying the Blind Unmix image

1. Open the Blind Unmix window while the acquired spectral image is displayed.
Select [Image] -> [Blind Unmixing...] on the menu bar. 

2. To specify the number of classifications, select one from [2] to [4] radio button in the Number of 
Classifications pane.
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Select [Auto Search] radio button when not specifying the number of classifications.

3. Click the [Find] button to execute the Blind Unmix.
On completion of Blind Unmix, an image window opens for the image unmixed with the detected 
spectra. 

Figure 6.3-53  Blind Unmix window

Figure 6.3-54  Spectral Unmixing view
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6.3.6.2    Setting for Blind Unmix window

Figure 6.3-55  Blind Unmix window

Table 6.3-3   Summary of Blind Unmix window functions
Name Function

(1) Number of Classifications Allows you to select the number of classifications for 
automatic separation of spectral wavelength information.

Number of Classifications [2] to [4]:
Automatically separate the spectral wavelength information 
by the specified number of classifications.

Auto Search:
Automatically separate the spectral wavelength information 
without specifying the number of classifications. 

(2) Background Allows you to set the threshold for elimination of the 
background offset noise.
0 to 4095 is specifiable.
For a 16-bit spectral image, 0 to 65535 is specifiable.
(Specifying the maximum value causes all to be regarded 
as background offset noise and no spectral wavelength 
information to be detected.) 

(3) Remainder This function enables calculation of remainder data in the 
Unmixing calculation.
When selected, the remainder data is shown as an image in 
the Unmixing calculation result.
When deselected, the remainder data is not shown. 

(4) Find Starts automatic detection of the spectral wavelength 
information.
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 7   Detection Mode VF
This chapter describes the settings for the Virtual Filter mode (VF). 

The Virtual Filter is a function that provides up to four binning groups for up to 32 channels spectral 
data and adjusts brightness of each group. 

7.1    Filter and Dye Window

This window enables to set the Optical path. 

The Virtual Filter detection mode can be used when the optical path changeover lever on the C2 scan 
head is set to the [Spectrum] position and the Virtual Filter (VF) is selected as the detection mode in the 
Optical path window. 

7.1.1    Structure of Filter and Dye Window

Figure 7.1-1  Filter and Dye window (VF-use)

Table 7.1-1   Functions of Filter and Dye window (VF-use)
Name Function

(1) Detector Indicates that the Virtual Filter detection mode [VF] is used when 
the optical path changeover lever on the C2 scan head is set to the 
[Spectrum] position and the Virtual Filter (VF) is selected as the 
detection mode in the Optical path window. 

(2) Setting button Opens the Optical path window.
To use, select the detector, the dichroic mirror, the channel, 
fluorescence dye for each channel, laser and others. 

(3) Status Indicates for the settings for each channel (fluorescence dye 
name, laser wavelength, and wavelength band to be acquired). 

(4) TD Indicates the status of the motorized transmitted detector.
(5) TD IN/OUT button Sets/removes the motorized transmitted detector in/from the

optical path. 
(IN = Set in the optical path/ OUT = Remove from the optical 
path)
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7.1.2    Setting the Optical Path

Click the [Setting] button of the Filter and Dye window to display the Optical path window. 
The Virtual Filter detection mode [VF] setting screen is displayed when the optical path changeover 
lever on the C2 scan head is set to the [Spectrum] position and the Virtual Filter (VF) is selected as the 
detection mode in the Optical path window. 

There are two modes available for Optical path setting, [Auto] and [Manual]. 
Normally, the auto mode should be used. 

Figure 7.1-2  Filter and Dye window (VF-use)

As for the case where the TD IN/OUT button is not displayed, it 
will be displayed when the motorized transmitted detector is set 
in the optical path in the Optical path window. 

(6) Close mechanical 
shutter during
experiment

If unchecked, the shutter remains open during the ND image 
acquisition. 
As the shutter is not opened/closed every image acquisition, the 
time for the image acquisition can be shortened. 

* During the interval period, laser power is automatically 
changed to the minimum but the laser cannot be shut off 
completely because the shutter is left open. 

(7) Eye Port button Changes optical path to eye port. 
Each function on the C2plus Settings window becomes non-
selectable when the Eye Port button is selected. 

l Optical Configuration

Individual data items set in the Virtual Filter mode (VF) can be managed 
collectively with the Optical Configuration window.
For storing and retrieving the [Optical Configuration] settings, see the sections 
concerning the optical configuration in the "NIS-Elements AR (Advanced 
Research) User's Guide."

l Time-lapse image acquisition using the Virtual Filter (VF) mode

Detector setting change takes time because the spectral detector is used in the 
Virtual Filter (VF) mode. For this reason, the frame time may be longer than the
estimated time.
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Figure 7.1-3  Optical path window (for auto mode, VF-use)

7.1.3    Optical Path Window
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Figure 7.1-4  Optical path window (for manual mode, VF-use)

Table 7.1-2   Functions of Optical path window (VF-use)
Name Function

(1) Detection mode selection 
button 

Enabled to select the Virtual Filter mode (VF).
Binning is performed for the spectral data of the 
concurrent 32 channels to group it into up to four
groups, enabling acquisition of an image of light of a 
specified wavelength range. 

(2) Mode selector Selects the desired mode for setting the Optical path.
Auto -
Activates the auto mode. 
Once the fluorescence dye to be used is selected, the 
appropriate laser, the dichroic mirror, and the 
wavelength range acquired from the virtual channel 
are automatically selected.
Manual -
Activates the manual mode.
Enables to set all of the laser, the dichroic mirror, and 
the wavelength range acquired from the virtual 
channel to be used manually.

(3) Excitation laser indicator Displays the current setting for the laser.
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The currently set laser icon is displayed in a large size, 
and the optical path is indicated. 

(4) Channel selection check box Enables to select the channels to be used. (Up to 4 
channel.) 

(6) Sorting fluorescence dye list Sorts the fluorescence dye list according to the
selected type.

ABC:
Displays the list in alphabetical order.

Emission:
Displays the list in the order of peak wavelength of 
fluorescence intensity.

Excitation:
Displays the list in excitation wavelength order.

(6) Channel color setting button Displays the Color Selection window, enables to set 
the desired color for each channel. 

(7) Fluorescence dye 
selection/input:

In auto mode -
Selects the fluorescence dye name to be used for each 
channel.

In manual mode -
Selects the in-use fluorescence dye name for each 
channel or enters an arbitrary channel name. 

(8) Excitation laser select These menus are only effective while in the manual
mode.
Enables to set the laser wavelength that is set with the 
software configuration, regardless of the setting of the 
Filter cube display/select. 

(9) Rainbow chart Provides the following information: 

l Wavelength band for which to acquire images 
(shown in color and value for each channel)

l Spectral profile of fluorescence dye 
l Excitation laser for fluorescence dye 
l A color band indicating the wavelengths in the

entire band (400 to 750 nm) 
l Scale of the wavelengths in the entire band (400 to 

750 nm) 
(10) Acquisition range for each 

virtual channel slider bar 
Specifies the laser wavelength range to be acquired for 
each virtual channel.

* When shifting the slider bar in Auto mode, the 
Mode selector changes to manual mode. 

(11) 1st Dichroic mirror select This menu is only effective while in the manual mode.
Enables to manually select the 1st Dichroic mirror to 
be used. 

(12) Motorized transmitted detector 
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7.1.4    Optical Path Window Switching Tab

selection button

When the motorized transmitted detector is in use, 
brings the transmitted detector into the Optical path, to 
enable the ability.

Brings the transmitted detector out of the Optical path, 
to disable the ability. 

(13) ND filter installation icon An icon is displayed on the line of laser with ND filter 
installed. 

* This icon indicates whether ND filter is installed or 
not, and does not indicate insertion or removal of 
ND filter (IN = Insert in the optical path, OUT = 
Remove from the optical path).
Insertion or removal of ND filter is performed on 
the Acquisition window. 

(14) OK button Confirms the Optical path settings applied and closes 
the Optical path window. 

(15) Cancel button Discards the Optical path settings applied and closes 
the Optical path window.

l About switching between SD and VF

SD -> VF: 
The last settings in the Virtual Filter mode (VF) are recalled.

VF -> SD: 
The last settings in the Spectral Detector mode (SD) are recalled. 

l About the setting condition when the setting mode is switched

Auto mode -> Manual mode:
The entire settings in the Auto mode are retained.

Manual mode -> Auto mode:
The fluorescence dye with the same channel name as set in the manual mode is 
automatically selected.
If the same fluorescence dye name does not exist in the list, a fluorescence dye
detectable by the laser wavelength is automatically selected from the list.

In the Auto mode, the resolution and the number of channels are automatically set 
so as to accommodate the wavelength range to detect all of the selected fluorescence 
dyes.
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By selecting the manual mode at setting mode, the tab for switching between [Detector] and [Grating 
Settings] is displayed on the right top of the Optical path window. 

7.1.4.1    Detector Tab

Figure 7.1-5  Optical path window (Detector tab)

Table 7.1-3   Functions of Detector tab

7.1.4.2    Grating Settings Tab

The [Grating Settings] tab is displayed only when the manual mode is selected at setting mode.
Set the range for grating and set the wavelength range for the channels selected within the range. 

Name Function
(1) Resolution Displays the wavelength resolution currently set. 
(2) Channels Displays the number of channels (number of PMTs) currently set.
(3) Binning The number of channel binning is fixed to 1. 
(4) Acquisition range 

for each virtual 
channel slider bar 

Specifies the laser wavelength range to be acquired for each
virtual channel.

The wavelength range can be overlapped between channels.
The settable range is the grating range (the gray zone indicated in 
the rainbow chart).
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Figure 7.1-6  Optical path window (Grating Settings tab)

Table 7.1-4   Functions of Grating Settings tab

* If the grating range is changed in the Grating Settings tab, return to the Detector tab and reset the
acquisition range for each virtual channel. 

Name Function
(1) Resolution Selects a wavelength resolution.

Selectable from 2.5, 5, or 10 nm. 
(2) Channels The number of channel is fixed to 32. 
(3) Binning The number of channel binning is fixed to 1. 
(4) Grating range 

setting bar
Sets a wavelength range in a wavelength range from 400 nm to 
750 nm. 
The range depends on the grating resolution.
It is shiftable horizontally but the width of the bar cannot be 
reduced. 

(5) Start Displays the start wavelength of the Grating range currently 
selected.
The right and left buttons cannot be used when the Virtual Filter 
mode is selected. 

(6) All In the currently selected wavelength range, enables shifting to the 
right or left in units of 0.25 nm without changing the width of the 
wavelength.

(7) End Displays the end wavelength of the Grating range currently
selected.
The right and left buttons cannot be used when the Virtual Filter 
mode is selected. 

(8) Enlarge button Enlarges the rainbow chart.
The display is switched in three levels.
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7.2    Acquisition Window

The Acquisition window enables to set PMT brightness (detection sensitivity), laser power, and pinhole 
size. 

7.2.1    Structure of Acquisition Window

Figure 7.2-1  Acquisition window (VF-use)

Table 7.2-1   Functions of Acquisition window (VF-use)
Name Function

(1) Laser power monitor 
button 

Displays the laser power value (integer obtained after A/D
conversion divided by 10) of the current channel by clicking 
this button.
During the image acquisition, the laser power cannot be
measured and this button is grayed out. 

(2) Brightness adjustment 
for each channel 

For each of the virtual channels, use the Gain Laser and ND 
filter IN/OUT controls to adjust the brightness of the live image. 

(3) Channel selection Selects the virtual channels (Ch1 to Ch4, and/or TD) to acquire
the desired images. Do this by adding a check mark.

When acquiring the transmitted image (TD image) only, see 
Section 7.2.1.2, "When Acquiring Transmitted Image Only." 

(4) Select All Channels 
button

Selects all channels for acquiring images. 

(5) Laser ON/OFF button Selects whether the laser is emitted or not. 
* When LU-NV is in use, this button is grayed out and is 

disabled while the button on the front panel of the laser unit 
is OFF or blinking.
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7.2.1.1    Recommended Value Indication/Automatic Application

By the function of the recommended value indication/automatic application, the recommended values of
the appropriate resolution, zoom magnification, and Z stack step size are calculated based on the 
objective type and the selected excitation wavelength.
Using the calculated recommended values enables the image acquisition clearer and with less damage to 
the sample.

The laser is emitted.

The AOTF shutter closes and the laser power value 
becomes 0.
When switched from OFF to ON, the laser power 
value set in the previous ON status is applied. 

(6) Fluorescence dye 
name indication

The fluorescence dye name specified in the Optical path 
window is indicated. 

(7) Channel color Displays the channel color specified in the Optical path
window. 

(8) Laser wavelength 
indication 

The currently selected laser wavelength is indicated. 

(9) Si HV Adjusts HV of the Spectral detector. 
(10) Pinhole Adjusts the pinhole size.

For pinhole size, see Section 7.2.3, "Setting the Pinhole." 
(11) Brightness adjustment 

for transmitted 
detector 

For the transmitted detector, use the HV and Offset controls to 
adjust the brightness of the live image. 

(12) AG button Automatically adjusts the Si HV value (Si HV gain) of the 
currently selected channel to the optimum values.

For Auto Gain, see Section 7.2.4, "Auto Gain." 
(13) Auto Gain setting 

button
Sets the ratio of saturation pixels used for automatic Si HV gain 
correction. The window for range of the ratio of saturation 
pixels settings appears when this button is clicked.

For setting for ratio of saturation pixels, see "Setting for ratio of
saturation pixels" in the Section 7.2.4, "Auto Gain." 

(14) Optimize button Displays the XYZ Size Setup window.
In the XYZ Size Setup window, the calculation method of the 
recommended values of the resolution, zoom magnification, and 
Z stack step size can be set.

For the XYZ Size Setup window, see Section 7.2.1.1,
"Recommended Value Indication/Automatic Application."
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  Recommended Value Automatic Application  

To automatically apply the recommended values to the parameters, set the [Nyquist XY] button of the
Scan Area window to ON.

Figure 7.2-2  Scan Area window

Figure 7.2-3  Location of Recommended Value Indication

* When the laser or objective in use is changed, the recommended values are recalculated, and newly 
indicated and automatically applied.
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 Recommended Value Settings  

Detailed settings of the recommended values are made in the XYZ Size Setup window that is displayed 
by clicking the [Optimize] button of the Acquisition window.
If the [Nyquist XY] button of the Scan Area window is ON, the recommended values are automatically 
applied to the parameters.
Or if the [Nyquist XY] button is OFF, the recommended values of the scan size and zoom are indicated 
in the Scan setting window.

Figure 7.2-4  XYZ Size Setup window

Table 7.2-2   Functions of XYZ Size Setup window
Name Function

(1) Zoom Preference When the [Nyquist XY] button is ON, keeps the scan size 
and applied the recommended value of the zoom. 

(2) Resolution Preference When the [Nyquist XY] button is ON, keeps the zoom and 
applied the recommended value of the scan size.

(3) Use Cropping Fits the scan size in detail by using Crop Scan. 

(4) Suggested Step (Z)

Sets the Z step size calculation method.
Recommend (Z˜1/3
FWHM)

Approximately one third of the thickness 
of optical section (FWHM value).

Half Overlap
(Z=1/2 FWHM)

One half of the thickness of optical 
section (FWHM value).

Minimum Overlap
(Z=FWHM)

The thickness of optical section (FWHM 
value). 

Perfect Voxel
(Z=X=Y)

Value same as the pixel size.

(5) OK button Confirms the XYZ Size Setup applied and closes the XYZ 
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7.2.1.2    When Acquiring Transmitted Image Only

By using the TD channel, you can acquire the image with the TD channel only. 

1. Display the Optical path window.
Select a channel for the laser power control and deselect other unnecessary channel's check box. 

* Even when the multiple channels are selected in the Optical path window, the image with the 
TD channel only can be acquired by deselecting the unnecessary check box in the Acquisition 
window. In this case, the laser power value of the channel that is deselected at last is used for 
acquiring the TD image.

Figure 7.2-5  Optical path window (VF-use)

2. Set the transmitted detector into the optical path and then click the [OK] button to close the 
Optical path window. 

Figure 7.2-6  Optical path window (VF-use)

3. Use the HV and Offset controls of the transmitted detector to adjust the brightness of the live 
image. 

4. Use a channel that remains to "On" to control the laser power to set the laser power value.

5. Deselect the unnecessary check boxes other than TD. 

Size Setup window. 
(6) Cancel button Discards the XYZ Size Setup applied and closes the XYZ 

Size Setup window.
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Figure 7.2-7  Acquisition window (VF-use)

6. Acquire the image. 

7.2.2    Setting Image Brightness

For the live images of each Virtual channel, adjust Gain, Laser, ND filter IN/OUT, Si HV, HV (TD), 
and Offset (TD) to obtain clear images. 

Figure 7.2-8  Setting the live image brightness (VF-use)

Table 7.2-3   Brightness adjustment functions for the live image (VF-use) 
Name Function

(1) Gain Sets the PMT Gain.

Slider bar:
Slides to the right or left to set the gain value.
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Arrow buttons:
Click either arrow button to increase or decrease the gain value 
stepwise.

Direct entry in gain value display field:
Type the desired setting value.

(2) Laser (*) Sets the laser power value.

Slider bar:
Slides to the right or left to set the laser power value.

Arrow buttons:
Click either arrow button to increase or decrease the laser power 
value stepwise.

Direct entry in laser power value display field:
Type the desired setting value. 

(3) Si HV Adjusts HV of the Spectral detector. (Applied to all Virtual channel 
groups.)

Slider bar:
Slides to the right or left to set the Si HV value.

Arrow buttons:
Click either arrow button to increase or decrease the Si HV value 
stepwise.

Direct entry in Si HV value display field:
Type the desired setting value.

(4) HV Sets the voltage to be applied to the transmitted detector.

Slider bar:
Slides to the right or left to set the HV value.

Arrow buttons:
Click either arrow button to increase or decrease the HV value 
stepwise.

Direct entry in HV value display field:
Type the desired setting value.

(5) Offset Sets the offset value of the transmitted detector.

Slider bar:
Slides to the right or left to set the offset value.

Arrow buttons:
Click either arrow button to increase or decrease the offset value 
stepwise.
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Direct entry in offset value display field:
Type the desired setting value. 

(6) ND filter IN/OUT 
button (*)

Inserts/removes the ND filter in/from the optical path. (IN = Insert in 
the optical path/ OUT = Remove from the optical path)
This button is displayed only for lasers that can control 
insertion/removal of ND filter.

* When LU-NV is in use, this function is grayed out and is disabled while the button on the front panel 
of the laser unit is OFF or blinking. 

  PMT Overload

If too much gain is applied to the illumination intensity, the gain is automatically shut down to 
protect PMT and/or transmitted detector (TD), and then following PMT Overload dialog box is
displayed. 

Figure 7.2-9  PMT Overload dialog box

7.2.3    Setting the Pinhole
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Figure 7.2-10  Setting the Pinhole (VF-use)

Table 7.2-4   Pinhole setting functions (VF-use)

7.2.3.1    Calculation Settings for Pinhole Size 

This section describes the setting window for calculating the pinhole size.

Click the [Pinhole] button in Acquisition window, the A.U. Calculation Settings window appears.
(Usually, the [Recommend] is selected to enable automatic calculation. [Recommend] calculates the 
A.U. value by using the Nikon-recommended EM and NA values.) 

Name Function
(1) Pinhole size 

setting
Sets a pinhole size for C2 system.

Slider bar:
Slides to the right or left to set the pinhole size. (Unit: A.U.)

Arrow buttons:
Click either arrow button to increase or decrease the pinhole size 
stepwise.

Direct entry in pinhole size display field:
Type the desired setting value. 

(2) Pinhole button Displays the A.U. Calculation Settings window to calculate the 
pinhole size.
(For A.U. Calculation Settings, see Section 7.2.3.1, "Calculation 
Settings for Pinhole Size.") 

(3) Home Changes the pinhole to the predetermined home position.
The value of the home position can be changed in the A.U. 
Calculation Settings window.
(For A.U. Calculation Settings, see Section 7.2.3.1, "Calculation 
Settings for Pinhole Size.") 

(4) Pinhole size Indicates pinhole size of C2 system. (Unit: µm) 
(5) thickness of 

optical section
Indicates the FWHM (full width at half maximum) of z airy disk. 

(6) Optical 
Resolution

The actual size of 1 pixel square calculated from the optical
information (for objectives and scan parameters) and the size 
acquired from an image. 

(7) Reference 
excitation 
wavelength for 
the pinhole size
calculation

Selects the excitation wavelength as the reference of the automatic 
calculation of the pinhole size from the laser wavelengths, or enter it 
manually in the A.U. Calculation Settings window. (For A.U. 
Calculation Settings, see Section 7.2.3.1, "Calculation Settings for 
Pinhole Size.") 
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Figure 7.2-11  A.U. Calculation Settings window

Table 7.2-5   A.U. Calculation Settings window
Name Function

(1) Select calculation 
method

Recommend -
Sets parameters automatically. (Nikon recommended) 
User Setting -
Allows the user to manually set parameters. 

(2) EM:emission
wavelength[µm]

Selected Laser wavelength -
Calculates parameters by using the laser wavelength selected in 
the pinhole combo box of the Acquisition window as the 
emission wavelength (EM value).
The wavelength displayed in the combo box is to be the laser
wavelength set in the Optical Setting window. 
Manual -
Allows the user to manually set parameters. (The parameter is 
calculated with the input value as the emission wavelength (EM 
value).)
Enter the value directly from the keyboard.

(3) NA:Numerical 
Aperture

Sets refractive index of the objective. 
NA_obj(NA of objective lens) -
Regardless of whether or not the objective NA value exceeds 
the refractive index of the sample, executes calculation by using
the objective NA as the calculation parameter. 
Min(NA_obj, NA_sample) -
When the objective NA value does not exceed the refractive 
index of the sample, executes calculation by using the objective 
NA as the calculation parameter. When the objective NA value 
exceeds the refractive index of the sample, executes calculation
by using the sample refractive index. 

(4) "Airy" Home Position Sets a home position of pinhole.
Enter the value directly from the keyboard.

* The pinhole size can be selected from six types in C2. 
Therefore, if the entered value does not match any of the types, 
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7.2.4    Auto Gain

Auto Gain is a function to automatically correct the value of Si HV gain to set the optimum image 
brightness.
Automatic Si HV gain correction is performed within the predetermined range of the ratio of saturation 
pixels. 

Automatic Si HV gain correction is performed only Si HV.
For a TD, automatic adjustment is performed when it is selected. 

After execution of Auto Gain, in the window indicating the progress of Auto Gain, the correction values 
actually used (ratio of saturation pixels) are displayed.
If Auto Gain failed, "x" is indicated and the Si HV value returns to its original value. 

the size that is larger than and the closest to the entered value is 
set as the home position.

(5) Keep A.U. check box When checked, the pinhole size is fixed by the A.U. when the 
selected wavelength or objective is changed. (However changes 
by the um.) 
When unchecked, the pinhole size is fixed by the um. (However 
changes by the A.U.)

* The pinhole size can be selected from six types in C2. 
Therefore, if the to-be-fixed A.U. value does not match any of 
the types, the size that is larger than and the closest to the A.U. 
value is selected. 

(6) OK button Confirms the A.U. Calculation Settings applied and closes the
A.U. Calculation Settings window. 

(7) Cancel button Discards the A.U. Calculation Settings applied and closes the 
A.U. Calculation Settings window.

l When setting the line scan, Auto Gain cannot be executed. 
l During execution of Auto Gain, do not perform manual adjustments in the 
Acquisition window.
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Figure 7.2-12  Execution of Auto Gain (VF-use)

Figure 7.2-13  Auto Gain progress

  Setting for ratio of saturation pixels  

Set the maximum and minimum value for the ratio of saturation pixels used for automatic Si HV gain
correction.

Click the [Auto Gain Setting] button to display the Auto gain setup window.
Set the maximum and minimum value for the ratio of saturation pixels in the Auto gain setup window. 
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Figure 7.2-14  Displaying the Auto gain setup window

Figure 7.2-15  Setting for ratio of saturation pixels

Table 7.2-6   Setting for ratio of saturation pixels

7.3    Various Views (Virtual Filter mode-use)

This section describes various Virtual Filter mode (VF) views. 

7.3.1    Channel View Setting

Name Function
(1) Target Maximal 

Intensity
Specifies the application ratio of the setting of the ratio of saturation 
pixels.
Sets the percentage (%) of the maximum value to be applied. 

(2) Advanced 
Settings

If checked, advanced settings of the ratio of saturation pixels are 
enabled. 

(3) Overillumination
Tolerance (Area)

Minimum Sets the minimum value for ratio of saturation pixels.
Maximum Sets the maximum value for ratio of saturation pixels.

(4) Perform in Find 
Mode (fast)

If checked, execution in the Find mode is enabled. 

(5) Perform Auto 
Offset

If checked, the offset value is set automatically. 

(6) OK button Confirms the settings of Auto gain setup applied and closes the Auto 
gain setup window. 

(7) Cancel button Discards the settings of Auto gain setup applied and closes the Auto 
gain setup window.
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7.3.1.1    Channel Mixed View

Images acquired in the Virtual Filter mode (VF) are displayed in the method suitable to the purpose. 

  All image  

The [All] tab is selected, all the virtual channels are mixed to display. 

Figure 7.3-1  All image

 Each channel image  

To display the image of each virtual channel, select the tab corresponding to the channel.
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Figure 7.3-2  Each channel image
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Figure 7.3-3  TD image

 Custom image  

Custom image displays a mixed image of selected multiple channels.
To change channels to be mixed, re-select channels. 

Right-click on the [Custom] tab and a menu appears. Select [Properties...] on the menu.
The Custom window appears to allow you to change the channels for the Custom View.

Page 24 of 297. Detection Mode VF

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh784.htm



Figure 7.3-4  Selecting channels (Custom image)

  Ratio Image

The Ratio image view is displayed.

Right-click on the window to display a menu.
Selecting [Ratio View] from the menu changes the window to the Ratio image. 
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Figure 7.3-5  Displaying the Ratio image view
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Figure 7.3-6  Ratio image 

* You can change the combination of channels to be displayed in the Ratio View.
Right-click on the window and a menu appears. Select [Ratio Properties...] on the menu. 
The Ratio Properties window appears to allow you to change the channels for the Ratio View. 

Figure 7.3-7  Ratio Properties window
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7.3.1.2    Split Channel View

Virtual channels are split into respective channels and displayed.

Click the [Split Components] button. 
"All image" mixing all channels, respective channel images, "TD image," "Ratio image," "Custom 
image" are displayed.

Figure 7.3-8  Frozen window
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Figure 7.3-9  Split channel view

* For switching from Split channel view to Channel mixed view, click the [Split Components] button 
again. 

Page 29 of 297. Detection Mode VF

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh784.htm



 8   Scan Setting Window
This window enables to set scanning conditions, such as resolution, scan speed, and magnification. 
The setting items in the Scan setting window vary, for example depending on the scan area.

In the Standard Detector mode [DU3], imaging is possible with 2048 x 2048 pixels at maximum. In the 
Spectral Detector mode [SD] and Virtual Filter mode [VF], imaging is possible with 1024 x 1024 pixels 
at maximum.

8.1    Structure of Scan Setting Window

Figure 8.1-1  Scan setting window

Table 8.1-1   Summary of functions in Scan setting window
Name Function

(1) Scan setting Sets conditions for scanning.
For details of scan settings, see Section 8.3, "Scan
Settings." 

Scan Direction: 
Selects Unidirectional or Bidirectional scan. 

Scan Size: 
Selects a resolution. (Unit=pixel) 

Fast button: 
Turning on this button makes the scan speed high.
When a Fast Galvano compatible model (C2plus) that
supports high scan speed is in use, the scan speed is further 
increased by turning on the [Fast] button and set the scan 
magnification to 8X or higher.

* For speeding-up of the scan speed, see Section 8.3.1, 
"Fast Mode."

Selecting Scan Speed: 
Selects a scan speed.
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8.2    Relationships among Scan Area Shape, Resolution, and 
Scan Speed

This section describes the relationship of the resolution and scan speed in the Scan setting window, and 
the relationship of the scan area shape set in the navigation mode versus the resolution and scan speed. 

 Relationship of resolution and scan speed  

Once a Scan Size (resolution) is set, the software automatically generates a list (see Table 8.2-1) of the 
scan speeds available with that resolution, making them selectable from the Scan Speed pull-down 
menu. 

For example, suppose you set the resolution for the Square scan area to X = 512 and Y = 512 pixels, and 
select the Unidirectional scan. Then, values listed in the Scan Speed pull-down menu are: 0.06, 0.125, 
0.25, 0.5, 1, or 2 (enable selecting when Fast mode is turned on), or 4 (enable selecting at 8X or higher 
scan magnification and when Fast mode is turned on.) 

* The performance at the scan speed is not guaranteed. It varies depending on the environment. 

* When the Band scan area is selected in the Galvano scan mode, scan speed values listed in the Scan 
Speed pull-down menu are guideline, which may not be the actual scan speed. 

  Retention of Scan Settings for Different Scan Areas  

For each scan area shape, the latest Scan settings are retained.
Once a scan area is selected in the navigation mode, the navigation mode displays the scan area that has 
been set at last, and the Scan setting window displays the set values of Scan settings. 

  Automatic Change of Scan Settings with Change in the Band Scan Area Shape  

If the ratio of X and Y lengths of the Band scan area is changed:

Scan magnification: 
Sets a scan magnification.

(2) Scan Zoom Reset button Sets the scan magnification to 1.000. 
(3) Switch button for the 

previous setting
Returns to the previous setting. 

(4) Scan Area window button Displays the Scan Area window.
For details of Scan Area window, see Chapter 9. 
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Resolution: Does not change
Scan speed: Changes based on the new ratio of X and Y lengths, in a manner that gives the same pixel 
dwell.

Table 8.2-1   Combinations of resolution and scan speed (Square scan area)
Resolution 

64 (not
available 

in VF 
mode)

128 (not 
available 

in VF 
mode)

256 512 1024

2048 (not 
available in 
SD and VF 

mode)
0.03 Uni-scan Uni-scan
0.04 Uni-scan Uni-scan
0.06 Uni-scan Uni-scan Uni-scan
0.125 Uni-scan Uni-scan Uni-scan
0.25 Uni-scan Uni-scan Uni-scan Uni-scan
0.5 Uni-scan Uni-scan Uni-scan
1 Uni-scan Uni-scan Uni-scan

2 Uni-scan Uni-scan
Uni-scan *1

Bi-scan

3 Bi-scan *1

3.5 Bi-scan

4 Uni-scan Uni-scan Uni-scan *1 Uni-scan *2

6 Bi-scan *1

7 Uni-scan Uni-scan *1

8 Uni-scan *2 Bi-scan *2

12 Uni-scan *1

15 Bi-scan *2
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For Band scan area

l The scan speed list is automatically changed depending on the Y resolution. 

Example 1.

For resolution is 512 pixel and 1/2 band scan, "0.125, 0.25, 0.5, 1, 2, 4
(*1)

, or 8 (*2)" are listed as the 
scan speed.

Example 2. 
For resolution is 512 pixel and 1/4 band scan, "0.25, 0.5, 1, 2, 4, 7 (*1), or 15 (*2)" are listed as the scan 
speed.

Example 3. 
For resolution is 512 pixel and 1/6 band scan, "1, 2, 4, 8, 12, 18 (*1), or 50 (*2)" are listed as the scan 
speed.

(*1) Selectable scan speed when Fast mode is turned on. (For C2 and C2plus)

(*2) Selectable scan speed at 8X or higher scan magnification and Fast mode is turned on. (For only 
C2plus) 

8.3    Scan Settings

This section describes the Scan settings. 

  S
can speed 

Marks in the table

*1 mark indicates that selectable scan speed when Fast mode is turned on. (For C2 and C2plus) 

*2 mark indicates that selectable scan speed at 8X or higher scan magnification and Fast mode is turned 
on. (For only C2plus) 

: Indicates that the combination is unavailable in the SD and VF mode. 

l Scan in the Virtual Filter mode (VF)
When the Virtual Filter mode is selected, the scan time varies with the set number 
of channels. ("Time calculated by the displayed scan speed" x "number of 
channels")
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Figure 8.3-1  Scan settings

Table 8.3-1   Functions of Scan settings
Name Function

(1) Scan Direction Toggles between Unidirectional and Bidirectional scan.
Bidirectional scan is only selectable if the Square scan area, 
Band scan area, or Line scan area is set. 
By default, Unidirectional scan is selected.
Bidirectional scan is not available when the SD or VF mode is 
selected. 

(2) Scan Size Sets the scan resolution in the X-direction. (Setting unit: Pixel)
The resolution in the Y-direction is automatically calculated 
from the X to Y ratio of the scan area.

Pull-down menu:
Selects the desired resolution from this list.

UP and Down buttons:
Click these to select resolutions one after another. 

(3) Fast button Turning on this button makes the scan speed high.

When a Fast Galvano compatible model (C2plus) that supports 
high scan speed is in use, the scan speed is further increased by
turning on the [Fast] button and set the scan magnification to 
8X or higher. 

* For speeding-up of the scan speed, see Section 8.3.1, "Fast 
Mode."

(4) Selecting Scan Speed Sets scan speed. (Setting unit: Frame/sec or lines/sec in line 
scan mode)

Pull-down menu:
Selects the desired scan speed from this list.

UP and Down buttons:
Click these to select scan speeds one after another. 

(5) Scan magnification Sets scan magnification.

Slider bar:
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  Correcting the Image Shifting when Setting Bidirectional Scan  

Image shifting correction when Bidirectional scan is selected is shown below.
When Bidirectional scan is selected from Scan Direction, the [Direction mismatch adjustment] button 
appears for shift correction. 
Click this button to display the Align bidirectional scanner window. 

Figure 8.3-2  Correcting the image shifting for Bidirectional scan

Figure 8.3-3  Align bidirectional scanner window

Slides to the right or left to set the scan magnification.

Arrow buttons:
Click either arrow button to increase or decrease the scan
magnification stepwise.

Direct entry in scan magnification display field:
Type the desired setting value. 

(6) Pixel Dwell Indicates the laser irradiation time per pixel.
This value is automatically confirmed from scan resolution and
speed. 

l If the Spectral Detector mode or the Virtual Filter mode is selected as the detection
mode, the bidirectional scan cannot be executed.
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Table 8.3-2   Correcting the image shifting for Bidirectional scan 

8.3.1    Fast Mode

Turning on the Fast button makes the scan speed ultra-high. 

When a Fast Galvano compatible model (C2plus) that supports high scan speed is in use, the scan speed 
is further increased by turning on the [Fast] button and set the scan magnification to 8X or higher.

Figure 8.3-4  Fast mode

 Notes on the use of Fast mode (when scan magnification of 8X or higher is selected)  

Note the following restrictions when a scan magnification of 8X or higher is selected in the Fast mode. 

l Only when 256 or 512 is selected for Scan Size, the scan speed is further increased. 

l When Scan Area rotation has been set, turning on the [Fast] button resets the rotation angle. 

l The Fast mode cannot be used together with the Spectral Detector mode (SD) or Virtual Filter 
mode (VF). (If the Optical path changeover lever for scan head is changed to Spectrum while the 
Fast mode is turned on, the Fast mode is automatically turned off.) 

Item Description
Image shift correction range -50 to 50
Image shift correction action Sets the correction value.

Slider bar:
Slides to the right or left to set the correction value.

Arrow buttons:
Click either arrow button to increase or decrease the
correction value in steps of 0.1.

Direct entry in correction value display field:
Type the correction value.

Page 7 of 98. Scan Setting Window

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhA629.htm



l If correction of image deviation is greatly changed in the bidirectional scan, it takes several 
seconds until the correction is applied, but this is no problem. Wait until the correction is applied. 

To perform fast image acquisition in the Fast mode, the following conditions must be met.
Otherwise, the image acquisition speed may be lower than the specified speed.

(1) The Power Options setting of the Windows 7 OS must be set to [High Performance]. 

* To make the Power Options setting, click the [Start] button > [Control Panel] > [Power 
Options] to display the [Select a power plan] window.
On the [Select a power plan] window, click [Show additional plans] and select [High 
Performance]. 

(2) The network must be the onboard network of recommended PC and no other expansion network 
card must be installed. 

Table 8.3-3   Details of Fast mode when scan magnification of 8X or higher is selected 

8.4    Unidirectional and Bidirectional Scan

8.4.1    Unidirectional and Bidirectional Scan Motion

Unidirectional scan consists of "forward paths" only, while Bidirectional scan uses both "forward and 
reverse paths." 
Thus, Bidirectional scan takes less time to acquire a given image, but it causes shifting between the 
image scanned along the forward path and that scanned along the reverse path.
It is therefore necessary to correct the image shifting when Bidirectional scan is selected. 

Available Scan Size 256 512

Scan Speed
Unidirectional 7 fps 4 fps
Bidirectional 15 fps 8 fps

Available Detector DU3 Only
Scan Zoom x8 to x1000
Scan area rotation function Unavailable
CROP scan area Unavailable
ROI scan area Unavailable
Free line scan Unavailable
Photo activation experiment Unavailable
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Figure 8.4-1  Unidirectional and Bidirectional scan motion

8.4.2    Scan Settings upon Toggling between Unidirectional and Bidirectional Scan

When you change from Bidirectional scan to Unidirectional scan, or vice versa, the new scan may not be 
executable with the current scan settings. 
In that case, the Scan setting can be automatically changed. 
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 9   Navigation Mode
The navigation mode enables to set the scan area in acquired images.
There are two types of navigation modes. 
If settings on either window are changed, display of the scan area, etc., on the other window changes in 
an interlocked manner.

9.1    How to Display Navigation Mode

The procedure of how to display each window is shown as follows.

  Scan Area Window

How to display the Scan Area window is shown below.

Click the button shown below to open the Scan Area window. 

Figure 9.1-1  To display the Scan Area window

Page 1 of 189. Navigation Mode

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhF37E.htm



Figure 9.1-2  Scan Area Window

* Other display methods 
As shown below, right-click on the gray area (without any setting window displayed) to display a 
menu.
Then select [Acquisition Controls] -> [C2plus Scan Area] in the menu to open the Scan Area 
window. 

Figure 9.1-3  To display the Scan Area window

  Navigation Mode

How to display the navigation mode is shown below.
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The navigation mode is displayed by clicking [Show Scan Area] button in the Live window (which 
opens when the live image is acquired) or the Captured window (in which the live image was
captured). 

Figure 9.1-4  Live window
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Figure 9.1-5  Navigation mode

9.2    Structure of Navigation Mode

Figure 9.2-1  Navigation mode

Table 9.2-1   Summary of navigation mode functions
Name Function

(1) Show Scan Area button Switch the Live window to the navigation mode. 
(2) Scan area setting tools Provides tools for setting a scan area. 

A scan area of a selected shape can be set.
Available tools vary depending on the scan mode and the 
type of scan area. 
For scan areas that can be set, see Section 9.3, "About Scan
Areas." 

(3) Scan area view A set scan area is displayed as green lines.
If two or more ROI scan areas are set, colors of displayed 
lines are different.
The lines are displayed in light blue for the Crop scan area. 

(4) Channel selection tabs 

All tab -
Displays the overlaid images of all channels. 
Fluorescence dye name tabs -
Displays the fluorescence dye names of each channel. 
Clicking each tab displays only the image of the 
corresponding channel.
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9.3    About Scan Areas

There are three types of scan areas according to their shape. They are the Square scan area, the Band 
scan area and the Line scan. 

Additionally, two other types are available. They are the ROI scan area and the Crop scan area, designed 
to serve particular purposes.

"NIS-Elements C" allows the user to store and retrieve the scan area settings (except for ROI scan area).
For storing and retrieving the [Optical Configuration] settings, see the sections concerning the optical
configuration in the "NIS-Elements AR (Advanced Research) User's Guide."

9.3.1    Conditions for Setting Scan Areas

The following table shows conditions for setting scan areas. 

Table 9.3-1   Conditions for setting scan areas

(*1) Unsettable when the Virtual Filter [VF] is selected as the detection mode.
(*2) Usable only when the Standard Detector [DU3] is selected as the detection mode.

Scan area Function Parameter limits
Square Rotation -90 to 90° 

Magnification As desired (1X to 1000X) 
Resolution Both X and Y: 64 (*1), 128 (*1), 256, 512, 1024, or 2048 (*2)

pixels 
X to Y ratio X = Y 

Band Rotation -90 to 90° 
Magnification 1X to 1000X 
Resolution X: 64 (*1), 128 (*1), 256, 512, 1024, or 2048 (*2) pixels 

Y: 32, 64, 128, 256, 512, or 1024 (*2) pixels 
X to Y ratio X > Y

Line Line type Straight line only
Magnification 1X to 1000X
Resolution X: 64 (*1), 128 (*1), 256, 512, 1024, or 2048 (*2) pixels

l The rotation angle and the Crop scan area cannot be set when the Bidirectional 
scan is selected.

l The "ROI scan area" and the "Crop scan area" are effective for the Square scan 
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9.3.2    Scan Area Setting Tools

The available scan area setting tools include the Square setting tool, Band setting tool, Line setting tool, 
ROI setting tool and Crop setting tool. 

Figure 9.3-1  Scan area setting tools

Table 9.3-2   Functions of scan area setting tools

area.

l Parameters of the "ROI scan area"and the "Crop scan area"depend on the scan 
area.

Name Function
Square setting tool The Square scan area of a desired size can be set.

The X and Y-directions are always of the same resolution. 
Band setting tool The Band scan area of a desired size can be set.

The Y-direction resolution is always lower than the X-direction
resolution. 

Line setting tool 

The Line scan (straight line scan) of a desired length and angle can 
be set.
The line width is 1pixel. 
Images can be acquired in the X and T-directions.
X and T-directions -
Timelapse observation is carried out only to the area specified by the 
Line.

Crop setting tool Enables to set a smaller rectangular scan area within the Square scan 
area. 
The file size of image data can be decreased without changing the 
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  Square Scan Area

The Square scan area appears when the square setting tool is selected. 

l By default, the Square scan area occupies the whole of the image window.

l Only one Square scan area can be set in a single image.

l The Square scan area cannot be removed.

l The Square scan area that appears upon selecting the square setting tool is the one that was set 
previously.

l In the image window, the Square scan area can be set to any position and any size. 

scan speed by cutting off unnecessary parts.
The resolution in Y direction is the same or lower than the resolution 
in X direction. 

* The Crop setting tool is not displayed when the Bidirectional 
scan is selected.

ROI setting tool Enables to set the laser irradiation area with any shape.
The scan area includes all ROIs. 

Reset button Resets the current scan area settings. 

l Z-direction setting when scanning a cross section

The Z-direction will be set by NIS-Elements. 
For setting instructions, refer to "NIS-Elements AR (Advanced Research) 
User's Guide."
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Figure 9.3-2  Square scan area

Table 9.3-3   Functions of the Square scan area and their operation

  Band Scan Area

The Band scan area appears when the band setting tool is selected.

l By default, the Band scan area has the X-direction length equal to the width of the image window, 

Function Operation
Resize scan area Drags the point placed at each corner, or at the center of each side, of 

the scan area. The scan area can be enlarged or reduced to a desired 
size, while retaining the square form. 

Rotate scan area Places the mouse pointer over the rotation point located outside the 
scan area. As the pointer changes to the rotation pointer, drag it to 
rotate the scan area. The rotation range is -90 to 90 degrees. 
The scan area can be rotate only within the display area of the image 
window. It cannot be rotate outside the display area.

Move scan area Places the mouse pointer on a side of the scan area. As the pointer 
changes to the move pointer, drag it to move the scan area.
The scan area can be moved only within the display area of the 
image window. It cannot be moved outside the display area.
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and the Y-direction length equal to 1/2 of the X-direction length, with its center at the center of the 
image window.

l Only one Band scan area can be set in a single image.

l The Band scan area cannot be removed.

l The Band scan area that appears upon selecting the Band setting tool is the one that was set 
previously.

l The Band scan area can be set to any position in the image window, and to any size that meets the 
condition "X-direction length > Y-direction length." 

Figure 9.3-3  Band scan area

Table 9.3-4   Functions of the Band scan area and their operation
Function Operation
Resize scan area Drags the point placed at each corner, or at the center of each side, of 

the scan area to enlarge or reduce the size as desired. 
Point at each corner -
The size can be enlarged or reduced as desired while retaining the 
ratio of X to Y-direction lengths. 
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  Resolution of Band Scan Area

This section describes the X and Y-direction resolution of the Band scan area. 

Table 9.3-5   Resolution of Band scan area

(*1) Unsettable when the Virtual Filter [VF] is selected as the detection mode.
(*2) Usable only when the Standard Detector [DU3] is selected as the detection mode.

l If the Band scan area is resized:
For the X-direction, the resolution does not vary even if the X-direction length is changed. 
For the Y-direction, if the X-direction and/or the Y-direction length is changed, the ratio of X to Y-
direction lengths varies. 
Based on the new ratio, the Y-direction resolution is automatically recalculated and set. 

Example:
Assume that the X-direction resolution = 512 pixels, the Y-direction resolution = 256 pixels, and the 
ratio of X to Y-direction length = 1:1/2.
If the Band scan area is changed and the resultant ratio of X to Y-direction lengths = 1:1/4, the Y-
direction resolution is set to 128 pixels.

l If the X-direction resolution is changed:
The Band scan size does not vary either in the X or Y-direction. 

Point at the center of each side -
The X and Y sizes can be changed individually provided that "X-
direction length > Y-direction length."

Rotate scan area Places the mouse pointer over the rotation point located outside the 
scan area. As the pointer changes to the rotation pointer, drag it to 
rotate the scan area. The rotation range is -90 to 90 degrees.
The scan area can be rotate only within the display area of the image
window. It cannot be rotate outside the display area. 

Move scan area Places the mouse pointer on a side of the scan area. As the pointer 
changes to the move pointer, drag it to move the scan area. 
The scan area can be moved only within the display area of the 
image window. It cannot be moved outside the display area. 

X-direction 
resolution 

A desired X-direction resolution is selected from 64 (*1), 128 (*1), 256, 512, 
1024, and 2048 (*2) pixels 

Y-direction 
resolution

The Y-direction resolution is automatically set as it is calculated from the
ratio of X to Y-direction lengths. 

Example:
If the X-direction resolution = 512, and the ratio of X-direction length to Y-
direction length = 1:1/2, then the Y-direction resolution is set to "256." 
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The Y-direction resolution is automatically set as it is recalculated from the ratio of X and Y-
direction lengths. 

Example:
Assume that the ratio of X-direction length to Y-direction length = 1:1/2, where the X-direction 
resolution = 512 pixels and the Y-direction resolution = 256 pixels.
If the X-direction resolution is changed to 256 pixels, the Y-direction resolution is set to 128 pixels. 

  Line Scan

The Line scan area appears when the Line setting tool is selected. 

l The Line scan has no default value.

l Line scan drawing can be set on the Live window, but is hidden after the live image has been 
acquired and is displayed only on the Scan Area window. 

l Only one Line scan can be set in the single image.

l The Line scan cannot be removed. 

l The Line scan that appears upon selecting the line setting tool is the one that was set previously.

l In the image window, the Line scan can be set to any position and any length and angle.

l The Line scan can be used in the live acquisition and in the timelapse acquisition with no delay.

Figure 9.3-4  Line scan
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Table 9.3-6   Functions of the Line scan and their operation

  Crop Scan Area

Enables to set a smaller rectangular scan area within the Square scan area. 
The file size of image data can be decreased without changing the scan speed by cutting off unnecessary
parts. 

l For the Crop scan area, a rectangle only can be selected.

l Only one Crop scan area can be set on an image.

l Any position and any size can only be set within the Square scan area.

l If the Crop setting tool is selected, the previously set the Crop scan area is displayed.

l The resolution in Y direction is the same or lower than the resolution in X direction.

l Unusable in the Bidirectional scan.

l When the Crop scan area is set, the acquired image becomes bright because Pixel Dwell cannot be 
retained.

Functions operation
Change scan line Drags the both ends of the line to change the line length or angle. 

* Settable scan line length varies depending on the [Fast] button 
ON/OFF state in the Scan setting window. For the [Fast] 
button, see Section 8.3.1, "Fast Mode."

Rotate scan line The Line scan allows a line to be drawn with a desired length and at 
a desired angle on the Scan Area window, thus it does not provide a 
function to rotate it. 

Move scan line Places the mouse pointer on a side of the scan line. 
As the pointer changes to the move pointer, drag it to move the scan 
line. 
The scan line can be moved only within the display area of the Scan 
Area window. It cannot be moved outside the display area. 
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Figure 9.3-5  Crop scan area

Table 9.3-7   Functions of the Crop scan area and their operation

  ROI Scan Area

Clicking the [Edit ROIs inside Square Area] button of the ROI setting tool displays the ROI Editor. 
Use the ROI Editor to set a scan area with any shape. 

l Unusable when the image resolution is 2048.

l Two or more ROI scan areas can be set on an image. 

Functions operation
Resize scan area When the mouse pointer is placed on a corner or side of the Crop 

scan area, an arrow pointer is displayed. 
Clicking the mouse while an arrow is displayed and dragging in the 
arrow direction enables to enlarge or reduce to any size. 
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Figure 9.3-6  ROI scan area

* Drawn ROIs are hidden when the ROI Editor is closed, but you may check the scan areas on the 
Scan Area window.

Figure 9.3-7  ROI Editor
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Table 9.3-8   Functions of the ROI scan area drawing tool
Name Functions and their operations

(1) Pointing Used to move a drawn ROI on the window. 
(2) Rectangle Used to designate the scan area enclosed by a rectangle. 
(3) Ellipse Used to designate the scan area enclosed by a circle.

Circle
Clicks the center of the desired circle to draw a precise 
circle with a radius of the dragged length. 

3pt 
Circle

Designates any three points by clicking on the image to 
draw a precise circle that passes the three points.

Npt 
Circle

Designates multiple points by clicking on the image to
automatically select several points nearest to the circle to 
draw a precise circle. 

Ellipse

Clicks the center of the desired circle to draw a precise
circle with a radius of the dragged length.
When the base point on the top, bottom, right, or left of 
the circle is picked and dragged, the circle deforms to an 
ellipse.
When the drawn circle is picked and dragged with the 
mouse, the circle moves to another position.
Right-clicking on the drawn circle designates the circle as 
the ROI scan area. 

4pt
Circle

Designates any four points by clicking on the image to 
draw a precise circle that passes the four points. 

(4) Polygon Used to designate the scan area enclosed by straight lines. 
Designates the start point by clicking on an image and moving the 
pointer to the straight line ending position (end point) and clicking 
draws a straight line. Draw straight lines subsequently to draw a 
polygon. 
To close the selected area by connecting straight lines to each other, 
place the mouse pointer on the start point and double-click the 
mouse. 
Double-clicking the pointer at a position different from the start 
point can also close the selected area. 

(5) Bezier drawing
tool

Used for freehand drawing or for drawing a straight line or smooth 
curve by placing anchor points. 
For freehand drawing, click the mouse on the image then drag the 
mouse. 
To draw a curve using anchor points, drag the mouse in the curving 
direction. 
To close the selected area, right-click the mouse. (Double-clicking 
the mouse left button also closes the selected area.) 

(6) Auto Detect
(Adjacent similar
colors) 

Used to automatically detect and specify the similar color portion 
adjacent to the clicked position. 
By clicking the mouse on the image, the similar color portion 
adjacent to the clicked position is selected. 
To fix the selected area, right-click the mouse.

(7) Clear Clears the ROI scan area. 
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9.3.3    Switching Scan Area Setting Tools

The scan area setting tool can be switched by clicking the respective buttons. 
Before using the Crop setting tool and the ROI setting tool, turn the [Show Scan Area] button to "OFF." 

Figure 9.3-8  Scan area setting tools

When one scan area setting tool is switched to another setting tool, the information of the previous scan 
area is stored even after the display of the previous scan area disappears from the window. 

For example, if the Square scan area is set using the square setting tool and then switches over to the 
band setting tool and set the Band scan area, when the square setting tool is switched back, the Square 
scan area appears. (As shown below) 

(8) Help Displays the help for ROI Editor. 
(9) Finish Finishes drawing and editing of the ROI scan area and closes the 

ROI Editor.
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Figure 9.3-9  Storing scan area settings

9.3.4    Scan Area Zoom Function

The scan area zoom function is effective for the Square scan area and the Band scan area. 

Set the Square or the Band scan area around the portion of the live image to be enlarged. Then, acquire 
the live image, and the portion set with the scan area appears enlarged.

Figure 9.3-10  Scan area zoom function
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9.3.5    Scan Area Rotation Function

The scan area rotation function is effective for the Square scan areas and the Band scan areas.

Set a rotated square or the Band scan area around the portion of the live image to be rotated. Acquire the 
live image once again, and the rotated scan area appears in upright position.

This function rotates a set scan area, and at the same time, applies the scan area zoom function.

The scan area cannot be rotated when the Bidirectional scan is set.

Figure 9.3-11  Scan area zoom and rotation function

Page 18 of 189. Navigation Mode

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhF37E.htm



 10   Photo Activation Setting
This chapter describes the basic operation procedures to execute the photo activation experiment 
sequence that acquires images of target changes at a high speed while irradiating the stimulation laser
beam and acquire the observed images. 

* When a three-laser unit without AOM is connected, the photo activation experiment cannot be 
executed. 

* When the Virtual Filter mode is selected, the photo activation experiment cannot be executed. 

10.1    Photo Activation Setting Procedure

1. Acquire the image of sample for photo activation. 

Figure 10.1-1  Acquire a live image

Figure 10.1-2  Acquire a frozen image
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Figure 10.1-3  Frozen image

2. In the Acquisition window, set the image to be acquired through photo activation experiment 
observation. 
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Figure 10.1-4  Acquisition setting window

3. Specify an area, point, or line to which the photo activation is to be applied with the Simple ROI 
Editor.
For details of the Simple ROI Editor, see Section 10.2.3, "Simple ROI Editor." 

Figure 10.1-5  Setting of a ROI area

Figure 10.1-6  Simple ROI Editor

4. Specify a photo activation area.
Draw a ROI area on the acquired image.
Right-click on a designated ROI area to display a menu.
Select [Use as Stimulation ROI: S1] from the displayed menu and designate a ROI area as the 
photo activation area. 

If you wish to assign multiple photo activation areas to separate photo activation frames, select
[Use as Stimulation ROI: S2] or [Use as Stimulation ROI: S3]. (Only when a photo activation ROI 
area is selected.) 

* Multiple ROIs can be set for each photo activation frame.
ROI can be divided into frames to set different stimulation conditions. 
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Figure 10.1-7  Setting of photo activation area 

* To specify a photo activation point, select [Stim. Point] of the Simple ROI Editor and specify a 
point on the image. 

* To specify a photo activation line, select [Stim. Line] of the Simple ROI Editor and specify a
line on the image. 

* You can specify only one photo activation point/line and cannot specify multiple photo 
activation target areas. 

* You can crop the specified ROI area and set a non-photo activation area within the photo 
activation ROI area. Click the [Draw Holes] button of the Simple ROI Editor and then select a 
drawing tool. Then draw an area to be cropped on the pre-selected ROI area. (Point drawing 
tools are unavailable for specifying a non-photo activation area.) 
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5. Switch to the Photo Activation window. 
Select the stimulation laser beam and set the laser power and photo activation speed. (For 
stimulation laser setting, see Section 10.2.2, "Laser Setting for Photo Activation.") 

Figure 10.1-8  Switching to Photo Activation window 

6. Select HV mode in Photo Activation.

* The HV mode can be set only when [DU3] is selected for the detection mode. For details of
settings, see Section 10.1.2, "Setting HV Mode in Photo Activation."

Figure 10.1-9  HV mode

7. For each photo activation frame, set the stimulation laser beam, laser power, and photo activation 
speed. If you set multiple photo activation areas on the same frame, all of the specified ROIs are
photo-activated at the same time.
(If two ROIs are the photo activation targets, a photo activation frame photo-activates the two 
ROIs. In this case, photo activation may take time even though each photo activation area (ROI) is
small.) 
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Figure 10.1-10  Laser Setting for Photo Activation (Specify the photo activation ROI area) 

* When a photo activation point/line is specified, photo activation target area is limited to only 
one. Therefore photo activation frame cannot be set.
When a photo activation point is specified, the photo activation speed cannot be set. 

Figure 10.1-11  Laser Setting for Photo Activation (Specify the photo activation line) 

8. Click the [Photo Activation] button to open the ND Stimulation window. 

Figure 10.1-12  Photo activation button

* Other display methods
As shown below, select [Applications] -> [Define/Run Sequential Stimulation...] from the menu 
bar to open the ND Stimulation window. 
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Figure 10.1-13  To display the ND Stimulation window 

9. In the ND Stimulation window, set the photo activation experiment sequence. 
(For the photo activation setting window, see Section 10.2.1, "Photo Activation Experiment 
Sequence Setting.")

Figure 10.1-14  Experiment Sequence Setting

10. When the settings have been completed, click the [Apply Stimulation Settings] button to send the 
photo activation area information to the experiment sequence. 

Figure 10.1-15  Experiment Sequence Setting

11. Click the [Run now] button to execute the photo activation experiment sequence. 

Page 7 of 1610. Photo Activation Setting

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh496E.htm



Figure 10.1-16  Experiment Sequence Setting

Figure 10.1-17  Experiment sequence running

* If the photo activation position is not correct, manually correct the photo activation position.
For manual correction of the photo activation position, see Section 10.1.1"Correcting the Photo 
Activation Position Shift " 

* Only one of Galvano Scanner and DMD module can be used as stimulation device for Confocal.
Stimulation by Galvano Scanner cannot be used if you add DMD module by Manage Device.
Please change the system configuration by removing the DMD module using Manage Device when 
stimulation by Galvano scanner is required. 

10.1.1    Correcting the Photo Activation Position Shift

If the photo activation position is not correct, the photo activation position can be corrected manually.

1. Click the [Manual Shift] button on Photo Activation window to open the Manual Shift Alignment 
window. 
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Figure 10.1-18  Check of the photo activation position shift 

2. Correct the shift by specifying the shift amount (pixel) for each photo activation group while 
checking the image acquired by the first photo activation sequence. 

Figure 10.1-19  Manual Shift Alignment window 

3. After correcting the photo activation position shift, reexecute the photo activation experiment 
sequence.
Click the [Photo Activation] button to open the ND Stimulation window. 

Figure 10.1-20  Photo Activation button
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4. If the previous photo activation experiment sequence setting is to be maintained, click the [Apply 
Stimulation Settings] button to send the photo activation area information to the experiment 
sequence.

Figure 10.1-21  Experiment Sequence Setting

5. Click the [Run now] button to execute the photo activation experiment sequence. 

Figure 10.1-22  To execute the experiment sequence 

10.1.2    Setting HV Mode in Photo Activation

The HV value mode in photo activation can be set. (This mode is settable only when [DU3] is selected 
for the detection mode.) 

Page 10 of 1610. Photo Activation Setting

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh496E.htm



Figure 10.1-23  HV mode settings

Table 10.1-1   Functions of HV mode 

10.2    Setting of Each Window

This section describes setting items in each window on photo activation are explained.

10.2.1    Photo Activation Experiment Sequence Setting

Depending on the reaction speed, set the experiment sequence including photo activation and observation 
before and after photo activation is given. 

Photo activation and image acquisition are executed in time series for each phase set.

Name Function
(1) Zero HV The HV value is always 0 in the stimulation phase, but it becomes 

the user-specified HV value only in the image acquisition phase.
(2) Auto recovery The HV value becomes 0 when PMT overload due to photo 

activation occurs, but the user-specified HV value is restored at the 
end of the stimulation phase.

Page 11 of 1610. Photo Activation Setting

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh496E.htm



Figure 10.2-1  Photo activation sequence setting 

Table 10.2-1   Functions of ND Stimulation window
Name Function

(1) Phase Clicks   to set phases of the experiment sequence. 
(2) Group

Group the phases. Selects the phases to be grouped while 
pressing the [Shift] key and click the Group button [ ] for 
grouping. Set the number of repeated count in [ ] displayed in 
the Group field. 

(3) Acq/Stim Selects the items to be set from "Acquisition," "Stimulation," 
"Bleaching," and "Waiting." 

The FRAP experiment can also be executed by making the
phase settings as follows.
#1 = Acquisition / #2 = Stimulation / #3 = Acquisition 

(4) ROIs Specifies the photo activation frame to run the set phase.
Enables to select from seven choices; "S1," "S2," "S3," "S1,
S2," "S1, S3," "S2, S3," "S1, S2, S3."

e.g.) 

- Frames 1 and 3: Select "S1" and "S3."
- Frame 1 only: Select "S1."

(It is set as "S1" when a photo activation point/line is specified 
for a photo activation area.) 

(5) Interval Specifies the phase interval. 
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10.2.2    Laser Setting for Photo Activation

The stimulation laser beam to be irradiated in the experiment sequence is set. 

Figure 10.2-2  Laser Setting for Photo Activation (Specify the photo activation ROI area) 

- "No delay": No interval
- "No acquisition": No interval and image acquisition
If "Stimulation" or "Bleaching" is set in the [Acq/Stim] column, 
[Interval] is fixed to "No delay." 

(6) Duration Specifies the time (length) of the selected phase. 
If the time (length) is designated, the number of execution times 
is automatically selected.
(If [Interval] is set to "No delay" and [Loops] is changed, 
[Duration] is also changed in an interlocked manner.) 

(7) Loops Specifies the number of execution times for the selected phase. 
(If [Interval] is set to "No delay" and [Duration] is changed, 
[Loops] is also changed in an interlocked manner.)

* When the photo activation point or the photo activation line 
is designated, [Loops] cannot be set. 

(8) Move the phase one 
line 

Brings the selected phase to one line above. 

Brings the selected phase to one line below. 
(9) Remove the phase 

Removes the selected phase. 
(10) Remove all 

Removes all phases. 
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Figure 10.2-3  Laser Setting for Photo Activation (Specify the photo activation Point) 

Figure 10.2-4  Laser Setting for Photo Activation (Specify the photo activation line) 

Table 10.2-2   Functions of Photo Activation window

10.2.3    Simple ROI Editor

This section describes the functions of the Simple ROI Editor drawing tool. 

Name Function
(1) Photo activation frame tabs Selects the photo activation frame to be set. (Only 

when a photo activation ROI area is selected) 
(2) Stimulation laser selection 

check box
Selects the stimulation laser beam to be irradiated on 
the sample. 

(3) Stimulation laser power output 
adjustment

Adjusts the output power of the stimulation laser beam 
to be irradiated. 

(4) Photo activation scan speed 
setting

Sets the photo activation scan speed.
The speed is expressed in Sec/Frame when a photo 
activation ROI area is selected, or in lines/sec when a 
photo activation line is selected. 
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Figure 10.2-5  Simple ROI Editor

Table 10.2-3   Functions of the Simple ROI Editor drawing tool
Name Functions and their operations

(1) Pointing Used to move a drawn ROI on the window. 
(2) Rectangle Used to designate the ROI area enclosed by a rectangle. 
(3) Ellipse Used to designate the scan area enclosed by a circle.

Circle
Clicks the center of the desired circle to draw a precise 
circle with a radius of the dragged length. 

3pt 
Circle

Designates any three points by clicking on the image to 
draw a precise circle that passes the three points.

Npt 
Circle

Designates multiple points by clicking on the image to
automatically select several points nearest to the circle to 
draw a precise circle. 

Ellipse

Clicks the center of the desired circle to draw a precise
circle with a radius of the dragged length.
When the base point on the top, bottom, right, or left of 
the circle is picked and dragged, the circle deforms to an 
ellipse.
When the drawn circle is picked and dragged with the 
mouse, the circle moves to another position.
Right-clicking on the drawn circle designates the circle as 
the ROI scan area. 

4pt
Circle

Designates any four points by clicking on the image to 
draw a precise circle that passes the four points. 

(4) Polygon Used to designate the ROI area enclosed by straight lines. 
Designates the start point by clicking on an image and moving the 
pointer to the straight line ending position (end point) and clicking 
draws a straight line. Draw straight lines subsequently to draw a 
polygon. 
To close the selected area by connecting straight lines to each other, 
place the mouse pointer on the start point and double-click the 
mouse. 
Double-clicking the pointer at a position different from the start 
point can also close the selected area. 

(5) Bezier drawing
tool

Used for freehand drawing or for drawing a straight line or smooth 
curve by placing anchor points. 
For freehand drawing, click the mouse on the image then drag the 
mouse. 
To draw a curve using anchor points, drag the mouse in the curving 
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direction. 
To close the selected area, right-click the mouse. (Double-clicking 
the mouse left button also closes the selected area.) 

(6) Auto Detect
(Adjacent similar
colors) 

Used to automatically detect and specify the similar color portion 
adjacent to the clicked position. 
By clicking the mouse on the image, the similar color portion 
adjacent to the clicked position is selected. 
To fix the selected area, right-click the mouse.

(7) Auto Detect All
(All similar 
colors) 

Used to automatically detect and specify all the similar color portion 
to the clicked position.
By clicking the mouse on the image, all the similar color portion to
the clicked position is selected. 
To fix the selected area, right-click the mouse. 

(8)

Stim. Point
Used to designate the photo activation point.
You can specify only one photo activation point and cannot specify 
multiple photo activation target areas. 

Stim. Line Used to designate the photo activation straight line.
You can specify only one photo activation line and cannot specify 
multiple photo activation target areas.

(9) Draw Holes Used to draw a non-photo activation area in a ROI area drawn by 
using the various tools of Simple ROI Editor. 

(10) Clear Clears the ROI area. 
(11) Undo Returns to the previous operation status. 
(12) Redo Re-executes the operation returned by Undo. 
(13) Help Displays the help for Simple ROI Editor. 
(14) Finish Finishes drawing and editing of the ROI area and closes the Simple 

ROI Editor.
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 11   Using Manual Microscope
This chapter describes how to make settings for operations from NIS-Elements with the Confocal 
Microscope C2 connected to Nikon manual microscope .

When using FN1 microscope, connect the C1-Y-TT Trinocular Tube (hereinafter referred to as 
trinocular tube). Combination of the trinocular tube and the "vertical movement device (Nikon "RFA" or 
Prior external Z Drive "Prior Z RFA")" enables NIS-Elements to control the manually-operated 
ECLIPSE FN1. 

11.1    Setting Manual Microscope Connection

Make settings using the following procedure to synchronize NIS-Elements with the manual microscope. 

 1      Call the Manage devices window

Select [Devices] on the menu bar and then select [Manage devices...].
The Manage devices window appears. 

Figure 11.1-1  Devices menu
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Figure 11.1-2  Manage devices window

 2      Add "Manual Microscope"

1. Click the [Add] button in the Manage devices window to display the menu for devices to be 
added.

Figure 11.1-3  Manage devices window

2. Select the "Manual Microscope" form pull-down menu.
"Manual Microscope" is added in the [Installed devices:] area.
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Figure 11.1-4  Manage devices window

Figure 11.1-5  Manage devices window

 3      Add the vertical movement device (Nikon "RFA" or Prior external Z Drive "Prior Z RFA")

1. Click the [Add] button to display the menu for devices to be added.
Select the "Nikon RFA" or Prior external Z Drive "Prior Z RFA" form pull-down menu. (*) 
The Connection Parameters window appears. 
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Figure 11.1-6  Manage devices window

(*) Compatible Microscopes: 
Nikon RFA : ECLIPSE AZ100, ECLIPSE 80i, ECLIPSE FN1
Prior Z RFA : ECLIPSE Ti-U, ECLIPSE FN1

2. Set the Serial port in the Connection Parameters window.
Select the serial port to which "Nikon RFA" or Prior external Z Drive "Prior Z RFA" is connected 
from the pull-down menu of [Serial port:].
Click the [OK] button to finish the Serial port setting. 

Figure 11.1-7  Connection Parameters window

3. If you use "Nikon RFA" as the vertical movement device, set the model number.
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Select "RFA" in the [Installed devices:] area and click the [Configure Devicec] button.
The Model setting window appears. 

Figure 11.1-8  Manage devices window

4. Set the model number in the Model setting window.
Select "99888" (*) from the pull-down menu of [Model:].
Click the [OK] button to finish the Model number setting. 

Figure 11.1-9  Model setting window

(*) The model number differs depending on the microscope.
ECLIPSE AZ100, ECLIPSE 80i, ECLIPSE FN1 : 99888
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5. Click the [Close] button to close the Manage devices window. 

Figure 11.1-10  Manage devices window

 4      Setting the [Manual Microscope Pad]

1. Display the [Manual Microscope Pad].
As shown below, right-click on the gray area (without any setting window displayed) to display a 
menu. Then select [Acquisition Controls] -> [Manual Microscope Pad] in the menu. 

Figure 11.1-11  To display the Manual Microscope Pad

* Other display methods
And also, select [View] on the menu bar and then select [Acquisition Controls] -> [Manual 
Microscope Pad] to open the control pad. 

Page 6 of 1211. Using Manual Microscope

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh9413.htm



Figure 11.1-12  To display the Manual Microscope Pad

2. Set the Nosepiece information in the [Manual Microscope Pad].

Click the  button in the [Nosepiece] area.
The Nosepiece & Objectives window appears. 

Figure 11.1-13  Manual Microscope Pad
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Figure 11.1-14  Nosepiece & Objectives window

* When using manual microscope, information on the installed objectives cannot be read 
automatically by NIS-Elements. When using a manual microscope, be sure to select the 
objective to be used in the Nosepiece & Objectives window.

3. Specify the Objective in the Nosepiece & Objectives window.
Select the Objective name to be used from the pull-down menu of [Objective name]. 

Figure 11.1-15  Nosepiece & Objectives window
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Figure 11.1-16  Selecting Objectives

4. Click the [OK] button to close the Nosepiece & Objectives window. 

Figure 11.1-17  Nosepiece & Objectives window

The connection setting procedure has been completed. 

11.2    Manual Microscope Pad

The Microscope Control Pad for manual microscope consists of the following portions: 
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Figure 11.2-1  Manual Microscope Pad Settings

Nosepiece

Select the objective located in the light path.

11.3    Operating the Z Drive 

This section describes how to operate the Z drive of the manual microscope by NIS-Elements. 

1. Display the XYZ Navigation window.
As shown below, right-click on the gray area (without any setting window displayed) to display a 
menu. Then select [Acquisition Controls] -> [XYZ Navigation] in the menu. 

Figure 11.3-1  To display the XYZ Navigation window 

* Other display methods
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And also, select [View] on the menu bar and then select [Acquisition Controls] -> [XYZ 
Navigation] to open the window. 

Figure 11.3-2  To display the XYZ Navigation window

2. Control the Z drive position.
Click the upper and lower blue arrow buttons to move the Z drive.
Each clicking of the button can move the Z drive up and down by one step (predetermined length). 

Figure 11.3-3  XYZ Navigation window

* The travel distance can be set with three precision levels (0.1 µm, 1 µm, 10 µm) and the user-
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defined step value. 

* The Z drive can also be moved directly to any position by entering its coordinate in the [Z-
Nikon RFA ZDrive] edit box. 
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 12   Using C2+TIRF System
By combining the observations of single molecules with laser TIRF and the sectioning capabilities of the 
C2, C2+TIRF System allows for multi-perspective cellular analysis. 

Use the "digital imaging head for C2 for Nikon microscopes" attached to the left-side port of Nikon 
microscope [ECLIPSE Ti] and CCD camera attached to the back port, by switching between them. 

With the C2, Z stack images (more than one) are acquired, and with the CCD camera for TIRF position 
(one image) is acquired. 

12.1    Starting the C2+TIRF System

To use C2+TIRF System, you may select it at activation of NIS-Elements C or after the activation.

  Steps to enable C2+TIRF System at activation of NIS-Elements C  

1. On the Driver selection window displayed at activation of NIS-Elements C, turn "ON" the [Enable 
Multi Camera] check box.
On the Driver selection window, you may select the second camera. 

Figure 12.1-1  Driver selection window

Figure 12.1-2  Driver selection window

2. From the pull-down menu of the Second driver:, select the secondary camera.
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For the CCD camera, only [ANDOR] is selectable. 

Figure 12.1-3  Selecting the second camera

3. Click the [OK] button to starts the NIS-Elements C.
After NIS-Elements C activates, the menu bar shows two camera operation icons. 

Figure 12.1-4  Starting the NIS-Elements C

Figure 12.1-5  Menu bar for C2+TIRF System

  Enabling C2+TIRF System after Activation of NIS-Elements C  

1. Select [Acquire] on the menu bar and then select [Select Driver...].
The Driver selection window appears. 
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Figure 12.1-6  To display the Driver selection window

Figure 12.1-7  Driver selection window

2. Turn "ON" the [Enable Multi Camera] check box.
On the Driver selection window, you may select the second camera. 

Figure 12.1-8  Driver selection window
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Figure 12.1-9  Driver selection window

3. From the menu of the Second driver:, select the secondary camera.
For the CCD camera, only [ANDOR] is selectable.

Figure 12.1-10  Selecting the second camera

4. Click the [OK] button to confirm it.
The menu bar shows two camera operation icons. 

Figure 12.1-11  Switching to C2+TIRF System
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Figure 12.1-12  Menu bar for C2+TIRF System

12.2    Setting ECLIPSE Ti and Laser Connection

Make settings using the following procedure to synchronize NIS-Elements with the ECLIPSE Ti and 
LU4A (Laser).

 1      Call the Manage devices window

Select [Devices] on the menu bar and then select [Manage devices...].
The Manage devices window appears. 

Figure 12.2-1  Devices menu
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Figure 12.2-2  Manage devices window

 2      Add "Nikon Ti"

Click the [Add] button to display the menu for devices to be added.
Select the "Nikon Ti" form pull-down menu.
"Nikon Ti" is added in the [Installed devices:] area. 
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Figure 12.2-3  Manage devices window

Figure 12.2-4  Manage devices window
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 3      Add "Nikon LU4A"

Click the [Add] button to display the menu for devices to be added.
Select the "Nikon LU4A" form pull-down menu. 
"Nikon LU4A" is added in the [Installed devices:] area.

Figure 12.2-5  Manage devices window
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Figure 12.2-6  Manage devices window

 4      Setting the Lasers (Nikon LU4A)

1. Call the LU4A Pad window.
As shown below, right-click on the gray area (without any setting window displayed) to display a 
menu. Then select [Acquisition Controls] -> [LU4A Pad] in the menu to open the LU4A Pad 
window. 

Figure 12.2-7  To display the LU4A Pad window

Page 9 of 2412. Using C2+TIRF System

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhE725.htm



2. Open the LU4A Configuration window.
Click the [Configure...] button in the LU4A Pad window.
The LU4A Configuration window appears. 

Figure 12.2-8  LU4A Pad window

3. Select the laser to be used.
Select the laser to be used from the pull-down menu of each laser.
After selecting the laser, click the [OK] button to confirm the settings. 
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Figure 12.2-9  LU4A Configuration window

12.3    Optical Configuration Setting

Register the settings for the confocal image acquisition with C2 and the TIRF image acquisition with 
CCD camera to the Optical Configuration files. 

This section describes the setting of laser optical path switching (set on the LU4A Pad window) and 
setting of device selection (set on [Ti Pad]) for image acquisition that are to be configured only for 
C2+TIRF system. 

12.3.1    Optical Configuration Setting for C2

 1      Switch the laser optical path on the LU4A Pad window

1. Call the LU4A Pad window.
As shown below, right-click on the gray area (without any setting window displayed) to display a 
menu. 
Then select [Acquisition Controls] -> [LU4A Pad] in the menu to open the LU4A Pad window. 
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Figure 12.3-1  To display the LU4A Pad window

2. With Beam Switcher in the LU4A Pad window, select the laser optical path.
For the optical configuration of the C2, select [Confocal]. 

Figure 12.3-2  LU4A Pad window

 2      Select the device to be used for image acquisition with [Ti Pad]

1. Call the [Ti Pad].
As shown below, right-click on the gray area (without any setting window displayed) to display a 
menu. 
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Then select [Acquisition Controls] -> [Ti Pad] in the menu to open the [Ti Pad].

Figure 12.3-3  To display the Ti Pad

2. Select the device for [Ti Pad].
For the optical configuration of the C2, select [EPI]. 
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Figure 12.3-4  Ti Pad

3. Configure laser power and other settings on [C2plus Settings], and register the configuration to 
the Optical Configuration file.
For storing and retrieving the [Optical Configuration] settings, see the sections concerning the 
optical configuration in the "NIS-Elements AR (Advanced Research) User's Guide." 

12.3.2    Optical Configuration Setting for CCD Camera

 1      Switch the laser optical path on the LU4A Pad window

1. Call the LU4A Pad window. 

2. With Beam Switcher on the LU4A Pad window, select the laser optical path.
For the optical configuration of the CCD, select [TIRF]. 
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Figure 12.3-5  LU4A Pad window

3. Select the lasers for CCD camera image acquisition and make power adjustments. 

Figure 12.3-6  LU4A Pad window

 2      Select the device for image acquisition on [Ti Pad]

1. Call the [Ti Pad].

2. Select the device for [Ti Pad].
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For the optical configuration of the CCD, select [TIRF]. 

Figure 12.3-7  Ti Pad

3. Register the Optical Configuration file for the CCD camera.
For storing and retrieving the [Optical Configuration] settings, see the sections concerning the 
optical configuration in the "NIS-Elements AR (Advanced Research) User's Guide." 

12.4    Procedure of Image Acquisition 

Acquire the images by using the registered Optical Configuration files. 

 1      Call the ND Acquisition window 

Select [Applications] -> [Define/Run ND Acquisition...] from the menu bar to open the ND Acquisition 
window. 
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Figure 12.4-1  ND Acquisition window

 2      Set the Z stack for image acquisition with C2 

1. Turn "ON" the [Z Series] tab check box. 

Figure 12.4-2  ND Acquisition window

2. Set the Z stack for image acquisition with C2.
For Z stacks settings, refer to "NIS-Elements AR (Advanced Research) User's Guide." 

Page 17 of 2412. Using C2+TIRF System

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhE725.htm



Figure 12.4-3  Z stacks settings

 3      Set the TIRF position for image acquisition with CCD camera

1. Turn "ON" the [TIRF] check box. 

Figure 12.4-4  Select the TIRF

2. Set the TIRF position for image acquisition with CCD camera.
Adjust the Z stage to the TIRF position.
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You may adjust the Z stage to the TIRF position with either of the following methods: 
(1) Manually handle the Z stage.
(2) Into [ZDrive] for Ti Pad, input the TIRF position to operate the Z stage. 

After adjusting the Z stage to the TIRF position, click [Set TIRF Posc].
The Z stage is set to the TIRF position. 

Figure 12.4-5  Define TIRF Position

 4      Register the devices for image acquisition

1. Turn "ON" the [Lambda] tab check box. 
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Figure 12.4-6  Select the Lambda tab

2. Register the C2 and CCD camera.
Click below the [Camera] column, and then register the first device.
Click on the second line, and then register the second device. 

Figure 12.4-7  Registration of device

 5      Select the Optical Configuration file

Select the Optical Configuration files for the C2 and CCD camera from the pull-down menu for Optical 
Conf. 
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Figure 12.4-8  Select the Optical Configuration file for C2

Figure 12.4-9  Select the Optical Configuration file for CCD camera

 6      Setting the Z phase for TIRF

Select the [TIRF] from the pull-down menu of [Z Pos.] for CCD camera.
The C2 acquires images of all positions configured with Z stacks, thus the setting remains as [All]
without change. 
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Figure 12.4-10  Z phase settings

 7      Start the image acquisition

Click the [Run now] button to start the image acquisition.
After image acquisition, two image windows for C2 confocal image and CCD camera TIRF image are 
displayed.

Figure 12.4-11  Run now

12.5    Merge the Confocal Image and TIRF Image 
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When the C2+TIRF System is in use, a confocal image acquired with C2 and a TIRF image acquired 
with CCD camera can be merged and acquired as one image. 

  Merge Camera  

Turn "ON" the [Merge Camera] check box of the Advanced menu on the Lambda tab and click the [Run 
now] button to execute the image acquisition to get merged images. 

Note that images are simply merged without any regard for the difference in the sizes of the C2 confocal 
image and the CCD camera TIRF image even if they are not in the same size, thus it is recommended to 
adjust the image sizes in advance. 

  Merge Camera + Stretch Camera Image to Same Size  

To coordinate the confocal image and TIRF image sizes, turn "ON" both the [Merge Camera] check box 
and [Stretch Camera Image to Same Size] check box and then perform image acquisition.

This makes the smaller one expanded to the larger image size and a merged image is acquired with the 
same size.

However, even in that case, note that the image is simply expanded for size coordination regardless of 
what is represented in the image, thus it is recommended to adjust the image sizes in advance. 
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Figure 12.5-1  ND Acquisition window
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 13   C2plus Compact GUI
NIS-Elements allows you to use the C2plus Compact GUI window, which is a simplified configuration 
screen supporting functions equivalent to those of "C2plus Settings," so that you can sufficiently use the
window spaces.
This chapter describes how to show the screen and the functions available on it. 

13.1    Displaying the C2plus Compact GUI

As shown below, right-click on the gray area (without any setting window displayed) to display a menu. 
Then select [Acquisition Controls] -> [C2plus Compact GUI] in the menu to open the C2plus Compact 
GUI window.
(If you are using a Galvano scanner that does not support the Fast Galvano, select [Acquisition Controls]
-> [C2 Compact GUI] from the menu.) 

Figure 13.1-1  To display the C2plus Compact GUI
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Figure 13.1-2  C2plus Compact GUI (DU3-use)

13.2    Functions of the C2plus Compact GUI

The C2plus Compact GUI window allows you to configure settings for use of the Confocal Microscope 
C2 in the same manner as you configure with [C2plus Settings]. 
The following shows an example of the screen where DU3 is selected for Detector mode. 
For details of each item by detector, see the appropriate chapter. 
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Figure 13.2-1  C2plus Compact GUI (DU3-use)

Table 13.2-1   Functions of the C2plus Compact GUI
Name Function

(1) Scan button Starts/stops live image acquisition. 
(2) Capture button Captures the image. 
(3) Find button Starts/stops live image acquisition in Find mode.

Find mode is the mode where the live image acquisition is 
executed by temporarily switching to the high-frame-rate 
setting in order to ease the detection of the observation object 
such as a cell.
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For details, see Section 4.1.2, "Find Mode." 
(4) Eye Port button Changes optical path to eye port. 

Each function on the C2plus Settings window becomes non-
selectable when the Eye Port button is selected. 

(5) Auto Gain DU3-use
Automatically adjusts the HV value (HV gain) of the 
currently selected channel to the optimum values.

* For details, see the following.

DU3:
Section 5.2.5, "Auto Gain."

SD or VF-use
Automatically adjusts the Si HV value (Si HV gain) to the 
optimum values. 

* For details, see the following.

SD:
Section 6.2.4, "Auto Gain." 

VF:
Section 7.2.4, "Auto Gain."

(6) Laser power monitor 
button

Displays the laser power value (integer obtained after A/D 
conversion divided by 10) of the current channel by clicking 
this button. 

* When a laser unit of the LU-N series is in use, the value 
displayed in the monitor does not increase over a certain 
value with the increase in the laser power value, but this 
is not a problem. 

(7) Scan Direction Toggles between Unidirectional and Bidirectional scan. 
Bidirectional scan is only selectable if the Square scan area, 
Band scan area, or Line scan area is set. 
By default, Unidirectional scan is selected. 
The  button is enabled only when the Bidirectional scan is 
selected. Clicking this button displays the Align bidirectional 
scanner window allowing correction of image shifting. 

* For details, see the following.
Section 8.3, "Scan Settings." 

(8) Control by: Switches the Scan Speed selection form. 
(9) Fast Mode Turning on this button makes the scan speed high.

When a Fast Galvano compatible model (C2plus) that 
supports high scan speed is in use, the scan speed is further 
increased by turning on the [Fast] button and set the scan 
magnification to 8X or higher. 
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* For speeding-up of the scan speed, see Section 8.3.1, 
"Fast Mode."

(10) Scan Speed Selects scan speed. (Setting unit: Frame/sec or lines/sec in
line scan mode) 

* When the Band scan area is selected, scan speed values 
shown in each Scan Speed button are guideline, which 
may not be the actual scan speed.

(11) Scan Size Selects the scan resolution in the X-direction. (Setting unit:
Pixel) 
The resolution in the Y-direction is automatically calculated
from the X to Y ratio of the scan area. 

(12) Scan Area window 
button

Displays the Scan Area window.
For details of Scan Area window, see Chapter 9. 

(13) Ch Series button Settable only in DU3-use.
When the [Ch Series] button is turned on, channel series is 
set allowing the user to set a desired order of channels to be
scanned.
Click  to the next of the [Ch Series] button and select 
[Flexible setupc] to open the Line Channel Series Setup 
window. Set the scan order on this window.

Channel series can also be applied to the image acquisition
phase in the photo activation experiment sequence (but 
cannot be applied to the stimulation phase). 

* For details, see the following. 
Section 5.1.4, "Selecting the Channel Series."

(14) Ch.Setup check box Displayed when the [Ch Series] button is ON.
When checked, the setting by the channel is facilitated.
Automatically enters the state where only one channel is 
selectable.

(15) Channel Series scan
order

Displays the channel scan order when Channel Series is set. 

(16) Fps: Indicates the current scan settings. 
(17) Settings button Displays the menu for various settings such as HV Linear

Correction. 

* Select [Show AUX Detector] from the menu that appears 
when the [Settings] button is clicked to make an external 
detector available. While an external detector is in use, 
the [AUX] icon is displayed on the Compact GUI 
window. For details, see Chapter 16. 

(18) Pinhole Adjusts the pinhole size. 
Sets a pinhole size in Airy units (units of airy disk size).

Slider bar:
Slides to the right or left to set the pinhole size. (Unit:
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A.U.) 

Direct entry in pinhole size display field:
Type the desired setting value. 

* For details, see the following. 

DU3:
Section 5.2.3, "Setting the Pinhole." 

SD:
Section 6.2.3, "Setting the Pinhole." 

VF:
Section 7.2.3, "Setting the Pinhole." 

(19) AU button Changes the pinhole to the predetermined home position.
The value of the home position can be changed in the A.U. 
Calculation Settings window.

* For details, see the following. 

DU3:
Section 5.2.3.1, "Calculation Settings for Pinhole Size." 

SD:
Section 6.2.3.1, "Calculation Settings for Pinhole Size." 

VF:
Section 7.2.3.1, "Calculation Settings for Pinhole Size." 

The A.U. Calculation Settings window is displayed by 
selecting [AU settingsc] from the setting menu displayed by 
the [Settings] button. 

(20) Reference excitation 
wavelength for the 
pinhole size calculation

Selects the excitation wavelength as the reference of the 
automatic calculation of the pinhole size from the laser 
wavelengths, or enter it manually in the A.U. Calculation 
Settings window.

* For details, see the following. 

DU3:
Section 5.2.3.1, "Calculation Settings for Pinhole Size." 

SD:
Section 6.2.3.1, "Calculation Settings for Pinhole Size." 

VF:
Section 7.2.3.1, "Calculation Settings for Pinhole Size." 

(21) Optical path Setting Opens the Optical path window.
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button To use, select the detector and the dichroic mirror, the 
channels as well as the fluorescence dye, laser, and for each 
channel. 

(22) Detection mode 
indicator/selection button

Selects/displays the Detection mode for use.
When the optical path changeover lever on the C2 scan head 
is set to the [Spectrum] position, [SD] or [VF] can be 
selected as the detector mode.
When the optical path changeover lever on the C2 scan head 
is set to the [Standard] position, the detector mode is fixed to 
[DU3].

* For details of each item for each Detection mode, see the 
following. 

Chapter 5, "Detection Mode DU3."

Chapter 6, "Detection Mode SD." 

Chapter 7, "Detection Mode VF." 
(23) Brightness adjustment 

for each channel
For each of the channels (Ch1 to Ch3), use the HV, Offset, 
Laser, and ND filter IN/OUT controls to adjust the brightness
of the live image. 
Note that these items vary depending on the selected 
detector. 

* For details, see the following.

DU3:
Section 5.2.1, "Structure of Acquisition Window."

SD:
Section 6.2.1, "Structure of Acquisition Window."

VF:
Section 7.2.1, "Structure of Acquisition Window." 

(24) Brightness adjustment 
for transmitted detector

For the transmitted detector, use the HV and Offset controls 
to adjust the brightness of the live image.

* When acquiring the transmitted image (TD image) only, 
see the following.

DU3:
Section 5.2.1.2, "When Acquiring Transmitted Image 
Only."
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13.3   Photo Activation Setting Using the C2plus Compact GUI

This section describes how to set the photo activation in the C2plus Compact GUI window.
For procedures common to the C2plus Settings window, see Chapter 10, "Photo Activation Setting."

 1      Acquire the image of sample for photo activation.

Figure 13.3-1  Frozen image

 2      Adjust the brightness of the live image.

VF:
Section 7.2.1.2, "When Acquiring Transmitted Image 
Only."
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Figure 13.3-2  The C2plus Compact GUI window

 3      Specify a photo activation area, point, or line.

Figure 13.3-3  Setting of photo activation area

 4      Set the stimulation laser.

1. To manually display the C2plus Stimulation window, right-click on the gray area (without any 
setting window displayed) to display a menu as shown below. Then select [Acquisition Controls] -
> [C2plus Stimulation] in the menu. 
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Figure 13.3-4  To display the C2plus Stimulation window

2. Determine whether to set the stimulation laser for each stimulation area (photo activation frame) 
or apply the same setting to all frames.
Select the [Synchronize Lasers] check box to apply a single setting to all frames. 

Figure 13.3-5  C2plus Stimulation window

3. Select the laser for photo activation and set the laser power. 

Figure 13.3-6  Laser setting for photo activation
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4. Set the scan speed for photo activation.

Figure 13.3-7  Scan speed

5. Select the HV mode in photo activation. 
* The HV mode can be set only when [DU3] is selected for the detection mode.

For details of settings, see Section 10.1.2, "Setting HV Mode in Photo Activation." 

Figure 13.3-8  HV mode

 5      Open the ND Stimulation window.

Select [Applications] -> [Define/Run Sequential Stimulation] from the menu bar to open the ND 
Stimulation window. 

Figure 13.3-9  To display the ND Stimulation window
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 6      Set the photo activation experiment sequence.

For the photo activation setting window, see Section 10.2.1, "Experiment Sequence Setting for Photo 
Activation Observation." 

Page 12 of 1213. C2plus Compact GUI

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh3D34.htm



 14   External Trigger Output
This chapter describes the external trigger output function of NIS-Elements. 

This function allows trigger signals of (e.g., Acquisition or Photo Activation experiments) to be sent to 
an external device connected with the C2 controller. 

* For trigger input to receive trigger signals from an external device, see Chapter 15. 

14.1    Trigger Signal Output

Trigger signals are output frame by frame when an image is acquired. 

One external trigger signal channel is available.
Note that the external trigger settings are unchangeable during Live or experiment. 

14.1.1    Procedure for External Trigger Output Settings

 1     Call the External Trigger Output Settings window

1. [Trigger] check box to turn it "ON."
The external trigger output function is turned on, and [Trigger] button becomes effective.
If trigger signals output is not to be executed, uncheck the [Trigger] check box.

2. Click the [Trigger] button to open the External Trigger Output Settings window. 

Figure 14.1-1  Trigger check box

 2     Set the Polarity for the output trigger signal channels

1. Check the trigger signal output setting. 
[Acquisition] and [Photo Activation] are displayed only when the trigger signal output is ON.
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2. Specify the level to output as the trigger signal.

 Sets the rising edge of the TTL level signal as the trigger signal.

 Sets the falling edge of the TTL level signal as the trigger signal.

3. Click the [OK] button to finish the trigger signals polarity settings. 

Figure 14.1-2  External Trigger Output Settings

Allocation of trigger signal polarity is memorized for each user and applied when the external trigger 
settings window opens next.

14.1.2    External Trigger Output Operation List

The external trigger output operations are listed below.

Table 14.1-1   External trigger output operation list
Type Operation
XYT

XYZT 
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ROI photo 
activation
(for the 
case of 
ROI1: 
Group 1, 
and ROI2, 
ROI3: 
Group 2) 
Line/Point 
photo 
activation

Photo 
activation 

Page 3 of 314. External Trigger Output

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hh922A.htm



 15   Using Data Acquisition Device (NIDAQ)
This chapter describes operations of the NIS-Elements when the Data Acquisition Device (hereafter
NIDAQ) of National Instruments is connected to the PCI Express slot in PC for Confocal Microscope 
C2. (The NIDAQ is connected to the PCI slot in PC for Confocal Microscope C2, but this slot is 
provided for use in the system and is not available for external triggers.) 

Use of the NIDAQ connected to the PCI Express slot allows the user to start and stop an experiment 
(including image acquisition) by using trigger signals from external devices connected to the C2 
controller. 

15.1   NIDAQ Connection Settings

Make settings using the following procedure to synchronize the NIS-Elements with NIDAQ. 

 1      Call the Manage devices window.

Select [Devices] -> [Manage devices...] from the menu bar.
The Manage devices window appears. 

Figure 15.1-1  Devices menu
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Figure 15.1-2  Manage devices window

 2      Add NIDAQ.

Click the [Add] button to display the menu for devices to be added.
Selecting NIDAQ from the menu adds "NIDAQ" to the [Installed devices:] area and opens the 
NIDAQ Configuration window. 
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Figure 15.1-3  Manage devices window

 3      Perform advanced settings for trigger signals.

1. Select the trigger signal method to be added from the [Available devices] area and click the [Add -
->] button. 

Select [TTL Input] to use NIDAQ for inputting trigger signals from external devices.

Select [RealTime TTL Input] to use NIDAQ for acquiring timestamp information. (For settings 
for acquiring timestamp information, see Section 15.2, "Trigger Signal Input Using NIDAQ.") 

The selected trigger signal method is added to the [Installed devices:] area and the Configuration 
window for the trigger signal appears. 
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Figure 15.1-4  NIDAQ Configuration window

* Since the NIDAQ connected to the PCI slot is used in the C2 system, "Occupied" appears on 
the window and the 1st NIDAQ is not be selectable for trigger signal input. 

2. Set details of the trigger signal in the Configuration window and click the [OK] button to confirm 
the settings. 

Figure 15.1-5  Trigger Signal Configuration window

3. Repeat steps 1 to 2 for each trigger signal method to be added. 

* To register individual trigger signal lines to be used for each action, repeat steps 1 to 2 and
select the line to be used from the [Line:] menu. 
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Figure 15.1-6  Trigger Signal Configuration window

4. Click the [Close] button to confirm the settings. 

Figure 15.1-7  Confirming advanced settings for trigger signals

* On completion of the NIDAQ connection settings with [TTL Input] registered, the [I/O] tab is 
added to the ND Acquisition window. 
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Figure 15.1-8  ND Acquisition window

15.2   Trigger Signal Input Using NIDAQ

Use of the NIDAQ connected to the PCI Express slot allows the user to start and stop image acquisition 
and so on by inputting trigger signals from external devices. 

When NIDAQ is installed in the PCI Express slot, trigger signal output can be set using this NIDAQ but 
the trigger signal output is delayed from the actual timing in some cases. For trigger signal output, 
follow the descriptions in Chapter 14.

15.2.1    Procedure for Setting External Trigger Input for Image Acquisition

This section describes how to input trigger signals during an image acquisition experiment. 

The following describes the procedure for setting external trigger input using an example of acquiring an 
image on the ND Acquisition window.

 1      Call the ND Acquisition window and select the [I/O] tab.

1. Select [Applications] -> [Define/Run ND Acquisition...] from the menu bar to open the ND 
Acquisition window.

2. Select the [I/O] tab from switching tabs of the ND Acquisition window, and then check the check 
box. 
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Figure 15.2-1  ND Acquisition window

 2      Set the trigger signal input timing in the trigger input setting field.

1. Click the [Device Type] first line. (If several signal methods are registered, select the method of 
the trigger signal to be input in [Device Type].) 

Figure 15.2-2  ND Acquisition window

2. Click the [Name] first line and select the line of the trigger signal to be input. 
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Figure 15.2-3  ND Acquisition window

3. Click the [Conditions] first line and select the polarity of the trigger signal to be input.

Figure 15.2-4  ND Acquisition window

4. Click the [Action] first line and select the timing of the trigger signal to be input. 

Rising:  Sets the rising edge of the TTL level signal as the trigger signal. 
Falling:  Sets the falling edge of the TTL level signal as the trigger signal 
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Figure 15.2-5  ND Acquisition window

5. Click the [Action] second and subsequent lines to register two or more trigger actions, and then 
repeat steps 1 to 2 for each action. 

Figure 15.2-6  ND Acquisition window

6. Proceed to image acquisition settings and other necessary settings, and then click the [Run now] 
button.

Clicking the [Run now] button opens the ND Progress window and executes experiment sequence. 
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Figure 15.2-7  ND Acquisition window

* When the [Run now] button is clicked with [Start Experiment] set for [Action], the ND 
Progress window opens but the experiment sequence stops temporarily in the following state.
If a trigger signal is input from an external device in this state, the experiment sequence 
restarts. 

Figure 15.2-8  ND Progress window
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 16   Using External Detector Unit
This chapter describes how to set an external detector unit connected with the Si port of the Confocal 
Microscope C2 by using NIS-Elements. 

* External detector units are usable only when a C2 system without a spectral detector is in use.
When C2si (system with a spectral detector) is in use, no external detector is usable. 

16.1   Procedure for Settings on the C2plus Settings Window

 1      Acquire the Square scan area image.

 2      Switch the mode to the external detector usage mode.

1. Switch the optical path changeover lever on the C2 scan head to the [Spectrum] position. 

Figure 16.1-1  Optical path changeover lever for C2 scan head

2. On the Acquisition window, the [External Port] check box is turned ON and the system is switched 
to the external detector usage mode. 
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Figure 16.1-2  External detector usage mode

* Do not perform the photo activation experiment in the external detector usage mode. 

 3      Set the scan settings.

1. Display the C2plus Aux Control window.
As shown below, right-click on the gray area (without any setting window displayed) to display a 
menu. Then select [Acquisition Controls] -> [C2plus Aux Control] in the menu to open the C2plus 
Aux Control window.

Figure 16.1-3  To display the C2plus Aux Control window

2. Select the scanning method.
[Points]:

Multipoint scan can be set.
Set the capturing time per point in the [Capture] field.
(Go to step  4 .)
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[Normal]:
A scan area (such as square) can be set.
Set the capturing time per scan area or the number of frames in the [Capture] field.
(Go to step  5 .) 

Figure 16.1-4  C2plus Aux Control window

 4      Set points.

1. Open the Scan Area window or Live window and then select a point setting method from the Point
(s) Scan Area tool.

Figure 16.1-5  Point setting method

Select a point setting method as shown below and points are drawn. 
Free

Draws one point in the FOV.
Dragging the drawn point moves the point.
Double-click the mouse in the FOV to add points. 

2x2:
Draws 2x2 grid points in the FOV.

4x4:
Draws 4x4 grid points in the FOV.

8x8:
Draws 8x8 grid points in the FOV.

16x16:
Draws 16x16 grid points in the FOV.

MxN:
Specifying the number of vertical and horizontal points on the AUX Point Grid Setup 
window that appears when this item is selected draws grid points in the FOV. 
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Figure 16.1-6  Point drawing

* When the mouse pointer is set at the lower-right corner point of drawn grid points, the  pointer 
appears to expand or reduce the entire grid area.
Furthermore, dragging a point (except for the lower-right corner point) on the entire grid moves the 
entire grid. 

* Even if multiple points are set as grid points, a point to be scanned during the live imaging is only the 
active point displayed in .

* To make a grid point to an active one, select [Set As Active] from the menu that is displayed by right-
clicking on the grid point. To delete a grid point, select [Delete Point]. 

* This grid point setting can be registered in the optical configuration.

Figure 16.1-7  Scan Area window

Go to step  6 .
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 5      Set the scan area.

Open the Scan Area window and draw the scan area.

Figure 16.1-8  Scan area settings

 6      Adjust the laser.

Adjust the laser power on the Acquisition window.

Figure 16.1-9  Acquisition window
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* While an external laser is connected, the laser power cannot be adjusted on the Acquisition window. 

 7      Acquire an image on the ND Acquisition window.

Make settings on the ND Acquisition window and perform an experiment. 

* When an experiment is performed by using ND Acquisition, a black image is acquired on the NIS-
Elements side because signals have been sent to the external detector. 

* When [Interval] and [Duration] are set on the ND Acquisition window for point scan, actual 
operation is performed with "capturing time set by AUX Control" x "specified number of points" x 
"number of Loop." 

l When using external detector in Compact GUI
Select [Show AUX Detector] from the menu that appears when the [Settings] button 
is clicked to make an external detector available.
While an external detector is in use, the [AUX] icon is displayed on the Compact 
GUI window. 

Figure 16.1-10  Compact GUI
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 17   NIS-Elements C-ER Package
The following functions are available only for people who purchased the "NIS-Elements C-ER" 
package.
For other functions, see the "NIS-Elements C Instructions" and the "NIS-Elements AR (Advanced 
Research) User's Guide." 

17.1   Automatic Deconvolution

When Automatic Deconvolution is executed for Capture image, Live image, or an acquired image (in 
ND2, Tiff, JP2, or Lim format), the software automatically determines the best processing method to 
acquire an image of an enhanced resolution. 

17.1.1   Procedure of Deconvolution

 1      Acquire the sample image for perform automatic deconvolution.

Figure 17.1-1  Image Acquisition
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 2      Perform the automatic deconvolution processing.

Set the pre-scan mode if you want to increase the point scan accuracy in the external detector unit. 

1. Click the  [Automatic Deconvolution] button.
Starts automatic deconvolution processing. 

Figure 17.1-2  Automatic Deconvolution

* Selecting [Show deconvolution GUI] that appears by clicking  [Show deconvolution GUI] 
button makes it possible to display the Automatic Deconvolution window when  is clicked.. 

 When the Automatic Deconvolution window is displayed 

The Automatic Deconvolution window is used to confirm and set parameters necessary to execute 
deconvolution.
This window shows different items for 2D and 3D images.

[Basic Settings] field:
(for 2D and 3D images)
This field shows parameters for acquiring the original image.
If you want to change them, select or enter values for each item.

[Channels] field:
(for 2D and 3D images)
This field shows channels for which deconvolution is to be executed.
(Channel names at the time when the original image was acquired are shown.)
Deconvolution is disabled for channels whose checkbox is cleared.

[Use Spherical Aberration Correction] checkbox:
(only for 3D images)
Selecting this checkbox enables processing considering spherical aberration at the time of 
deconvolution. 

[Acquisition Depth] field:
(only for 3D images)
Enter the distance from the cover glass to the sample. (The default value is shown 
originally.)

[Default] button: 
(only for 3D images)
Used to show the value of the default position (Z stack center). 

[Sample Refractive Index] field:
(only for 3D images)
Select or enter a refractive index of the sample. (The default value is shown originally.)

[Create new document] checkbox:
(for 2D and 3D images)
Selecting this checkbox creates a new file for deconvolution from the original image. 

[Convert document to floating point data format] checkbox:
(for 2D and 3D images, available only for 16-bit)
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Selecting this checkbox enables Float conversion at the time of deconvolution. 
[Do not show this dialog for images with valid metadata] checkbox:

(for 2D and 3D images)
Selecting this checkbox does not show the Automatic Deconvolution window even when 
is clicked. 

[OK] button:
(for 2D and 3D images)
Used to start deconvolution processing. 

[Close] button:
(for 2D and 3D images)
Used to close this window without performing deconvolution processing. 

Figure 17.1-3  Automatic Deconvolution Window

17.1.2   Post-Deconvolution Processing

 Undoing/Redoing image processing 

If an image has not been saved, it can be returned to the pre-image processing state with the  (Undo) 
button or to the post-image processing state with the  (Redo) button.
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Figure 17.1-4  Undo/Redo

 Displaying parameter values 

Parameter values used for deconvolution are shown on the image window after processing.
Right-clicking on these parameters or image window displays [Show Deconvolution Info]. Clearing this 
checkbox hides the parameters. 

Figure 17.1-5  Show Deconvolution Info

 Storing processed images 

When a processed image is saved using the  button, the image file is overwritten in the post-image 
processing state. When storing an image file with another name, select [File] > [Save As] from the menu 
bar. 
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Figure 17.1-6  Undo/Redo
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 18   Simple Si Detector
This chapter describes operations that are different from operations performed when other detectors are 
used in settings for using the Simple Si detector (C2-DUVB GaAsP Detector Unit).

When the "C2-DUVB-OP GaAsP 2nd channel Kit" is used, Channel 1 can be used an option channel.

Descriptions in this chapter are based on windows when a laser unit "LU-N4" is used.

When using the Standard Detector (DU3), see Chapter 5. 

18.1    Optical Path Changeover Lever of C2 Scan Head for 
Simple Si

When using the Simple Si detector, switch the optical path changeover lever on the C2 scan head to the 
[Spectrum] position. 

Figure 18.1-1  Optical path changeover lever for C2 scan head

18.2    Combinations of Detection Modes and Functions for 
Simple Si

The following table lists settable functions in each detection mode.

Table 18.2-1   Combinations of Detection Modes and Functions

Function
Detection Mode
CB VB
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Y: Available
N: Unavailable

* External detector units are usable only when a C2 system without a spectral detector or the Simple 
Si detector is in use.
When C2si (system with a spectral detector) or the Simple Si detector is in use, no external detector 
is usable. 

18.3   Detection Mode CB

This chapter describes the settings for the Continuous Bandpass mode (CB).

In the Continuous Bandpass mode, spectral images of up to 32 channels are sequentially acquired for 
each specified wavelength resolution of each channel. 

18.3.1    Filter and Dye Window

This window enables to set the Optical path.

Unidirectional Y Y
Bidirectional Y Y
Channel Series N Y

Multi position acquisition
(Chapter 4)

Available in all detection modes.
(However, no photo activation 
experiment is available.)

Fast mode (Chapter 8) Y Y
HV linear correction Y Y
Pinhole setting Y Y
Photo activation (Chapter 10) Y Y

Particular line sequential
(Chapter 5)

2Ex1Em N N
4Ex4Em N N

Using external detector (Chapter 16) * N N
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Figure 18.3-1  Filter and Dye window (CB-use)

Table 18.3-1   Functions of Filter and Dye window (CB-use)
Name Function

(1) Detector When Simple Si detector is in use, indicates that the Detector 
mode [CB] of Simple Si detector is used when the optical path 
changeover lever on the C2 scan head is set to the [Spectrum] 
position and the Continuous Bandpass mode (CB) is selected as
the detection mode in the Optical path window. 

(2) Setting button Opens the Optical path window.
To use, select the detector, the dichroic mirror, the excitation 
laser, fluorescence dye for each excitation laser and others. 

(3) Status Indicates the excitation laser.
(4) Resolution Selects a wavelength resolution.

10 nm: 
Images of up to 32 channels are acquired in step of 10 nm
within a wavelength range of 400 nm to 720 nm.

20 nm: 
Images of up to 16 channels are acquired in step of 20 nm
within a wavelength range of 400 nm to 720 nm.

(5) Channels Selects the number of channels (number of PMTs).
When 20 nm is selected in Resolution, up to 16 channels are 
selectable.
When 10 nm is selected in Resolution, up to 32 channels are 
selectable. 

(6) Wavelength range
information

Displays the wavelength range information.

(7) Close mechanical 
shutter during 
experiment

If unchecked, the shutter remains open during the ND image 
acquisition. 
As the shutter is not opened/closed every image acquisition, the 
time for the image acquisition can be shortened.

* During the interval period, laser power is automatically 
changed to the minimum but the laser cannot be shut off 
completely because the shutter is left open. 

(8) Eye Port button Changes optical path to eye port. 
Each function on the C2plus Settings window becomes non-
selectable when the Eye Port button is selected. 

(9) Acquiring 
wavelength range 
setting bar

Sets a wavelength range to be acquired in a wavelength range 
from 400 nm to 720 nm.
Sets a range by shifting the wavelength range setting bar to the 
right or left or by enlarging or reducing it. (Linked with the above 
setting of the number of channels to be acquired.)

* A part of the wavelength range may be displayed in black 
depending on the setting conditions. In the wavelength range 
displayed in black, no wavelength range can be set.
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18.3.2    Setting the Optical Path

Click the [Setting] button of the Filter and Dye window to display the Optical path window.

The Continuous Bandpass mode [CB] setting screen is displayed when the optical path changeover lever 
on the C2 scan head is set to the [Spectrum] position and the Continuous Bandpass mode (CB) is 
selected as the detection mode in the Optical path window. 

Figure 18.3-2  Filter and Dye window (CB-use)

(10) Start Displays the start wavelength of the wavelength range currently 
selected.
Enabled to enlarge or reduce the range in units of wavelength 
resolution with the right or left button.
This start wavelength can be set within a wavelength range of 400 
to 710 nm. 

(11) All In the currently selected wavelength range, enables shifting to the 
right or left in units of 1 nm without changing the width of the 
wavelength. 

(12) End Displays the end wavelength of the wavelength range currently
selected.
Enabled to enlarge or reduce the range in units of wavelength
resolution with the right or left button.
This start wavelength can be set within a wavelength range of 410 
to 720 nm.

l Optical Configuration

Individual data items set in the Continuous Bandpass mode (CB) can be managed 
collectively with the Optical Configuration window.
For storing and retrieving the [Optical Configuration] settings, see the sections 
concerning the optical configuration in the "NIS-Elements AR (Advanced 
Research) User's Guide."
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Figure 18.3-3  Optical path window (CB-use)

18.3.3    Optical Path Window
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Figure 18.3-4  Optical path window (CB-use)

Table 18.3-2   Functions of Optical path window (CB-use)
Name Function

(1) Detection mode selection 
button 

Continuous Bandpass mode (CB) 
In this mode, spectral images of up to 32 
channels are sequentially acquired for
each specified wavelength resolution of 
each channel.

(2) Resolution Selects a wavelength resolution. 

10 nm: 
Images of up to 32 channels are acquired in step of 
10 nm within a wavelength range of 400 nm to 720 
nm.

20 nm: 
Images of up to 16 channels are acquired in step of 
20 nm within a wavelength range of 400 nm to 720 
nm.
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(3) Channels Selects the number of channels (number of PMTs).
When 20 nm is selected in Resolution, up to 16 
channels are selectable.
When 10 nm is selected in Resolution, up to 32 
channels are selectable. 

(4) Excitation laser indicator Displays the current setting for the laser.
The currently set laser icon is displayed in a large size, 
and the optical path is indicated. 

(5) Excitation laser selection check 
box

Enables to select the excitation lasers to be used.

(6) Excitation laser wavelength 
select

Enables to set the laser wavelength that is set with the 
software configuration, regardless of the setting of the 
Filter block display/select. 

(7) Rainbow chart Provides the following information: 

l Wavelength band for which to acquire images 
(shown in color and value for each excitation laser)

l Spectral profile of fluorescence dye 
l Excitation laser for fluorescence dye 
l A color band indicating the wavelengths in the

entire band (400 to 720 nm) 
l Scale of the wavelengths in the entire band (400 to 

720 nm) 
(8) 1st Dichroic mirror select Enables to manually select the 1st Dichroic mirror to 

be used.
If a 1st Dichroic mirror that the NIS-Elements does not 
recommend is selected in the combination of the 
selected laser wavelength and the 1st Dichroic mirror, 
"!" appears following the 1st Dichroic mirror name

(9) Transmitted detector selection 
button

Brings the transmitted detector into the Optical path, to 
enable the ability. 

Brings the transmitted detector out of the Optical path, 
to disable the ability. 

(10) Filter cube setting button

Used to exchange the filter cube of option dichroic 
mirror, create new filter cube information, or change 
the details of the registered filter cube. Clicking this 
button displays the Filter Cube Setting window.
For the editing procedure, see Section 18.3.3.1, "Filter 
Cube Setting Window." 

Used to display/select the filter cube name installed in 
the filter cube of option dichroic mirror. 
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18.3.3.1   Filter Cube Setting Window

This window opens when the [Filter cube setting] button is clicked on the Optical path window. 
The new filter cube to be created or the content of the registered filter cube can be changed.

(11) OK button Confirms the Optical path settings applied and closes 
the Optical path window.

(12) Cancel button Discards the Optical path settings applied and closes 
the Optical path window. 

(13) Acquiring wavelength range 
setting bar

Sets a wavelength range to be acquired in a
wavelength range from 400 nm to 720 nm.
Sets a range by shifting the wavelength range setting 
bar to the right or left or by enlarging or reducing it. 
(Linked with the above setting of the number of 
channels to be acquired.)

* A part of the wavelength range may be displayed 
in black depending on the setting conditions. In the 
wavelength range displayed in black, no
wavelength range can be set.

(14) Start Displays the start wavelength of the wavelength range 
currently selected.
Enabled to enlarge or reduce the range in units of 
wavelength resolution with the right or left button.
This start wavelength can be set within a wavelength 
range of 400 to 710 nm. 

(15) All In the currently selected wavelength range, enables 
shifting to the right or left in units of 1 nm without 
changing the width of the wavelength. 

(16) End Displays the end wavelength of the wavelength range 
currently selected.
Enabled to enlarge or reduce the range in units of 
wavelength resolution with the right or left button.
This start wavelength can be set within a wavelength 
range of 410 to 720 nm. 

(17) Enlarge button Enlarges the rainbow chart.
The display is switched in three levels. 

l About switching between CB and VB

CB -> VB: 
The last settings in the Variable Bandpass mode (VB) are recalled.

VB -> CB: 
The last settings in the Continuous Bandpass mode (CB) are recalled.
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Figure 18.3-5  Filter Cube Setting window (for DM/BA1 BA2 Filter-use)

Table 18.3-3   Functions of the Filter Cube Setting Window
Name Function

(1) Preset data Selects a set of the Filter cube for option dichroic mirror 
recommended by Nikon.

(2) Filter cube name 
display/Edit

Displays/edits the Filter cube name in the combination of 
the dichroic mirror and the barrier mirror. (Input words: 1 -
24 (in Alphabetical letters))

(3) Filter cube name creation 
button

Generates the filter cube name automatically using 
Wavelength, Type, and BandWidth of the barrier filter.

(4) Use BA2 check box When checked, the second barrier filter (BA2) can be used.
(5) Dichroic mirror 

wavelength input
Inputs the wavelength of the dichroic mirror. (Input range: 
400 - 720 nm)

The following wavelength is transmitted according to the 
selected Type.

[LP] Long pass: 
Wavelength equal to or longer than the Wavelength 
value is transmitted.

[SP] Short Pass: 
Wavelength equal to or shorter than the Wavelength
value is transmitted.

(6) Filter type select Selects the dichroic mirror type.
(7) Barrier filter wavelength 

input
Inputs the wavelength of the barrier filter (Input range: 400 
- 720 nm)

The following wavelength is transmitted according to the 
selected Type.
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18.3.4    Acquisition Window

The Acquisition window enables to set PMT brightness (detection sensitivity), laser power, and pinhole
size.

18.3.4.1    Structure of Acquisition Window

[LP] Long pass: 
Wavelength equal to or longer than the Wavelength 
value is transmitted.

[SP] Short Pass: 
Wavelength equal to or shorter than the Wavelength
value is transmitted.

[BP] Band Pass: 
Wavelength of the Wavelength value ?} BandWidth 
value/2 is transmitted.

(8) Barrier filter type select Selects the barrier filter type. ([LP] Long pass/[SP] Short 
Pass/[BP] Band Pass)

(9) Barrier filter band input When the barrier filter type is [BP], inputs the range from 
the center wavelength for the barrier filter. [Input range: 1 -
350 nm normally (but not limited to)]

(10) Apply Confirms the Filter Cube Settings.
(11) Exit Closes the Filter Cube Setting window.

If the setting has not been confirmed with the Apply 
button, a confirmation dialog box appears.
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Figure 18.3-6  Acquisition window (CB-use)

Table 18.3-4   Functions of Acquisition window (CB-use)
Name Function

(1) Acquisition/Photo 
Activation window 
switching

Switches between the Acquisition and Photo Activation
windows.

For the Photo Activation window, see Chapter 10. 
(2) Laser power monitor

button 
Displays the laser power value (integer obtained after A/D 
conversion divided by 10) of the current excitation laser by 
clicking this button.
During the image acquisition, the laser power cannot be 
measured and this button is grayed out.

(3) Excitation laser color Displays the excitation laser color of each channel specified in 
the Optical path window. 
When displaying the live image, the image of only the clicked 
channel is displayed on the Live window.
The channel whose image is displayed can be changed during 
Live. 

(4) Custom Acquisition 
Setting button

Click this button to open the DUVB Custom Acquisition 
Settings dialog box.
Sequence of scan channels and excitation/dimming timing of
the excitation laser can be set in the DUVB Custom Acquisition 
Settings dialog box.
For details, see Section 18.3.4.2, "DUVB Custom Acquisition
Settings Dialog Box."
The current acquisition control setting is shown on this button. 

(5) Live channel 
indication

Displays the wavelength of the channel that indicates the live 
image. 

(6) Pinhole Adjusts the pinhole size.
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For pinhole size, see Section 18.3.4.4, "Setting the Pinhole."
(7) Si HV and Offset Adjusts HV and Offset of the Spectral Detector. 

This function can be adjusted during acquisition of the live 
image. 

Slider bar:
Slides to the right or left to set the value.

Arrow buttons:
Click either arrow button to increase or decrease the value 
stepwise.

Direct entry in value display field:
Type the desired setting value.

(8) Brightness adjustment 
for transmitted 
detector 

For the transmitted detector, use the HV and Offset controls to
adjust the brightness of the live image.
Sets the offset value and the voltage (HV) to be applied to the 
transmitted detector. 

Slider bar:
Slides to the right or left to set the value.

Arrow buttons:
Click either arrow button to increase or decrease the value 
stepwise.

Direct entry in value display field:
Type the desired setting value.

(9) TD channel selection Enables to acquire TD images by checking the check box.
When fluorescence is excited, all excitation lights are detected 
by the transmitted detector (TD). If the BA filter for 405 laser is 
installed in the TD, excitation light is not detected by the TD. 

(10) TD IN/OUT button Sets/removes the motorized transmitted detector in/from the
optical path. 
(IN = Set in the optical path/ OUT = Remove from the optical 
path)
As for the case where the TD IN/OUT button is not displayed, it 
will be displayed when the motorized transmitted detector is set 
in the optical path in the Optical path window.

(11) TD scan Displays the wavelength of the TD image scanning laser.
The TD image is acquired together with the channel using the 
same laser wavelength. 

(12) Laser ON/OFF button 
(*1)

Selects whether the laser is emitted or not. 

The laser is emitted.

The AOTF shutter closes and the laser power value 
becomes 0.
When switched from OFF to ON, the laser power 
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(*1) When LU-NV is in use, this button is grayed out and is disabled while the button on the front 
panel of the laser unit is OFF or blinking.

18.3.4.2    DUVB Custom Acquisition Settings Dialog Box

This dialog box is used to set the sequence of scan channels and excitation/dimming timing of the 
excitation laser.

Figure 18.3-7  DUVB Custom Acquisition Settings dialog box (Longest-use)

value set in the previous ON status is applied.
(13) Laser (*1) Sets the laser power value.

Slider bar:
Slides to the right or left to set the value.

Arrow buttons:
Click either arrow button to increase or decrease the value 
stepwise.

Direct entry in value display field:
Type the desired setting value.

* When "C2-DUVB-OP GaAsP 2nd channel Kit" is in use, if 
a standard channel that uses the same laser wavelength as 
the option channel exists, the laser power value interlocks. 

(14) Laser wavelength 
indication 

The currently selected laser wavelength is indicated.

(15) Optimize button Click this button to display the XYZ Size Setup window.
In the XYZ Size Setup window, the calculation method of the 
recommended values of the resolution, zoom magnification, and 
Z stack step size can be set.
For the XYZ Size Setup window, see Section 18.3.4.3, 
"Recommended Value Indication/Automatic Application."
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Figure 18.3-8  DUVB Custom Acquisition Settings dialog box (Shortest-use)

Table 18.3-5   DUVB Custom Acquisition Settings dialog box
Name Function

(1) Acquisition Order Select the sequence of scan channels.

Longest:
In the order of long wavelength -> short wavelength 

Shortest:
In the order of short wavelength -> long wavelength

(2) Excitation Mode for 
Acquisition

Set the sequence of scan channels and excitation/dimming 
timing of the excitation laser.

Simultaneous radio button: 
All lasers are excited.
Lasers are not dimmed even after channels in the 
wavelength range have been acquired. 

Subtractive radio button: 
Acquisition starts with all lasers excited, and lasers are 
dimmed from those that have acquired channels in the 
wavelength range.
This radio button is shown only when [Longest] is selected 
in Acquisition Order. 

Cumulative radio button: 
Lasers are not dimmed even after channels in the
wavelength range have been acquired, and a laser of the 
next wavelength is excited.
This radio button is shown only when [Shortest] is selected 
in Acquisition Order. 

Sequential radio button: 
After channels in the wavelength range have been acquired, 
the excited laser is dimmed and a laser of the next 
wavelength is excited. 

(3) OK button Confirms the settings applied and closes this dialog box. 
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18.3.4.3    Recommended Value Indication/Automatic Application

By the function of the recommended value indication/automatic application, the recommended values of 
the appropriate resolution, zoom magnification, and Z stack step size are calculated based on the 
objective type and the selected excitation wavelength. 
Using the calculated recommended values enables the image acquisition clearer and with less damage to 
the sample.

 Recommended Value Automatic Application  

To automatically apply the recommended values to the parameters, set the [Nyquist XY] button of the 
Scan Area window to ON.

Figure 18.3-9  Scan Area window

(4) Cancel button Discards the settings applied and closes this dialog box. 
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Figure 18.3-10  Location of Recommended Value Indication

* When the laser or objective in use is changed, the recommended values are recalculated, and newly 
indicated and automatically applied.

 Recommended Value Settings  

Detailed settings of the recommended values are made in the XYZ Size Setup window that is displayed 
by clicking the [Optimize] button of the Acquisition window.
If the [Nyquist XY] button of the Scan Area window is ON, the recommended values are automatically 
applied to the parameters.
Or if the [Nyquist XY] button is OFF, the recommended values of the scan size and zoom are indicated 
in the Scan setting window.

Figure 18.3-11  XYZ Size Setup window
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Table 18.3-6   Functions of XYZ Size Setup window

18.3.4.4    Setting the Pinhole

Figure 18.3-12  Setting the Pinhole (CB-use)

Name Function
(1) Zoom Preference When the [Nyquist XY] button is ON, keeps the scan size 

and applied the recommended value of the zoom. 
(2) Resolution Preference When the [Nyquist XY] button is ON, keeps the zoom and 

applied the recommended value of the scan size.
(3) Use Cropping Fits the scan size in detail by using Crop Scan. 

(4) Suggested Step (Z)

Sets the Z step size calculation method.
Recommend (Z˜1/3
FWHM)

Approximately one third of the thickness 
of optical section (FWHM value). 

Half Overlap
(Z=1/2 FWHM)

One half of the thickness of optical 
section (FWHM value).

Minimum Overlap
(Z=FWHM)

The thickness of optical section (FWHM 
value). 

Perfect Voxel
(Z=X=Y)

Value same as the pixel size.

(5) OK button Confirms the XYZ Size Setup applied and closes the XYZ 
Size Setup window. 

(6) Cancel button Discards the XYZ Size Setup applied and closes the XYZ 
Size Setup window.
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Table 18.3-7   Pinhole setting functions (CB-use)

18.3.4.5    Calculation Settings for Pinhole Size 

This section describes the setting window for calculating the pinhole size.

Click the [Pinhole] button in Acquisition window, the A.U. Calculation Settings window appears.
(Usually, the [Recommend] is selected to enable automatic calculation. [Recommend] calculates the 
A.U. value by using the Nikon-recommended EM and NA values.) 

Name Function
(1) Pinhole size 

setting
Sets a pinhole size for C2 system.

Slider bar:
Slides to the right or left to set the pinhole size. (Unit: A.U.)

Arrow buttons:
Click either arrow button to increase or decrease the pinhole size 
stepwise.

Direct entry in pinhole size display field:
Type the desired setting value. 

(2) Pinhole button Displays the A.U. Calculation Settings window to calculate the 
pinhole size.
(For A.U. Calculation Settings, see Section 18.3.4.5, "Calculation 
Settings for Pinhole Size.")

(3) Home Changes the pinhole to the predetermined home position.
The value of the home position can be changed in the A.U. 
Calculation Settings window.
(For A.U. Calculation Settings, see Section 18.3.4.5, "Calculation 
Settings for Pinhole Size.") 

(4) Pinhole size Indicates pinhole size of C2 system. (Unit: µm) 
(5) Optical 

Sectioning
Indicates the FWHM (full width at half maximum) of z airy disk.

(6) Optical
Resolution

The actual size of 1 pixel square calculated from the optical 
information (for objectives and scan parameters) and the size 
acquired from an image. 

(7) Reference 
excitation 
wavelength for 
the pinhole size 
calculation

Selects the excitation wavelength as the reference of the automatic 
calculation of the pinhole size from the laser wavelengths, or enter it 
manually in the A.U. Calculation Settings window. (For A.U. 
Calculation Settings, see Section 18.3.4.5, "Calculation Settings for 
Pinhole Size.")
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Figure 18.3-13  A.U. Calculation Settings window

Table 18.3-5   A.U. Calculation Settings window
Name Function

(1) Select calculation 
method

Recommend -
Sets parameters automatically. (Nikon recommended) 
User Setting -
Allows the user to manually set parameters. 

(2) EM:emission 
wavelength[µm]

Selected Laser wavelength -
Calculates parameters by using the laser wavelength selected in 
the pinhole combo box of the Acquisition window as the 
emission wavelength (EM value).
The wavelength displayed in the combo box is to be the laser 
wavelength set in the Optical Setting window. 
Manual -
Allows the user to manually set parameters. (The parameter is 
calculated with the input value as the emission wavelength (EM 
value).)
Enter the value directly from the keyboard. 

(3) NA:Numerical 
Aperture

Sets refractive index of the objective. 
NA_obj (NA of objective lens) -
Regardless of whether or not the objective NA value exceeds 
the refractive index of the sample, executes calculation by using 
the objective NA as the calculation parameter. 
Min(NA_obj, NA_sample) -
When the objective NA value does not exceed the refractive 
index of the sample, executes calculation by using the objective 
NA as the calculation parameter. When the objective NA value 
exceeds the refractive index of the sample, executes calculation 
by using the sample refractive index.

(4) "Airy" Home Position Sets a home position of pinhole.

Direct entry in offset value display field:
Type the desired setting value. 
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18.3.4.6    HV Linear Correction

When HV changes, Gain changes as shown in the graph captioned "Without HV Linear Correction."

As HV increases, the gain variation (the variation of image brightness) is gradual initially, and it
becomes steep beyond a certain point.

The gain variation can be automatically corrected to be linear with HV variation by the function called
"HV Linear Correction." With this correction, gain varies at the same rate as the HV adjustment. 

Figure 18.3-14  Gain vs. HV

To enable HV Linear Correction, check the [HV Linear Correction] check box.

* The pinhole size can be selected from six types in C2. 
Therefore, if the entered value does not match any of the types, 
the size that is larger than and the closest to the entered value is 
set as the home position.

(5) Keep A.U. check box When checked, the pinhole size is fixed by the A.U. when the 
selected wavelength or objective is changed. (However changes 
by the µm.) 
When unchecked, the pinhole size is fixed by the µm. (However 
changes by the A.U.)

* The pinhole size can be selected from six types in C2. 
Therefore, if the to-be-fixed A.U. value does not match any of 
the types, the size that is larger than and the closest to the A.U. 
value is selected.

(6) OK button Confirms the A.U. Calculation Settings applied and closes the 
A.U. Calculation Settings window. 

(7) Cancel button Discards the A.U. Calculation Settings applied and closes the
A.U. Calculation Settings window.
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Figure 18.3-15  HV Linear Correction

18.4   Detection Mode VB

This chapter describes the settings for the Variable Bandpass mode (VB).

In the Variable Bandpass mode, images capturing light in any wavelength range can be acquired in up to 
5 channels. 

18.4.1    Filter and Dye Window

This window enables to select the desired channel series and set the Optical path.

Figure 18.4-1  Filter and Dye window (VB-use)

l When HV Linear Correction is enabled or disabled, HV is reset to 0 V once. 
l If the Offset slider bar is moved, the accurate correction is not performed.
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Table 18.4-1   Functions of Filter and Dye window (VB-use)
Name Function

(1) Detector When Simple Si detector is in use, indicates that the Detector 
mode [VB] is used when the optical path changeover lever on the 
C2 scan head is set to the [Spectrum] position and the Variable 
Bandpass mode (VB) is selected as the detection mode in the
Optical path window. 

(2) Eye Port button Changes optical path to eye port. 
Each function on the C2plus Settings window becomes non-
selectable when the Eye Port button is selected. 

(3) Setting button Opens the Optical path window.
To use, select the detector, the dichroic mirror, the excitation 
laser, fluorescence dye for each excitation laser and others. 

(4) Status Indicates for the settings for each channel (fluorescence dye 
name, laser wavelength, and wavelength band to be acquired).
The wavelength band to be acquired can also be changed using 
the acquisition wavelength range for each channel slider bar. 
(When an option channel is in use, the wavelength band of Ch1 is 
not changeable.) 

* When "C2-DUVB-OP GaAsP 2nd channel Kit" is in use, Ch1 
is an option channel and Ch2 to Ch5 are standard channels.

(5) Ch series Ch series is available only when "C2-DUVB-OP GaAsP 2nd 
channel Kit" is in use.
Specifies the scan sequence of option channel and selected 
standard channel (one of four channels Ch2 to Ch5). 

None:
Ch series is not used.
When None is selected, perform scanning by simultaneously 
firing all lasers (option channel and selected standard channel) 
for the channels to be used. 

1->4:
Scan starts in the order of option channel (Ch1) -> selected
standard channel (one of four channels Ch2 to Ch5). 

4->1:
Scan starts in the order of selected standard channel (one of 
four channels Ch2 to Ch5) -> option channel (Ch1). 

(6) Close mechanical 
shutter during 
experiment

If unchecked, the shutter remains open during the ND image 
acquisition. 
As the shutter is not opened/closed every image acquisition, the 
time for the image acquisition can be shortened.

* During the interval period, laser power is automatically 
changed to the minimum but the laser cannot be shut off 
completely because the shutter is left open. 

(7) AUX button Displays the AUX Settings window to use the external detector 
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18.4.2    Setting the Optical Path

Click the [Setting] button of the Filter and Dye window to display the Optical path window.

Select the Variable Bandpass mode (VB). 

Figure 18.4-2  Filter and Dye window (VB-use)

unit.
For details of the AUX Settings window, see Chapter 17. 

(8) PreScan button Makes settings of the pre-scan mode for correction of the position 
shift in a zoom change or of the image acquisition area shift in the 
photo activation by the prior scanning. 

l Optical Configuration

Individual data items set in the Variable Bandpass mode (VB) can be managed 
collectively with the Optical Configuration window.
For storing and retrieving the [Optical Configuration] settings, see the sections 
concerning the optical configuration in the "NIS-Elements AR (Advanced 
Research) User's Guide."
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Figure 18.4-3  Optical path window (VB-use)

18.4.3    Optical Path Window
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Figure 18.4-4  Optical path window (VB-use)

Table 18.4-2   Functions of Optical path window (VB-use)
Name Function

(1) Detection mode selection 
button 

Variable Bandpass mode (VB) 
In this mode, images capturing light in any 
wavelength range can be acquired in up to 
5 channels. 

(2) Scan mode select Selects the scanner unit to be used.

Galvano
Galvano scan mode allows high-quality imaging of 
up to 4096 × 4096 pixels.

Resonant
Resonant scan mode allows high-speed imaging of 
420 frames per second.

(3) Excitation laser wavelength 
select 

Enables to set the laser wavelength that is set with the 
software configuration, regardless of the setting of the 
Filter cube display/select. 
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(4) Sorting fluorescence dye list Sorts the fluorescence dye list according to the 
selected type.

ABC:
Displays the list in alphabetical order.

Emission:
Displays the list in the order of peak wavelength of 
fluorescence intensity.

Excitation:
Displays the list in excitation wavelength order.

(5) Channel selection check box Enables to select the channels to be used. (Up to 5 
channel.) 

* When "C2-DUVB-OP GaAsP 2nd channel Kit" is 
in use, Ch1 is an option channel and Ch2 to Ch5 
are standard channels.

* When using the Ch series, select the option channel 
(Ch1) and then select one of standard channels 
Ch2 to Ch5. (Ch series is available only when "C2-
DUVB-OP GaAsP 2nd channel Kit" is in use.)

(6) Channel color setting button Displays the Color Selection window, enables to set 
the desired color for each channel. 

(7) Fluorescence dye 
selection/input:

Selects the in-use fluorescence dye name for each 
channel or enters an arbitrary channel name. 

(8) Excitation laser wavelength 
select

Enables to set the laser wavelength that is set with the
software configuration, regardless of the setting of the 
Filter cube display/select. 

(9) Rainbow chart Provides the following information: 

l Wavelength band for which to acquire images 
(shown in color and value for each excitation laser)

l Spectral profile of fluorescence dye 
l Excitation laser for fluorescence dye 
l A color band indicating the wavelengths in the

entire band (400 to 720 nm) 
l Scale of the wavelengths in the entire band (400 to 

720 nm) 
(10) Acquisition wavelength range 

for each channel slider bar 
Specifies the fluorescence wavelength range to be 
acquired for each channel.
Overlapping wavelength range can be specified 
between channels. 

* When the "C2-DUVB-OP GaAsP 2nd channel Kit" 
is in use, the wavelength range of the option 
channel (Ch1) cannot be changed using the slider
bar.

(11) 1st Dichroic mirror select Enables to manually select the 1st Dichroic mirror to 
be used.
If a 1st Dichroic mirror that the NIS-Elements does not 
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18.4.3.1   Filter Cube Setting Window

This window opens when the [Filter cube setting] button is clicked on the Optical path window. 
The new filter cube to be created or the content of the registered filter cube can be changed.

recommend is selected in the combination of the 
selected laser wavelength and the 1st Dichroic mirror,
"!" appears following the 1st Dichroic mirror name 

(12) Transmitted detector selection 
button

Brings the transmitted detector into the Optical path, to 
enable the ability. 

Brings the transmitted detector out of the Optical path, 
to disable the ability. 

(13) Filter cube setting button

Used to exchange the filter cube of option dichroic 
mirror, create new filter cube information, or change 
the details of the registered filter cube. Clicking this 
button displays the Filter Cube Setting window.
For the editing procedure, see Section 18.4.3.1, "Filter 
Cube Setting Window." 

Used to display/select the filter cube name installed in 
the filter cube of option dichroic mirror. 

(14) OK button Confirms the Optical path settings applied and closes 
the Optical path window.

(15) Cancel button Discards the Optical path settings applied and closes 
the Optical path window.
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Figure 18.4-5  Filter Cube Setting window (for DM/BA1 BA2 Filter-use)

Table 18.4-3   Functions of the Filter Cube Setting Window
Name Function

(1) Preset data Selects a set of the Filter cube for option dichroic mirror 
recommended by Nikon.

(2) Filter cube name 
display/Edit

Displays/edits the Filter cube name in the combination of 
the dichroic mirror and the barrier mirror. (Input words: 1 -
24 (in Alphabetical letters))

(3) Filter cube name creation 
button

Generates the filter cube name automatically using 
Wavelength, Type, and BandWidth of the barrier filter.

(4) Use BA2 check box When checked, the second barrier filter (BA2) can be used.
(5) Dichroic mirror 

wavelength input
Inputs the wavelength of the dichroic mirror. (Input range: 
400 - 720 nm)

The following wavelength is transmitted according to the 
selected Type.

[LP] Long pass: 
Wavelength equal to or longer than the Wavelength 
value is transmitted.

[SP] Short Pass: 
Wavelength equal to or shorter than the Wavelength
value is transmitted.

(6) Filter type select Selects the dichroic mirror type.
(7) Barrier filter wavelength 

input
Inputs the wavelength of the barrier filter (Input range: 400 
- 720 nm)

The following wavelength is transmitted according to the 
selected Type.
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18.4.4    Acquisition Window

The Acquisition window enables to set PMT brightness (detection sensitivity), laser power, and pinhole 
size.

When "C2-DUVB-OP GaAsP 2nd channel Kit" is in use, Ch1 is an option channel and Ch2 to Ch5 are 
standard channels.

18.4.4.1    Structure of Acquisition Window

[LP] Long pass: 
Wavelength equal to or longer than the Wavelength 
value is transmitted.

[SP] Short Pass: 
Wavelength equal to or shorter than the Wavelength
value is transmitted.

[BP] Band Pass: 
Wavelength of the Wavelength value ?} BandWidth 
value/2 is transmitted.

(8) Barrier filter type select Selects the barrier filter type. ([LP] Long pass/[SP] Short 
Pass/[BP] Band Pass)

(9) Barrier filter band input When the barrier filter type is [BP], inputs the range from 
the center wavelength for the barrier filter. [Input range: 1 -
350 nm normally (but not limited to)]

(10) Apply Confirms the Filter Cube Settings.
(11) Exit Closes the Filter Cube Setting window.

If the setting has not been confirmed with the Apply 
button, a confirmation dialog box appears.
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Figure 18.4-6  Acquisition window (VB-use)

Table 18.4-4   Functions of Acquisition window (VB-use)
Name Function

(1) Acquisition/Photo 
Activation window 
switching

Switches between the Acquisition and Photo Activation
windows.

For the Photo Activation window, see Chapter 10. 
(2) Laser power monitor

button
Displays the laser power value (integer obtained after A/D 
conversion divided by 10) of the current excitation laser by 
clicking this button.
During the image acquisition, the laser power cannot be 
measured and this button is grayed out.

(3) Channel selection Selects the channels (Ch1 to Ch5) to acquire the desired images. 

Do this by adding a check mark.
* When using the Ch series, select the option channel (Ch1) 

and then select one of standard channels Ch2 to Ch5. (Ch 
series is available only when "C2-DUVB-OP GaAsP 2nd 
channel Kit" is in use.) 

(4) Gain Sets the PMT Gain. 

Slider bar:
Slides to the right or left to set the gain value. 

Arrow buttons:
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Click either arrow button to increase or decrease the gain
value stepwise. 

Direct entry in gain value display field:
Type the desired setting value.

(5) Offset for option 
channel

This function is shown only when "C2-DUVB-OP GaAsP 2nd 
channel Kit" is in use.
Sets the offset value of the option channel (Ch1). 

Slider bar:
Slides to the right or left to set the offset value. 

Arrow buttons:
Click either arrow button to increase or decrease the offset 
value stepwise. 

Direct entry in offset value display field:
Type the desired setting value. 

(6) Laser ON/OFF button 
(*1)

Selects whether the laser is emitted or not. 

The laser is emitted.

The AOTF shutter closes and the laser power value 
becomes 0.
When switched from OFF to ON, the laser power 
value set in the previous ON status is applied.

(7) Laser (*1) Sets the laser power value.

Slider bar:
Slides to the right or left to set the value.

Arrow buttons:
Click either arrow button to increase or decrease the value 
stepwise.

Direct entry in value display field:
Type the desired setting value.

* When "C2-DUVB-OP GaAsP 2nd channel Kit" is in use, if 
a standard channel that uses the same laser wavelength as 
the option channel exists, the laser power value interlocks. 

(8) Fluorescence dye 
name indication

The fluorescence dye name specified in the Optical path 
window is indicated. 

(9) Channel color Displays the channel color specified in the Optical path
window. 

(10) Laser wavelength 
indication

The currently selected laser wavelength is indicated. 

(11) Offset for standard
channel

Sets the offset value of the standard channel.
Sets the PMT gain of standard channels Ch2 to Ch5 when "C2-
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DUVB-OP GaAsP 2nd channel Kit" is in use. 

Slider bar:
Slides to the right or left to set the offset value.

Arrow buttons:
Click either arrow button to increase or decrease the offset 
value stepwise.

Direct entry in offset value display field:
Type the desired setting value.

(12) Pinhole Adjusts the pinhole size.
For pinhole size, see Section 18.4.4.4, "Setting the Pinhole."

(13) TD channel selection Enables to acquire TD images by checking the check box.
When fluorescence is excited, all excitation lights are detected 
by the transmitted detector (TD). If the BA filter for 405 laser is 
installed in the TD, excitation light is not detected by the TD. 

(14) TD IN/OUT button Sets/removes the motorized transmitted detector in/from the
optical path. 
(IN = Set in the optical path/ OUT = Remove from the optical 
path)
As for the case where the TD IN/OUT button is not displayed, it 
will be displayed when the motorized transmitted detector is set 
in the optical path in the Optical path window.

(15) Brightness adjustment
for transmitted 
detector 

For the transmitted detector, use the HV and Offset controls to 
adjust the brightness of the live image.
Sets the offset value and the voltage (HV) to be applied to the 
transmitted detector. 

Slider bar:
Slides to the right or left to set the value. 

Arrow buttons:
Click either arrow button to increase or decrease the value 
stepwise. 

Direct entry in value display field:
Type the desired setting value.

(16) Optimize button Click this button to display the XYZ Size Setup window.
In the XYZ Size Setup window, the calculation method of the 
recommended values of the resolution, zoom magnification, and 
Z stack step size can be set.

For the XYZ Size Setup window, see Section 18.4.4.3, 
"Recommended Value Indication/Automatic Application." 

(17) Select All Channels 
button

Selects all channels for acquiring images. 

(18) Custom Acquisition
Setting button

Click this button to open the DUVB Custom Acquisition 
Settings dialog box.
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(*1) When LU-NV is in use, this button is grayed out and is disabled while the button on the front 
panel of the laser unit is OFF or blinking.

18.4.4.2    DUVB Custom Acquisition Settings Dialog Box

Set the sequence of scan channels and the option channel acquisition timing.

Figure 18.4-7  DUVB Custom Acquisition Settings dialog box

Table 18.4-5   DUVB Custom Acquisition Settings dialog box

The sequence of scan channels and the option channel 
acquisition timing can be set in the DUV-B Custom Acquisition 
Setting dialog box. 
For details, see Section 18.4.4.2, "DUVB Custom Acquisition 
Settings Dialog Box."
The current acquisition control setting (sequence of scan 
channels) is shown on this button. 

Name Function
(1) Acquisition Order Select the sequence of scan channels.

Longest:
In the order of long wavelength -> short wavelength 

Shortest:
In the order of short wavelength -> long wavelength

(2) Fixed Bandpass (FB) 
Channel acquisition

Sets the option channel acquisition timing. (This setting is 
enabled only when "C2-DUVB-OP GaAsP 2nd channel Kit" is 
in use.)
The option channel is acquired concurrently with other standard 
channels to which the same laser wavelength is assigned in 
principle, but is acquired at the timing specified below if the 
same wavelength is not present. 
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18.4.4.3    Recommended Value Indication/Automatic Application

By the function of the recommended value indication/automatic application, the recommended values of
the appropriate resolution, zoom magnification, and Z stack step size are calculated based on the 
objective type and the selected excitation wavelength.
Using the calculated recommended values enables the image acquisition clearer and with less damage to 
the sample.

  Recommended Value Automatic Application  

To automatically apply the recommended values to the parameters, set the [Nyquist XY] button of the
Scan Area window to ON.

acquire FB and VB channels sequentially radio button: 
The option channel is acquired at other independent timing. 

acquire FB channel simultaneously if the VB channel uses 
an excitation wavelength higher than [Numerical entry] 
nm radio button:
The option channel is acquired at the same timing as 
channel that uses laser with a longer wavelength than the 
wavelength specified in the numerical entry field by the 
user.
If such channel does not exist, the option channel is
acquired at other independent timing. 

(3) OK button Confirms the settings applied and closes this dialog box. 
(4) Cancel button Discards the settings applied and closes this dialog box.
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Figure 18.4-8  Scan Area window

Figure 18.4-9  Location of Recommended Value Indication

* When the laser or objective in use is changed, the recommended values are recalculated, and newly 
indicated and automatically applied.

 Recommended Value Settings  

Detailed settings of the recommended values are made in the XYZ Size Setup window that is displayed 
by clicking the [Optimize] button of the Acquisition window.
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If the [Nyquist XY] button of the Scan Area window is ON, the recommended values are automatically 
applied to the parameters.
Or if the [Nyquist XY] button is OFF, the recommended values of the scan size and zoom are indicated 
in the Scan setting window.

Figure 18.4-10  XYZ Size Setup window

Table 18.4-6   Functions of XYZ Size Setup window
Name Function

(1) Zoom Preference When the [Nyquist XY] button is ON, keeps the scan size 
and applied the recommended value of the zoom. 

(2) Resolution Preference When the [Nyquist XY] button is ON, keeps the zoom and 
applied the recommended value of the scan size.

(3) Use Cropping Fits the scan size in detail by using Crop Scan. 

(4) Suggested Step (Z)

Sets the Z step size calculation method.
Recommend (Z˜1/3
FWHM)

Approximately one third of the thickness 
of optical section (FWHM value). 

Half Overlap
(Z=1/2 FWHM)

One half of the thickness of optical 
section (FWHM value).

Minimum Overlap
(Z=FWHM)

The thickness of optical section (FWHM 
value). 

Perfect Voxel
(Z=X=Y)

Value same as the pixel size.

(5) OK button Confirms the XYZ Size Setup applied and closes the XYZ 
Size Setup window. 

(6) Cancel button Discards the XYZ Size Setup applied and closes the XYZ 
Size Setup window.
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18.4.4.4    Setting the Pinhole

Figure 18.4-11  Setting the Pinhole (VB-use)

Table 18.4-7   Pinhole setting functions (VB-use)
Name Function

(1) Pinhole size 
setting

Sets a pinhole size for C2 system.

Slider bar:
Slides to the right or left to set the pinhole size. (Unit: A.U.)

Arrow buttons:
Click either arrow button to increase or decrease the pinhole size 
stepwise.

Direct entry in pinhole size display field:
Type the desired setting value. 

(2) Pinhole button Displays the A.U. Calculation Settings window to calculate the 
pinhole size.
(For A.U. Calculation Settings, see Section 18.4.4.5, "Calculation 
Settings for Pinhole Size.")

(3) Home Changes the pinhole to the predetermined home position.
The value of the home position can be changed in the A.U. 
Calculation Settings window.
(For A.U. Calculation Settings, see Section 18.4.4.5, "Calculation 
Settings for Pinhole Size.") 
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18.4.4.5    Calculation Settings for Pinhole Size 

This section describes the setting window for calculating the pinhole size.

Click the [Pinhole] button in Acquisition window, the A.U. Calculation Settings window appears.
(Usually, the [Recommend] is selected to enable automatic calculation. [Recommend] calculates the 
A.U. value by using the Nikon-recommended EM and NA values.) 

Figure 18.4-12  A.U. Calculation Settings window

Table 18.4-5   A.U. Calculation Settings window

(4) Pinhole size Indicates pinhole size of C2 system. (Unit: µm) 
(5) Optical 

Sectioning
Indicates the FWHM (full width at half maximum) of z airy disk.

(6) Optical
Resolution

The actual size of 1 pixel square calculated from the optical 
information (for objectives and scan parameters) and the size 
acquired from an image. 

(7) Reference 
excitation 
wavelength for 
the pinhole size 
calculation

Selects the excitation wavelength as the reference of the automatic 
calculation of the pinhole size from the laser wavelengths, or enter it 
manually in the A.U. Calculation Settings window. (For A.U. 
Calculation Settings, see Section 18.4.4.5, "Calculation Settings for 
Pinhole Size.")

Name Function
(1) Select calculation 

method
Recommend -
Sets parameters automatically. (Nikon recommended) 
User Setting -
Allows the user to manually set parameters. 

(2) EM:emission 
wavelength[µm]

Selected Laser wavelength -
Calculates parameters by using the laser wavelength selected in 
the pinhole combo box of the Acquisition window as the 
emission wavelength (EM value).
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18.4.4.6    HV Linear Correction

When HV changes, Gain changes as shown in the graph captioned "Without HV Linear Correction."

As HV increases, the gain variation (the variation of image brightness) is gradual initially, and it
becomes steep beyond a certain point.

The gain variation can be automatically corrected to be linear with HV variation by the function called
"HV Linear Correction." With this correction, gain varies at the same rate as the HV adjustment. 

The wavelength displayed in the combo box is to be the laser 
wavelength set in the Optical Setting window. 
Manual -
Allows the user to manually set parameters. (The parameter is 
calculated with the input value as the emission wavelength (EM 
value).)
Enter the value directly from the keyboard. 

(3) NA:Numerical 
Aperture

Sets refractive index of the objective. 
NA_obj (NA of objective lens) -
Regardless of whether or not the objective NA value exceeds 
the refractive index of the sample, executes calculation by using 
the objective NA as the calculation parameter. 
Min(NA_obj, NA_sample) -
When the objective NA value does not exceed the refractive 
index of the sample, executes calculation by using the objective 
NA as the calculation parameter. When the objective NA value 
exceeds the refractive index of the sample, executes calculation 
by using the sample refractive index.

(4) "Airy" Home Position Sets a home position of pinhole.

Direct entry in offset value display field:
Type the desired setting value. 

(5) Keep A.U. check box When checked, the pinhole size is fixed by the A.U. when the 
selected wavelength or objective is changed. (However changes 
by the µm.) 
When unchecked, the pinhole size is fixed by the µm. (However 
changes by the A.U.) 

(6) OK button Confirms the A.U. Calculation Settings applied and closes the
A.U. Calculation Settings window. 

(7) Cancel button Discards the A.U. Calculation Settings applied and closes the
A.U. Calculation Settings window.

Page 39 of 4018. Simple Si Detector

4/30/2019file:///C:/Users/Todd/AppData/Local/Temp/~hhA3F8.htm



Figure 18.4-15  Gain vs. HV

To enable HV Linear Correction, check the [HV Linear Correction] check box.

Figure 18.4-16  HV Linear Correction

l When HV Linear Correction is enabled or disabled, HV is reset to 0 V once. 
l If the Offset slider bar is moved, the accurate correction is not performed.
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 Appendix   Lists of Filter Cubes

The Filter Cube Information for the Optical Path

The Dichroic mirror or the Barrier filter to be registered on the Optical path window for the 
Confocal C2 is listed below.

  1st Dichroic mirror  

The 1st Dichroic mirror provided for the Optical C2 is shown below.

Table 1. 1st DM List

  Detector filter cube

The Dichroic mirror and the Detector filter cube provided for the Optical C2 is shown below.

Table 2. DM/BA filter List

Name Note:

1 BS 20/80 Excitation lights are unrestricted.

2 408/488/543

3 405/488/561

4 408/488/594

5 440 (457)/514/594

6 405/488/543/640

7 405/488/561/640

8 405 (408)/457 (440)/561/640 (633)

9 440 (457)/514/561/640 (633)

10 405 (408)/457 (440)/543/640 (633)

2nd DM 1st BA 3rd DM 3rd BA 2nd BA

1 455 None None None None

2 482 438/24 540LP 585/65 494/41 

3 511 447/60 560 561LP 510/84

4 540LP 482/35 593 594LP 514/30 

5 560 494/41 648 635LP 525/50

6 510/84 537/26

7 514/30 550/49

8 525/50 585/65

Page 2 of 4Appendix. Lists of Filter Cubes

4/30/2019mk:@MSITStore:C:\Users\Todd\OneDrive%20-%20Boston%20University\Admin%20Stu...



  Registered filter cube name

The Detector filter cube combined with the standard filter cube is shown below.
1 – 8 (9 for 2nd Filter Cube Set) ndicates the preset setting, whereas 9 (10 for 2nd Filter Cube 
Set) - 11 indicates the User registration, and 12 indicates no filter required.
The available Filter cube is equivalent with the Filter cube tab of the "Filter Cube Setting" window.

Table 3. Registration filter cube name List 1 1st Filter Cube Set

Table 4. Registration filter cube name List 2 2nd Filter Cube Set

9 537/26 593/40

Name
Registration 
number 2nd DM BA1

1 438/24 1 455 438/24

2 447/60 2 482 447/60

3 482/35 3 511 482/35

4 494/41 4 540LP 494/41

5 510/84 5 560 510/84

6 514/30 6 540LP 514/30

7 525/50 7 560 525/50

8 537/26 8 560 537/26

9 User 3 9 None None

10 User 4 10 None None

11 User 5 11 None None

12 Through 12 Through Through

Name
Registration
number 3rd DM 3rd BA 2nd BA

1 494/41,585/65 1 540LP 585/65 494/41 

2 510/84,561LP 2 560 561LP 510/84

3 514/30,585/65 3 540LP 585/65 514/30

4 525/50,561LP 4 560 561LP 525/50

5 525/50,594LP 5 560 594LP 525/50

6 537/26,561LP 6 560 561LP 537/26 

7 550/49,594LP 7 593 594LP 550/49

8 585/65,635LP 8 648 635LP 585/65 

9 593/40,635LP 9 648 635LP 593/40

10 User 2 10 None None None

11 User 3 11 None None None
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12 Through 12 Through Through Through
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